Manual COPYRIGHT (C) 2023 NetSupport Ltd. All rights reserved.

Information in this document is subject to change without notice. NetSupport Ltd reserves the right to revise this document and to make changes from time to time in the content hereof without obligation to notify any person or persons of such revisions or changes.

The software described in this document is supplied under a licence agreement and is protected by international copyright laws. You may copy it only for the purpose of backup and use it only as described in the Licence agreement.

Any implied warranties including any warranties of merchantability or fitness for a particular purpose are limited to the terms of the express warranties set out in the licence agreement.

Program COPYRIGHT (C) 1991-2023 NetSupport Ltd. All rights reserved.

**Trademarks**

NetSupport is a registered trademark of NetSupport Ltd.


OneRoster is a registered trademark of ClassLink, inc.

Other products, trademarks or registered trademarks are the property of their respective owners.
Software Licence Agreement

Please read this agreement before using your copy of NetSupport Software. This is a legal agreement between you and NetSupport Ltd. If you do not wish to be bound by the terms of this licence agreement you must not load, activate or use the software.

TERM: Subject to termination under Termination Clause below the licence shall be perpetual.

GRANT OF LICENCE: Subject to the payment of the applicable licence fees, and subject to your abidance by the terms and conditions of this agreement, NetSupport Ltd hereby grants to you a non-exclusive, non-transferable right to use one copy of the specified version of the software which you have acquired.

USE: The software is licensed with volume use terms specified in the applicable order acknowledgement, product invoice, licence certificate or product packaging. You may make, install and use as many additional copies of the software on the number of devices as the terms specify. You must have a reasonable mechanism in place to ensure that the number of devices on which the software has been installed does not exceed the number of licenses you have obtained.

SERVER USE: To the extent that the applicable order acknowledgement, product invoice, product packaging or licence certificate sets forth, you may use the software on a device or on a Server within a multi-user or networked environment ("Server Use"). A separate licence is required for each device or "seat" that may connect to the software at any time, regardless of whether such licensed devices or seats are connected to the software concurrently, or are actually using the software at any particular time. Your use of software or hardware that reduces the number of devices or seats that connect to and use the software directly or simultaneously (e.g., "multiplexing" or "pooling" software or hardware) does not reduce the number of licenses required. Specifically, you must have that number of licenses that would equal the number of distinct inputs to the multiplexing or pooling software or hardware "front end"). If the number of devices or seats that can connect to the software can exceed the number of licenses you have obtained, then you must have a reasonable mechanism in place to ensure that your use of the software does not exceed the use limits specified for the licence you have obtained.

COPYRIGHT: This software is protected by international copyright laws. You may copy it only for backup purposes. The software is licensed to you, but not sold to you.

RESTRICTIONS: Neither you nor any reseller may rent, lease, sell licensed copies [on approval], or otherwise transfer the right to use this software to another person, except that you may sell or give away your original copy, as long as you do not keep any copies. The software may not be modified, disassembled or reverse engineered except with the prior written consent of NetSupport Ltd.

LIMITED WARRANTY: NetSupport Ltd warrants that the software will perform substantially in accordance with the accompanying documentation for a period of ninety (90) days from the date of purchase. NetSupport's entire liability and your exclusive remedy shall be either a) the replacement of the defective software or b) return of the price paid. This remedy shall be at NetSupport's option and subject to proof of purchase from an authorised source.
Any implied warranties including any warranties of quality or fitness for a particular purpose are limited to the terms of the express warranties. NetSupport Ltd. Shall not in any event be liable for loss of profits, data or information of any kind or for special, incidental, consequential, indirect or other similar damages arising from any breach of these warranties or use of the software even if they have been advised of the possibility of such damages. Some countries do not allow the limitation or exclusion of incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warranty does not affect your statutory rights, and you may have other rights that vary from country to country. In any event NetSupport’s maximum liability shall not exceed the price paid by the end-user / licensee.

TERMINATION: You may terminate this licence and this Agreement at any time by destroying the program and its documentation, together with any copies in any form.

NetSupport Ltd. may terminate this licence forthwith by notice in writing to you if you commit any serious breach of any term of this licence and (in the case of a breach capable of being remedied) shall have failed within 30 days after receipt of a request in writing from NetSupport Ltd. so to do, to remedy the breach (such request to contain a warning of NetSupport’s intention to terminate). Upon termination you will destroy or return to NetSupport Ltd the original and all copies of the software and will confirm in writing to NetSupport Ltd that this has been done.

SUPPORT: If you have a problem with the installation of the software you should in the first instance contact your supplier. You can separately purchase support and maintenance which will also cover the supply of enhancements and upgrades.

GOVERNING LAW: This agreement shall be governed by the laws of England.
# Table of Contents

What is NetSupport School? ......................................................... 11  
Conventions used .................................................................. 13  
Terminology used .................................................................. 13  

**Installation** ........................................................................... 14  
System requirements .............................................................. 15  
Starting the installation .......................................................... 17  
  - NetSupport School Licence Agreement .............................. 18  
  - Licence information .......................................................... 18  
  - Select setup type ............................................................... 19  
  - Custom setup .................................................................. 20  
  - Ready to install the program ............................................ 23  
  - Installation complete ....................................................... 23  
  - Existing installation detected ........................................... 24  
Creating an administrative (network) installation .................. 25  
Silent installation .................................................................... 26  
  - Install Configuration Options dialog ................................. 27  
NetSupport School Deploy - NetSupport School’s Remote Install utility .......................... 28  
  - Starting NetSupport School Deploy .................................. 31  
  - Preparing a deployment .................................................. 32  
  - Deploy a NetSupport School package ............................... 33  
  - Deploy a Client Configuration ........................................... 38  
  - Deploy a NetSupport School licence file ............................ 39  
  - Remote uninstall ............................................................. 40  
  - Pre-define settings for a future deployment ....................... 42  

**Starting NetSupport School** .................................................... 44  
Starting NetSupport School ..................................................... 44  
NetSupport School Deploy - Room mode ............................... 46  
Finding and connecting to Students ........................................ 48  
  - Class wizard ................................................................. 49  
  - Connect to Students via Room mode ............................... 52  
  - Connect to Students using Browse mode ......................... 54  
  - Connect to Students using PC mode ............................... 55  
  - Connect to Students using User mode ............................. 57  
  - Connect to Students using SIS mode ............................... 58  
Class lists .................................................................................. 60
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting to NetSupport School for Mac Students</td>
<td>61</td>
</tr>
<tr>
<td>The Tutor Console</td>
<td>62</td>
</tr>
<tr>
<td>The List view</td>
<td>66</td>
</tr>
<tr>
<td>The status bar</td>
<td>68</td>
</tr>
<tr>
<td>Selecting Students to work with</td>
<td>69</td>
</tr>
<tr>
<td>Intermediate mode</td>
<td>70</td>
</tr>
<tr>
<td>Easy mode</td>
<td>72</td>
</tr>
<tr>
<td>Tutor Toolbar</td>
<td>74</td>
</tr>
<tr>
<td>Student automatic login</td>
<td>75</td>
</tr>
<tr>
<td>Student Register</td>
<td>76</td>
</tr>
<tr>
<td>Working with classroom layouts</td>
<td>81</td>
</tr>
<tr>
<td>Setting a background</td>
<td>82</td>
</tr>
<tr>
<td>Power management – power on/power off</td>
<td>83</td>
</tr>
<tr>
<td>Student power on</td>
<td>83</td>
</tr>
<tr>
<td>Student power off</td>
<td>84</td>
</tr>
<tr>
<td>Student disconnects from an active session</td>
<td>85</td>
</tr>
<tr>
<td>Removing a Student from a class</td>
<td>86</td>
</tr>
<tr>
<td>Configuring NetSupport School for subnet browsing</td>
<td>87</td>
</tr>
<tr>
<td>Understanding IP addresses</td>
<td>89</td>
</tr>
<tr>
<td>Implementing NetSupport School in a Terminal Server environment</td>
<td>91</td>
</tr>
<tr>
<td>Installing and configuring the NetSupport School Tutor Assistant</td>
<td>92</td>
</tr>
<tr>
<td>NetSupport School Windows 10 Teacher App</td>
<td>95</td>
</tr>
<tr>
<td>Installing and configuring NetSupport School on Google Chrome</td>
<td>97</td>
</tr>
<tr>
<td>Licensing for Google Chrome</td>
<td>100</td>
</tr>
<tr>
<td>Installing the NetSupport School Tutor for Android</td>
<td>102</td>
</tr>
<tr>
<td>Installing and configuring the NetSupport School Student for Android</td>
<td>103</td>
</tr>
<tr>
<td>Installing and configuring the NetSupport Browser App (iOS)</td>
<td>105</td>
</tr>
<tr>
<td>Licensing for tablets</td>
<td>106</td>
</tr>
<tr>
<td>Integration with Active Directory</td>
<td>107</td>
</tr>
<tr>
<td>Using NetSupport School in a wireless classroom</td>
<td>108</td>
</tr>
<tr>
<td>Using a NetSupport Connectivity Server/Gateways to find Student PCs</td>
<td>110</td>
</tr>
<tr>
<td>Installing and configuring a NetSupport Connectivity Server</td>
<td>111</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Configuration utility – General tab</td>
<td>112</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Configuration utility – Keys tab</td>
<td>114</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Configuration utility – Licenses tab</td>
<td>115</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Configuration utility – Security tab</td>
<td>116</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Configuration utility – Classes tab</td>
<td>117</td>
</tr>
<tr>
<td>NetSupport Connectivity Server Console</td>
<td>119</td>
</tr>
<tr>
<td>Working with groups</td>
<td>120</td>
</tr>
</tbody>
</table>
Deleting a group.................................................................................. 121
Group leaders .................................................................................... 123
Customise Student and group icons.................................................... 126

**Using NetSupport School** .................................................................. 128
Locking Student controls and blanking Student screens ..................... 129
Viewing Student screens .................................................................... 131
  Blanking the Student’s screen while viewing ................................... 131
  Sending Ctrl+Alt+Delete while viewing ............................................ 135
  Blank all Student screens ............................................................... 136
Remote clipboard .................................................................................. 137
Scanning Students ............................................................................... 139
  Scanning multiple screens simultaneously .................................... 140
Monitor mode ....................................................................................... 143
Keyboard Monitoring .......................................................................... 146
  Setting up word lists ..................................................................... 148
View typing history ............................................................................. 150
Screen capture ...................................................................................... 152
  Showing to Students .................................................................... 154
  Show leader .................................................................................. 157
  Exhibit - Showing one Student's screen to others ......................... 159
Student Feedback and Wellbeing.......................................................... 161
Interactive Whiteboard ....................................................................... 163
Annotating screens ............................................................................. 166
  Annotate toolbar .......................................................................... 167
Audio Monitoring .................................................................................. 168
Using Audio support ............................................................................ 171
  The Announce function ................................................................ 171
  Using audio while viewing ........................................................... 172
  Using audio while showing ......................................................... 172
  Adjusting audio settings ............................................................... 173
NetSupport School Video Player .......................................................... 174
  Play a video file on a machine ....................................................... 175
NetSupport School Video Player Control Panel ................................. 176
Using replay files ................................................................................. 178
  Record replay files for all Students ................................................. 179
  Record replay files for individual Students ..................................... 180
  Record replay files at the Tutor ...................................................... 181
  Watching replay files .................................................................... 182
Replay window - Control Panel .......................................................... 183
Showing replay files to Students ..................................................... 185
Converting replay files to video files .............................................. 186
Show Application .............................................................................. 187
Chatting to Students ........................................................................ 188
The Chat window ............................................................................ 190
Sending a message to Students ....................................................... 192
Creating preset messages ................................................................. 193
Help requests .................................................................................. 195
Transferring files ............................................................................ 198
Distributing files ............................................................................. 203
Sending and collecting work ............................................................. 205
Remotely launching applications and websites at Students ............. 210
User defined tools ........................................................................... 214
Rebooting or logging out Students .................................................. 216
Manage user account ....................................................................... 217
Web Control module ........................................................................ 219
Managing websites on Student machines ....................................... 222
Setting up an Approved or Restricted Website List ......................... 223
View web history ............................................................................ 228
Application Control module ............................................................ 230
Managing applications on Student machines .................................. 233
Setting up Approved or Restricted Applications ............................ 235
View application history ................................................................. 239
Student Surveys .............................................................................. 241
Survey lists ..................................................................................... 244
Question and Answer module .......................................................... 247
Question and Answer module - Tutor interface .............................. 251
Using the Question and Answer module ........................................ 253
Question and Answer Team Mode ................................................... 255
Printer Management ........................................................................ 257
Using Print Management ................................................................. 259
View print history ........................................................................... 262
Device Control ................................................................................ 264
Tutor profiles .................................................................................. 267
Manage Student resources ............................................................... 269
Student Journal .............................................................................. 270
Lesson planner ................................................................................ 276
Student Toolbar ............................................................................. 278
Student rewards ............................................................................. 281
NetSupport School 15.00

Student stickers........................................................................................................... 282

**Configuring the Student machine** ........................................................................ 283
Network Settings ........................................................................................................ 284
Room settings .............................................................................................................. 285
Security settings ......................................................................................................... 286
Audio settings .............................................................................................................. 288
User Interface settings ................................................................................................ 289
Advanced settings ....................................................................................................... 291
Student Journal settings .............................................................................................. 294
Terminal Services settings .......................................................................................... 295

**Configuring the Tutor machine** ............................................................................ 297
Start Options ................................................................................................................ 298
Tutor start-up restrictions ............................................................................................ 300
Network and Wireless Settings .................................................................................... 302
Performance settings .................................................................................................. 306
Student Selection .......................................................................................................... 307
Administration - Security settings .............................................................................. 309
Administration - Profiles .............................................................................................. 311

**Configuring Remote Control Settings** ............................................................... 314
Tutor View settings ..................................................................................................... 316
Tutor Keyboard/Mouse settings .................................................................................. 319
Replay File settings ...................................................................................................... 321
Audio settings .............................................................................................................. 322
Tutor Chat settings ...................................................................................................... 323
Tutor File Transfer settings ........................................................................................ 324
Tutor User Interface settings ....................................................................................... 327
Student User Interface settings .................................................................................... 329
Tutor Assistant settings ............................................................................................... 330
Group Leader settings ................................................................................................ 332
Student Toolbar Settings .............................................................................................. 333
Tutor Journal settings .................................................................................................. 334
Show settings ............................................................................................................... 336

**Tech Console** ......................................................................................................... 338
Searching for Students ................................................................................................. 342
Stopping the Student service ....................................................................................... 343
Remote inventory and system information ................................................................... 345
To retrieve a Student inventory .................................................................................... 345
The Inventory window ................................................................................................ 346
Running the Task Manager ......................................................................................... 348
The Task Manager window .......................................................................................... 348

The Inventory window ................................................................................................ 346
To retrieve a Student inventory .................................................................................... 345
The Task Manager window .......................................................................................... 348
Policy Management .......................................................... 351
Define and view Student security settings .......................... 353
Remote Command Prompt window .................................. 355
PowerShell window ......................................................... 357

**Testing Module** .................................................................. 359
The Test Designer .............................................................. 360
The Questions interface ...................................................... 362
The Exam interface ............................................................ 381
Setting up user accounts .................................................... 388
Admin options ................................................................. 389
Import/export data ............................................................ 390
The Testing Console .......................................................... 391
Test Reports window ......................................................... 394
The Test Player .................................................................... 396

**Contact us** ....................................................................... 398

**Index** ............................................................................. 399
What is NetSupport School?

NetSupport School is the market-leading classroom software solution for schools. Working across all platforms, NetSupport School supports a teacher with a wealth of dedicated assessment, monitoring, collaboration and control features to ensure they can leverage the very best from their ICT equipment.

Rising to the challenge and requirements of the modern classroom, NetSupport School provides the ability to orchestrate and deliver lesson content, work collaboratively and monitor student PCs, ensuring that complete student attention and focus is maintained at all times. There are no hidden extras: all features are included as standard including dedicated Teacher, Classroom Assistant and Technician modules.

NetSupport School is designed to work flawlessly over both wired and wireless networks with desktops, laptops or tablets and for use in traditional PC, thin client or virtualised environments.

Tutor Assistant
A free component available from both the Apple and Android App stores, the NetSupport Tutor Assistant delivers greater mobility for teachers around the classroom and is also the ideal tool to allow teaching assistants to help with monitoring student progress.

Apple iOS, Android tablet and smartphone compatible, once installed on a device the app pairs with the NetSupport School desktop Tutor software, allowing teachers the freedom to move around the classroom, helping retain key control and monitoring of all student machines/devices.

Teacher App - Windows 10
Provided in addition to the desktop Teacher application for Windows, the native Teacher App is designed for installation on Windows tablets and touch-enabled devices. In addition to all the expected core classroom features, the Teacher app also gives particular focus to the integration of key Windows 10 and Office 365 educational services.

Tutor for Android
The NetSupport School Tutor for Android extends the product’s capabilities into dedicated tablet-based classrooms, giving the teacher the power to connect to each student device and enabling real-time interaction and support.
**Note**: Student tablets must be running the NetSupport School Student app.

**Student for Android and Browser for iOS**
The NetSupport School Student for Android and Browser for iOS meets the challenges presented by the increased use of mobile technology in the modern classroom. Enabling mobile learners to participate in NetSupport-managed lessons, once installed on students’ Android tablets and iOS devices, teachers can interact with and support students from the traditional desktop Tutor application.

**Tutor for Google Chrome**
For use in dedicated Chrome OS learning environments, The NetSupport School Tutor for Chrome can be installed on the teacher’s Chrome OS system enabling you to interact with student Chromebooks.

**Student for Google Chrome**
Utilise the power of NetSupport School in a Google Chromebook education environment. For use in an existing or new NetSupport-managed classroom, the NetSupport School Student for Google Chrome extension can be installed on each student Chromebook running Google Chrome OS.

**NetSupport School for Mac**
For use within your Mac classroom, NetSupport School for Mac is a focused classroom management software solution that ensures teachers have the tools they need to monitor, engage and collaborate with their students.

**Note**: The NetSupport School Windows Tutor can connect to Mac Students if required.
Conventions used
The following logical and easy to understand conventions are used in this manual:

- Step-by-step instructions, which should be performed in sequence, are shown as numbered paragraphs, beneath a clearly stated, ‘How to do’ heading.
- As there is often more than one way of carrying out a task, you will find ‘Or’ options also included.
- Additional tips or explanatory notes regarding these instructions are enclosed in a border under the heading ‘Note’.

Terminology used

Control/Tutor
The ‘Tutor’ is the machine or device that shows to or views/takes over the Student. This is sometimes called the Control.

Client/Student
The ‘Student’ is the machine or device that is being shown to, viewed or taken over. This is sometimes called the Client.

Available Student
When a Student has been installed on a machine; it becomes available for connection to a Tutor. A Student must be available before a Tutor can connect to it.

Known Student
Having browsed for available Student, NetSupport stores a list of Student in the Client.NSS file. These are Known Student.

Connected Student
All available Students or groups of Students can be chosen for simultaneous connection. A Tutor can only remote control a Student to which they are connected.

Selected Student
A Student or group of connected Student s can be selected by the Tutor. The Tutor can then perform a variety of functions such as View, Show, and Message etc. A Tutor can switch between multiple Student s, making each of them, in turn, the selected Student.
Installation
Installing NetSupport School is exceptionally easy and you should be up and running within a very short time.

Decide what functions to install
If you wish to manage the class as the teacher, you will need to install the Tutor (Control) on your machine.

On every student machine you wish to connect to, you need to install the Student (Client).

To allow technicians to manage and maintain the school’s network, as well as providing technical support, you can install the Technicians’ Console.

Note: The NetSupport School Tutor is configured to use TCP/IP.

Recommended method to connect to Students (Clients)
Room Mode is a quick and easy method to connect to the Clients in a given room. A start-up wizard will allow you to assign machines to a particular room, and, at the start of a lesson, the teacher simply indicates which of the pre-defined rooms they wish to connect to. ‘Roaming’ Students also have the option of connecting to a designated room.

The Room settings can also be configured at the Student in the NetSupport School Student Configurator.

Other ways to connect the Tutor to the Students are via Browse Mode, PC Mode, User Mode or SIS Mode.

You are now ready to install NetSupport School Tutor and Student programs.
**System requirements**

Some areas of NetSupport School’s functionality rely on the presence of certain files/applications; please ensure these are available before installing NetSupport School.

**General**

Internet Explorer 8 or above.


250Mbytes free disk space for Student-only installation.

400Mbytes free disk space for a Tutor-only installation.

400Mbytes free disk space for an IT Technician-only installation.

600Mbytes free disk space for full installation.

50Mb free disk space for a NetSupport Connectivity Server-only installation.

TCP/IP.

*For the NetSupport School Tutor and Tech Console to run on Windows 7, Aero needs to be enabled. Choose **Start > Control Panel**. In the Appearance and Personalization section, click **Customize Color**. Choose Windows Aero from the Color Scheme menu and then click **OK**.

NetSupport School operates in Terminal Server, Thin/Zero Client, Virtual Desktop, Multiseat and shared-resource computing environments and is supported on Google Chromebooks, iOS and Android tablets.

Tutor Assistant app supported on iOS devices running version 9 and higher, Android 5.0 and higher.

Native Teacher app supported on Windows 10 devices.

Tutor for Android app supported on Android tablets running version 5.0 or later.

Student for Android app supported on Android tablets running version 5.0 or later.

NetSupport Browser app (iOS) supported on iOS devices running version 9.3.5 or later.

Mac support also available with [NetSupport School for Mac](#).

The NetSupport School Tutor requires a screen resolution of 1024 x 768 or above.
Synchronised Multimedia Player for WAV, MOV, AVI, MPG, etc. files.

**NetSupport Connectivity Server**
The NetSupport Connectivity Server is only supported on Windows 7 and above or Windows Server 2008r2 and above.

**Touch-enabled support**
NetSupport School Tutor running Windows 7 and above.
NetSupport School Student running Windows 8/8.1 and above.

**Testing module**
The Test Designer requires MDAC 2.1 or higher and COMCTL32.dll version 5.80 or higher. During installation, NetSupport will check to see if these files are present and advise if not. However, if installing ‘silently’ using the NetSupport School Deploy utility, you will not be warned if the files are missing.

**Note:** To enable printer notifications to be sent to the Tutor PC, the installer applies the following changes to the Student PCs:

**Windows firewall**
On installation, Windows firewall entries are automatically added to allow the product to be used for the active network. If you change to another network, you may need to extend the scope of the Windows firewall entries to allow connections to continue to be allowed through the Windows firewall.

**Local Security Policy settings**
On workgroup-connected PCs, the following local policy settings are set:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Access: Allow anonymous SID/Name translation</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Network Access: Do not allow anonymous enum of SAM accounts</td>
<td>DISABLED</td>
</tr>
<tr>
<td>Network Access: Do not allow anonymous enum of SAM accounts &amp; shares</td>
<td>DISABLED</td>
</tr>
<tr>
<td>Network Access: Let “everyone” permissions apply to anonymous users</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Network Access: Restrict anonymous access to Named Pipes and Shares</td>
<td>DISABLED</td>
</tr>
</tbody>
</table>
Starting the installation


Click the appropriate language from the menu and select the option to install NetSupport School.

Select which installer to use: setup.exe or MSI file (Active Directory deployments only).

If an Active Directory deployment is required, you will need to install using the MSI file.

**Note:** For further information on installing via Active Directory, please visit our Knowledge Base and refer to product article Installing NetSupport Manager or NetSupport School via Active Directory Group Policy.

The NetSupport School installation will start displaying a Welcome screen. Click **Next** to continue.

**Notes:**

- If you are upgrading your Windows operating system, you must ensure that you uninstall NetSupport prior to upgrading. NetSupport can then be re-installed once the operating system upgrade has been completed.
- When installing ensure you are logged in as an administrator.
- When installing NetSupport School on Windows 7, Windows 2008 Server R2, Windows 8 and Windows 2012 Server the Filter Driver may not be installed if you do not have the required Service Pack and hotfixes. You can still proceed with the NetSupport School installation without the Filter Driver, but some internet control features will be unavailable.

For further information, please contact our Technical Support team www.netsupportsoftware.com/support
**NetSupport School Licence Agreement**

The NetSupport Licence Agreement will be displayed. Please read the Licence Agreement carefully and select ‘I accept the terms in the Licence Agreement’ and click **Next** to continue.

If you reject the Licence Agreement, ‘I do not accept the terms in the Licence Agreement’ click **Cancel**. NetSupport School will not be installed and you will be directed to exit from the install program.

**Licence information**

Select **Register** and enter the NetSupport School licence details you have been provided with. If you are evaluating NetSupport, select **30 day evaluation**.

Choose what type of licence you wish to use:

- **All platforms**
  Your Students are all Windows-based or using a mixture of Windows, macOS, ChromeOS, Android and iOS.

- **Non Windows**
  Your Students are all using non-Windows devices (macOS, ChromeOS, Android or iOS).

Click **Next**.
Select setup type
Choose the setup type to install on the machine.

Student
Installs the Student software. This feature (the Client) should be installed on machines/devices that will be remote controlled.

Tutor
Installs the Tutor software. This feature (the Control) should be installed on machines/devices which will be used to remote control other PCs.

Note: When installing the Tutor, additional NetSupport School components are also installed by default, including the ‘Test Designer’, allowing you to design and playback customised tests at Student PCs; the Remote Deployment utility; and Replay File Conversion utility. To install a preferred combination of tools, choose the Custom install option.

IT Technician
Installs the Tech Console. This feature should be installed on machines that will be managing and maintaining computers.

Custom
Allows you to pick and choose which features to install on the machine.
Click **Next**. If you have selected **Custom**, the Custom Setup screen will be displayed.

**Custom setup**

![Custom Setup screenshot](image)

Select the component(s) to install on the machine.

**Student**

Install this component (the Client) on machines/devices that will be remote controlled. By installing this component, you are enabling a Tutor machine to establish a link with the Student. The range of features available to students is limited to those that enable them to communicate with the teacher: for example, sending a help request.

**Install Configurator**

The NetSupport School Student Configurator is used to customise the Student setup at each machine. For example, setting the transport to be used, allocating a Student name and setting security.

When you choose the Student component; you will also be given the option of installing the Student Configurator.
Clear this checkbox if you do not want to install the component, you can still configure the Student machine by running the Student Configurator at a later stage of this installation.

**Add Configurator Start Menu Shortcut**
Choose whether to create a Start Menu shortcut to the Student Configurator at the Student machine. The advantage of installing this at the Student machine is that it is easier to make changes to the settings in the future. The disadvantage is that the Students themselves could access the option and make changes.

**Note:** If you are installing the Tutor component, the Student Configurator will be installed by default.

**Tutor Console**
This component (the Control) should be installed on machines which will be used to remote control other PCs. It gives teachers access to NetSupport School’s full range of features: for example, viewing student screens and showing their screen to students.

Selecting this component will also install a Portable Tutor folder; this allows you to run the Tutor from a portable device such as USB Pen Drive, Memory Stick or Flash Drive.

For further information, please visit our Knowledge Base and refer to product article [Running the NetSupport School Tutor from a portable device](#).

**Note:** If you need the flexibility of allowing other machines to view this one, you can also install the Student component.

**Add Desktop Shortcut for Tutor**
Choose whether to create a desktop icon for the Control (Tutor) to enable easy access to the Tutor program.

**Remote Deployment Utility**
The Remote Deploy Utility enables you to perform multiple NetSupport School installations without the need to visit each individual machine.
**Tech Console (includes Remote Deployment Utility)**
This component should be installed on machines that will be managing and maintaining computers. It provides lab technicians and network managers with the main NetSupport School features.

Selecting this component will also install a Portable Tech Console folder. This allows you to run the Tech Console from a portable device such as USB Pen Drive, Memory Stick or Flash Drive.

**Add Desktop Shortcut for the Tech Console**
Choose whether to create a desktop icon to enable easy access to the Tech Console program.

**Name and Connectivity Server**
This provides a simple and reliable method of locating and connecting to Student PCs.

---

**Notes:**
- The NetSupport Connectivity Server is only supported on Windows 7 and above or Windows Server 2008r2 and above.
- The NetSupport Connectivity Server can't be installed on a machine that has the NetSupport DNA Local (Server) Gateway installed on it.

---

**Replay Conversion Utility**
This utility allows you to convert Replay Files to video files.

**Note:** This will be installed by default if you are installing the Tutor or Tech Console component.

---

**Design and playback tests**
Installs the NetSupport School ‘Test Designer’ component allowing you to create and run customised tests, exams and quizzes including text, picture, audio and video questions.

**Install to:**
By default, NetSupport School will be installed in the folder C:\Program Files\NetSupport\NetSupport School. If you want to install in a different folder, click **Change**.

Click **Next** when ready to continue.
**Room Identification**
Enter the value for the room you wish to connect to. The default room value is Eval. The room value can be updated later in the Tutor Configuration settings.

Click **Next** to continue.

**Ready to install the program**
To start the installation, click **Install**. To change any of the previous selections, click **Back**. To quit the installation, click **Cancel**.

---

**Note:** If you have elected to install a Client (Student), the setup will make the required amendments to your System.INI and/or registry, to load the Client as Windows initialises. NetSupport School will not replace any of your existing Drivers.

---

**Installation complete**
To complete the installation:

- Choose whether to run the Client Configurator. This enables you to set basic Client information and security.
- Choose whether to run the Remote Deploy utility. This provides you with the facility to install and configure NetSupport School on multiple machines.

Click **Finish** to exit the Setup program.
Existing installation detected
This screen will appear if a copy of NetSupport School is already installed
on the machine.

- **Modify**
  Change the program features that are installed.

- **Repair**
  Repair any installation errors in the program.

- **Remove**
  Remove NetSupport School from the computer.

Select the required option and click **Next**.
Creating an administrative (network) installation

An administrative installation (distribution copy) of NetSupport School is designed to assist administrators to install NetSupport on networked PCs where the installation media or licence details may not be readily available and it is anticipated that a number of installs will be performed either at once or over a period of time.

This type of installation can also be preconfigured to setup NetSupport School with certain options, therefore ensuring that all NetSupport School installations are configured the same.

Once created, the distribution copy can be used when performing a standard install, a silent installation or as part of a remote deployment.

**To set up a distribution copy of NetSupport School on a Server**
1. Create a folder on the network that is accessible to all PCs that you may want to install on.
2. Copy, from your original source media, the file SETUP.EXE.
3. Create and copy a valid NSM.LIC file to this folder. If a licence file is not present in the folder when running the install, NetSupport School will be installed using the default Evaluation licence.
4. Create and copy a CLIENT32U.INI file to this folder.

**Note:** You can make the network folder ‘read-only’ to avoid the configuration being altered by unauthorised users.

**To install NetSupport School from a Server onto individual machines**
1. At the required machine, navigate to the network folder containing the NetSupport School setup files.
2. Run Setup.exe.
3. Follow instructions in Starting the Installation.
Silent installation

A silent installation is one that requires no input from the user, providing a convenient method for performing a set installation at several machines.

To perform a silent install

1. Create a distribution copy of NetSupport School containing the required NetSupport School installation files, NSS.ini and NSM.lic (the NSM.lic is not required if you are evaluating).
2. To determine the properties for the installation, at the command line run INSTCFG.EXE /S from the NetSupport School program folder. The Install Configuration Options dialog will appear. The selected properties are stored in a parameter file, NSS.ini.
3. Choose {File}{Save} and save the 'NSS.ini' file to the folder containing the distribution copy of NetSupport School.
4. To perform the silent install at the required machine, from the folder containing the distribution copy, run:

   msiexec /i "NetSupport School.msi" /qn (MSI installer)

   setup /S /v/qn (setup.exe installer)

Note: NetSupport School can be installed via Active Directory. The software installation group policy object (GPO) must be applied to organisational units (OUs) containing computer accounts rather than users. Please note that for software installation to take effect immediately, it is necessary to enable the, Always wait for the network at computer start-up and logon parameter in the Computer Configuration\ Administrative Templates\ System\ Logon\ leaf of the group policy controlling the computers that are subject to software installation. Without this change, an additional log off / log on cycle is required to effect installation.
Install Configuration Options dialog

When performing a silent installation or using NetSupport School Deploy, you can customise the installation to suit individual requirements. This dialog, accessed by running INSTCFG.EXE /S from the NetSupport School program folder if performing a silent installation or if using NetSupport School Deploy, via the Install Properties General tab, enables you to specify the variables for the installation. The information is stored in a parameter file: default name NSS.ini.

**Icons**
Select the relevant check boxes to indicate which NetSupport School components will be installed on the Client machines.

**General**

**Install Directory**
Specify the directory where NetSupport School will be installed. Leave blank to install in the default directory:

32bit C:\Program Files\NetSupport\NetSupport School
64bit C:\Program Files(x86)\NetSupport\NetSupport School
**NetSupport School Deploy - NetSupport School’s Remote Install utility**

The NetSupport School Deploy utility provides network administrators with the facility to install and configure NetSupport School on multiple machines without the need to visit the machines individually.

Within the NetSupport School Deploy utility, you have the ability to deploy using an IP address range (specified IP ranges or computers with an IP range local to the Tutor machine), Windows Domains or, alternatively, you are provided with a view of your network. These methods allow you to pick and choose which machines you want to deploy to.

**With NetSupport School Deploy, you can:**
- Remotely install a NetSupport School package on multiple machines simultaneously.
- Create and download specific Client configurations to multiple machines.
- Remotely update NetSupport School licence details on multiple machines.
- Remotely uninstall a NetSupport School package from multiple machines simultaneously.

**Note:** When deploying to a PC within a domain, the console user must be either logged onto the domain or enter the user credentials (when prompted) of a domain account that has local administrator rights to the target PC.

**Installing the Deploy utility**

When installing NetSupport School, you decide which combination of components to include. To install NetSupport School Deploy, select the **Remote Deployment Utility** along with any other components you require.

NetSupport School Deploy is currently supported on the following operating systems:

- Windows Server 2008r2
- Windows 7
- Windows 8/8.1
- Windows Server 2012
- Windows 10
• Windows Server 2016
• Windows Server 2019
• Windows 11
• Windows Server 2022

Planning
NetSupport School Deploy is a powerful utility that makes installing NetSupport School packages on multiple machines a quick and easy process. However, while we endeavour to ensure that there are no limitations or incompatibility issues in the use of the software, it is recommended that a trial deploy is performed on a small number of machines to ensure there are no conflicts with other similar products such as remote control or desktop security packages. In addition, for added security and protection, you must have appropriate administrator rights for the machines you are deploying to.

How does NetSupport School Deploy work?
Once the Deploy options have been configured, the NetSupport School Deploy utility works by connecting to the target computer using File and Print Sharing.

This method requires access to the target computer’s Admin$ and will need to connect as a user with local administrator access (user details may be requested).

Once authenticated, the NetSupport School package files are copied to the following folder on the remote PC using the connection to the Admin$ share:

C:\Windows\pcirdist.tmp

Finally, once the files have been sent to the target PC, the installer file is executed using the Remote Procedure Calls (RPC) Service.

What are the requirements?
In order to successfully deploy NetSupport School components to your target PCs, the following items are required:

• File and Print Sharing must be enabled on the target PC.
• The Sharing and Security for local accounts policy must be set to {Classic} on the target PC.
• The user account used to connect to the target PC must have local administrator permissions on the target PC.
• Network discovery must be enabled on target PCs.
• UAC Remote Restrictions must be disabled for target PCs in a workgroup environment.
Starting NetSupport School Deploy


The Deploy main window is divided into the following sections:

**Menu bar**
The menu bar contains a series of drop-down menus that can be used to access the various tools and configuration utilities for the deploy process.

**Left-hand pane**
Contains three tabs: Network, Log Files and Security.

**Network and Security tabs**
List, in a Tree view, the available networks, domains and workgroups that can be selected for a deploy routine.

**Log Files tab**
Lists, in a Tree view, a history of previous deployments.

**Right-hand pane**
With the **Network tab** selected, you are provided with a range of general information about the machines located on the selected network/domain (machine name, Client address, Mac address, NetSupport School Client version and platform).
The **Log Files tab** provides a breakdown of past deployments categorised by type.

The **Security tab** also lists information specific to each individual machine located on the chosen network/domain. In addition to the machine name, IP address, Client version and platform, you will be able to see whether the Client is password protected or has user acknowledgement set. With this information to hand, you can decide in advance which machines to include or exclude from the forthcoming deployment. For example, if a current NetSupport School Client is already installed at some of the machines, you might choose to ignore it.

**Preparing a deployment**

**Choosing who to deploy to**

1. From the main window, select the Network or Security tab.
2. A list of available networks, domains and workgroups will appear in the left-hand pane. Expand or reduce the Tree list by clicking on the arrows.

   **Note:** You can also deploy to specific IP ranges by adding the appropriate address range to the Tree. Select {Tools}{Add IP Range} from the menu bar.

3. Highlight the required group in the Tree view.
4. The names of the machines belonging to the selected group will appear in the right-hand pane. Click between the Network and Security tabs to view specific information about each machine. You can change the appearance of the list view by selecting {View} from the menu bar.
5. Select the machines to include in the deploy routine. (You can use CTRL-Click or SHIFT-Click). Before deciding to include or exclude a machine, you can view its properties by right clicking on the machine name.
Choosing what to deploy

You can choose:
- NetSupport School package.
- Client Configuration.
- NetSupport School licence file.
- Uninstall NetSupport School.

Note: The properties for each of the above can also be pre-defined if it is not convenient to deploy immediately. See Pre-define settings for a future deployment.

Deploy a NetSupport School package

1. Select the required machines.
2. Choose {Deploy}\{NetSupport School Package\} from the Deploy Main window drop-down menu.
   Or
   Right click the selected machines and choose Deploy -NetSupport School Package.
3. The Deploy Summary dialog will appear.

This dialog provides a summary of the options you have selected for the deployment. If a first-time deployment, the text will appear in red to indicate that the required information has not been entered. To enter or amend the information for the deployment, click Properties.
4. The Install Properties dialog will appear.

![NetSupport School Install Properties dialog]

5. Enter the properties for the deployment by selecting the five tabs in turn.

**General tab**
Used to specify the NetSupport School package to deploy and which components are to be installed.

Enter a description for the package being deployed. If left blank, the package name/version number will be used.

Click **Browse** and select the folder containing the NetSupport School package to install. Ideally, this will be a folder containing a distribution copy of NetSupport School. (See the ‘Creating an administrative (network) installation’ section of this manual.)

Click **Edit** to specify the components to install. The Install Configuration Options dialog will appear. (See the ‘Install Configuration Options dialog’ section of this manual for a full description of this dialog.)

When you have completed this dialog choose {File}{Save} to save the NSS.ini file to the folder containing the distribution copy of NetSupport School.
Options tab
Use the information supplied in the Network and Security tabs to identify which machines may already have NetSupport School installed, you can then choose to:

- Ignore them by checking the **Skip machines already running NetSupport School** box.
- Update the machines with the latest version by checking the **Update new or older systems to current version** box.
- After deploying the package, you can confirm that the Client is running by checking the **Verify Client running after restarting** box. Ensure that machines are restarted automatically after the deploy for this option to work. See Restart tab.

Acknowledgement tab
Consider whether the machines will be in use when commencing the deploy. You can choose to:

- **Install NetSupport School Immediately**
  No prompt will be received at the machines being deployed to.
- **Warn user before installing NetSupport School**
  The user will receive a prompt and needs to click **OK** for the install to commence. Users cannot cancel this.
- **User can postpone NetSupport School installation**
  You can specify the number of times a user can postpone the installation. If the user does choose to postpone, they will be re-prompted at hourly intervals or the next time they restart the machine whichever comes earlier.

Message tab
You can specify a custom message to be displayed at each machine while the installation is in progress.

Restart tab
These options are only applicable if the target PCs require a forced restart to complete the installation.

**Note:** If you have asked for verification that the Client is running (see Options tab), you must choose an option that will force the machines to be restarted immediately.
• **Advise user to restart machine**
  At the completion of the deployment, a message will be displayed at machines asking the user to restart the PC at the next convenient opportunity. Do not choose if the note above applies.

• **Insist user restarts machine**
  A message will be displayed at machines advising the user to restart the PC to complete the installation.

• **Force restart**
  At the end of the deployment, a message is displayed advising users that the machine will be restarted. A time bar is displayed indicating how many seconds it is before the restart commences.

• **Automatic restart if not logged on**
  If the machine being deployed to is not logged on, a restart will commence automatically.

6. When you have completed all five tabs, click **OK** to return to the Deploy Summary dialog. You can review your selections and edit if required.

7. Click **Deploy** to commence the installation. A progress dialog will appear, enabling you to monitor the deployment as it installs on each machine.

The dialog has two tabs:
- **Log tab** enables you to monitor the deployment as it reaches each machine.
Status tab lists the stage the deployment has reached on each machine. For example, the installation may be complete on one machine but still in progress on another.

8. Click Close to return to the Deploy main window when the installation is complete.
Deploy a Client Configuration

Using NetSupport School Deploy, you can remotely deploy a Client Configuration file containing specific Client settings.

1. Select the required machines.
2. Choose {Deploy}-{Client Configuration} from the Deploy Main window drop-down menu.
   Or
   Right click the selected machines and choose **Deploy - Client Configuration**.
3. The Deploy Summary dialog will appear.
4. Click **Properties** to enter the details for the deployment.
5. Click **Browse** to specify the folder containing the Client Configuration file that is to be deployed. The default configuration file is CLIENT32U.INI and is stored in the NetSupport School installation directory.

   **Note:** The default configuration file for Clients pre-v12.50 is CLIENT32.INI.

6. Click **Edit** to access the Client Configurator in order to make changes to the Configuration file.
7. You can specify additional Client parameters if required. For example, this may be the location of an additional Configuration file to which you want to add specific user credentials (name and password).
8. For the new settings to take effect immediately, the Client Service will be automatically restarted after the deployment. If a restart is not required, uncheck the **Restart the Client service** box.
9. Click **OK** to return to the Summary dialog. You can view the contents of the configuration file by clicking on the file name.
10. Click **Deploy**. A progress dialog will appear, enabling you to monitor the status of the deployment.
11. Click **Close** when complete.
Deploy a NetSupport School licence file

When installing a NetSupport School package, a licence file is sent to each machine. However, there may be occasions when the licence information needs updating. For example, you have purchased additional licences and the licence file needs updating to reflect this. By using NetSupport School Deploy you can remotely update the file on user machines.

1. Select the required machines.
2. Choose {Deploy}‐{NetSupport School Licence file} from the Deploy Main window drop‐down menu.
   Or
   Right click the selected machines and choose **Deploy - NetSupport School Licence file**.
3. The Deploy Summary dialog will appear.
4. Click **Properties** to enter the details for the deployment.
5. Click **Browse** to specify the folder containing the licence file that is to be deployed. The default file is NSM.LIC.
6. For the new settings to take effect immediately, the Client Service will be automatically restarted after the deployment. If a restart is not required, uncheck the **Restart the Client service** box.
7. Click **OK** to return to the Summary dialog. You can view the contents of the licence file by clicking on the file name.
8. Click **Deploy**. A progress dialog will appear, enabling you to monitor the status of the deployment.
9. Click **Close** when complete.
Remote uninstall

1. Select the required machines.
2. Choose \{Deploy\}{Uninstall NetSupport School} from the Deploy Main window drop-down menu.
   Or
   Right click the selected machines and choose **Deploy-Uninstall NetSupport School**.
3. The Deploy Summary dialog will appear.
4. Click **Properties** to enter the details for the deployment. The Uninstall NetSupport School dialog will appear.

5. Enter the properties for the deployment by selecting the four tabs in turn.

**General tab**
Provides a description of the package being uninstalled.

**Acknowledgement tab**
Consider whether the machines will be in use when commencing the deploy. You can choose to:
- **Uninstall NetSupport School Immediately**
  No prompt will be received at the machines being deployed to.

- **Warn user before uninstalling NetSupport School**
  The user will receive a prompt and needs to click **OK** for the uninstall to commence. Users cannot cancel this.

- **User can postpone uninstall of NetSupport School**
  You can specify the number of times a user can postpone the uninstall. If the user does choose to postpone, they will be prompted the next time they restart the machine.

**Message tab**
You can specify a custom message to be displayed at each machine while the uninstall is in progress.

**Restart tab**
To completely remove all NetSupport School files, the machines must be restarted.

- **Insist user restarts machine**
  A message will be displayed at machines advising the user to restart the PC to complete the process.

- **Force restart**
  At the end of the deployment, a message is displayed advising users that the machine will be restarted. A time bar is displayed indicating how many seconds it is before the restart commences.

- **Automatic restart if not logged in**
  If the machine being deployed to is not logged in, a restart will commence automatically.

6. When you have completed all four tabs, click **OK** to return to the Deploy Summary dialog. You can review your selections and edit if required.

7. Click **Deploy** to commence the uninstall. A progress dialog will appear, enabling you to monitor the deployment as it uninstalls each machine.

8. Click **Close** when complete.
Pre-define settings for a future deployment

There may be occasions when you want to defer a deployment until a more convenient time of the day. With NetSupport School Deploy, you can prepare the settings in advance and choose when to perform the deployment.

**Note:** You select the machines to deploy to when you are ready to run the deployment.

**To prepare the settings for a future deployment**
1. Choose {Deploy}{Configuration} from the Deploy main window drop-down menu.
2. The Deploy List dialog will appear. Select the required Deploy option. (Package, Client Configuration, Licence file or Uninstall)
3. Click **Properties** and enter the required settings.
4. When all settings are entered, click **Close** to return to the Deploy main window.

**To run the deployment**
1. Select the machines to Deploy to. See Preparing a Deployment.
2. Choose {Deploy} from the main window drop-down menu.
   Or
   Right click the selected machines and choose **Deploy**.
3. Select the required Deploy option.
4. The Deploy Summary dialog will appear, showing your pre-defined selections. You can edit these if required.
5. Click **Deploy** to start the deployment.
Log files
When using NetSupport School Deploy, information about each deployment, whether a package install, license update, configuration download or uninstall, is recorded. This provides a useful reminder each time you use the utility of what you have previously deployed. The information is stored in a Log File.

To view log files
1. From the NetSupport School Deploy main window, select the Log Files tab.
2. In the left-hand pane of the main window, increase or decrease the Tree view to see a description of each type of deployment, the date and time the deployment took place and the machines that were deployed to.
3. As you select an item from the left-hand pane, itemised information about that deployment will appear in the right-hand pane.

Printing a log file
1. Select the required Log File in the Tree view.
2. Choose {Log}-{Print} from the Deploy Main window drop-down menu.

Deleting a log file
1. Select the required Log File in the Tree view.
2. Choose {Log}-{Delete} from the Deploy Main window drop-down menu.
Starting NetSupport School
This section will guide you through starting NetSupport School.

The main point to remember when using NetSupport School is that the machine that is taking control of other machines is called the Control or Tutor, and the machines being controlled are called the Clients or Students.

Note: This guide assumes you have already installed NetSupport School. If you have not done this, do so now. See the Installation section for details.

Starting NetSupport School
After installation, the Student program is automatically loaded on the Student machines as they start up.

To start the NetSupport School Tutor Console
   Or
   Click the NetSupport School Tutor Console desktop icon (if you installed a desktop shortcut for the Tutor Console).
   Or
   Click the Start screen, choose All apps/Programs, NetSupport School, NetSupport School Tutor Console.

Note: On Windows 8, only the Tutor and Tech Console icons will appear in the Start screen. You can access the other NetSupport School components by right-clicking and selecting All Apps along the bottom of the screen. If you want any of the other NetSupport School components to appear on the Start screen, right-click the item and choose Pin to Start.

NetSupport School provides three modes for viewing the Tutor user interface: advanced, intermediate and easy. Advanced mode provides full access to all of NetSupport School's features and functions. Intermediate mode provides access to the primary features and frequently used teaching tools. Easy mode provides access to a focused set of classroom management features needed to maintain control over a class. When NetSupport School loads, you will be asked how you would like to use it.
The Welcome wizard will appear if you have chosen advanced or intermediate mode. From here, you can deploy the Student software onto new computers in your current classroom, by clicking Classroom. If you need to deploy the Student software across your network or need more advanced options, click Network to open the NetSupport School Deploy utility. To just start the Tutor program, click Start and the Class wizard will appear.

The Class wizard enables you to enter the general properties of a new lesson and allows you to choose how to locate and connect to your Students. You can create multiple classes using different connection methods. The required class can then be loaded at the start of the lesson and you can quickly connect to Student machines.

**Note:** The options available in the Class wizard will depend on the Tutor user interface mode you have selected.

As the Tutor program loads, NetSupport School will then browse the network for the specified Students. While it is searching, the browsing message will be displayed. All connected Students will have their icons displayed in the Tutor Console. A warning icon will highlight machines you have been unable to connect to. Mouse over the icon to display the reason why the connection failed.

**Note:** If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down set of features.

You can enter or alter the lesson details for the current class in Normal view. This pane can be minimised by clicking the Minimise View icon.

**Note:** To prevent the Tech Console from automatically connecting to the Tutor machine, ensure the NetSupport School Student is installed and set the Enable User Acknowledge option in the Student Configurator. You will have to confirm the connection before it can take place.
**NetSupport School Deploy - Room mode**

NetSupport School provides a quick and easy way to assign PCs to a particular room and quickly deploy the Student software to those machines. The Tutor specifies the required room at the start of a lesson and will connect to all computers in that room.

**Note:** If you need to deploy the Student software across your network or need more advanced deploy options, you will need to use the NetSupport School Deploy utility. This can be accessed by clicking **Network** on the NetSupport School Start-up wizard or selecting `{Start}\{Programs}\{NetSupport School}\{NetSupport School Deploy}`.

1. From the NetSupport School Start-up wizard, select **Classroom**.

![NetSupport School Deploy dialog](image)

3. Enter the room to assign the computers.
4. The Workgroup/Domain drop-down list will display all the available domains and workgroups, you can also deploy to specific IP ranges by selecting **Add a new IP range** from the list.
5. The available computers will be displayed in the Available Computers list.
6. Select the computer(s) to deploy the Student software to and click **Add**. The computer(s) will be moved to the ‘Computers to deploy to’ list.
7. Click **Finish** to commence the installation. A progress dialog will appear, enabling you to monitor the deployment as it installs on each computer.

8. The NetSupport School Student software will be deployed to the requested machine and assigned to the room specified.

**Note:** You can also access the NetSupport School Basic Deploy dialog from the Tutor Configurator. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu, choose **Network and Wireless Settings** and click **Deploy**.
Finding and connecting to Students

The Class wizard enables the Tutor to select the connection mode that best suits their requirements. The Class wizard is displayed when the Tutor program is initially started and when a class is restarted. You can also specify how Students are connected to and configure these settings in the Tutor Configuration. Click Options in the Tutor Console, select Network Settings from the drop-down menu and choose Student Selection.

The connection methods available are:

- **Room mode**
  Connect to Student computers by room(s).

- **PC mode**
  Connect to a fixed list of Student computers by machine name.

- **User mode**
  Connect to a fixed list of Students (by logged on user name).

- **Browse mode**
  Browse the network and connect to Student computers with a specific machine name.

- **SIS mode**
  Connect to your SIS environment using OneRoster or Google Classroom.

The default method is ‘Room mode’.

Notes:
- If the expected Students are not found, it may be because NetSupport School has not been configured to browse the required networks. See Configuring NetSupport School for Subnet Browsing for more information.
- If a 'Name Server/Gateway' has been configured, the Tutor program will use the details registered here rather than perform a browse across the network.
- It is essential that you have a logical naming convention for the Student machines. If you need to change the names of any Student machines see Configuring the Student machines.
Class wizard

The Class wizard enables you to enter the general properties of a new lesson and allows you to choose how to locate and connect to your Students. You can create multiple classes using different connection methods. The required class can then be loaded at the start of the lesson and you can quickly connect to Student machines.

**Note:** The options displayed will depend on the Tutor user interface mode you selected at startup.

![New Class Window](image)

**Lesson Details**

You have the option to input the teacher name, lesson title, lesson objectives and outcomes. If these details are completed, they will form part of the Student Register and be displayed in the Student Toolbar.

**Note:** The Teacher username field will only be available when connected to SIS mode. Select the required teacher name from the drop-down list; a list of classes will appear in the Connect to pane.
**What time does this Lesson finish?**
Enter the time you want the class to finish; a timer will appear while the lesson is in progress. If you do not want the lesson to be timed, enable the **Open Lesson** option.

**Connect to**
Select the method to locate and connect to Students.

Click **New** to create a connection method for your class. The Select Start-up Mode dialog will appear: you can connect by a Room, a list of PC names, a list of Student logon names or browse the local network to locate Students.

**Note:** To connect using SIS mode, you need to click **Configure**. For further information, see Connecting to Students using SIS Mode.

When the connection method for your class has been defined, it appears in the Class wizard and is available for selection. Double click the required class or highlight the class and click **Select**.

**Note:** If you're connecting by Room mode, you can connect to multiple rooms by highlighting the required rooms (click Ctrl and select the required rooms) and clicking **Select**.

Once the connection list is populated with the required class(es), you can click the **Large Icon** and **Details View** buttons to switch view mode. Details View is particularly useful when connecting using SIS Mode as it will import additional class details, if previously entered into your student information system, to further help identify the correct item if a number of similarly named classes are listed.

To modify an existing class, select the required class and click **Edit**. The dialog relating to the method of connection will appear, allowing you to modify the details.

**Note:** For SIS Mode connections the Edit dialog is read-only, allowing you to view the imported SIS data including the individual student names.

To delete a class, select the required class and click **Remove**.

**Power On**
Turns on all computers when connecting by Room or PC names.
Ad-hoc room
From here, you can enter an ad-hoc room to connect to. This option will only be displayed if the Prompt at start-up option has been selected in the Tutor Configuration – Student Selection settings.

Create a Journal
Allows you to start or open an existing Journal.

Create a Student Register
Before the lesson starts, you can prompt the Students to login with their names. These will be displayed at the Tutor instead of the machine names.

Don’t show this dialog again
By checking this box, the Class wizard will not appear at start-up.

Note: To re-activate the Class wizard to appear at start-up, set the Display Class Wizard option in the start-up section of the configuration.

Configure
Provides access to a selection of Tutor configuration settings that allow you to apply network settings, such as, enabling the NetSupport Connectivity Server and choosing which connection method to use.

Click OK to start the lesson. The Tutor will now browse and connect to Students using the selected connection mode. If you have asked for Students to register their names, the Register Student dialog will appear.
Connect to Students via Room mode

NetSupport School provides a quick and easy method to connect to the machines in a given room. An intuitive start-up wizard enables you to assign PCs to a particular room and quickly deploy the student software to those machines. At the start of a lesson, the teacher simply indicates which of the pre-defined rooms they want to connect to. ‘Roaming’ Students also have the option of connecting to a designated room.

The Room settings can also be configured at the Student in the NetSupport School Student Configurator.

Connecting using the Class wizard
1. In the Class wizard, select New.
2. Click Room Mode.
3. Enter the name of the new room.
4. To make this the active connection method, select Make this the active connection method.
5. Click OK.
6. The new class will appear in the Class wizard.

7. Click OK.
8. The Tutor will browse for and connect to all Students found and display their icons in the Tutor Console.

Configuring rooms using the Tutor Configurator
1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.
2. Select Student Selection.
3. Click the Connect to Students in Room(s) option and enter the required room.
4. To choose from a list of rooms in the Class wizard, click Select from list of rooms. Enter the required room names, separating each value with a comma.
5. To allow students to join your room, click Acknowledge Roaming Students.
6. Click Prompt at startup if you want the Tutor to be able to specify an ad-hoc room to connect to in the Class wizard.
7. Click OK.
8. Click Yes to re-initialise the Tutor configurator.
9. The Class wizard appears, showing the room(s) you have set. Select the required room, click **Select** and click **OK**.

   **Note:** You can connect to multiple rooms by highlighting the required rooms (click Ctrl and select the required rooms) and clicking **Select**.

10. The Tutor will connect to all Students found and display their icons in the Tutor Console.

   **Note:** A warning icon will be displayed next to Students that have been unable to connect. Mouse over this icon to see the reason for the failed connection.

**Students manually connecting to a room**

Roaming Students can be configured to either manually enter the room or choose from a list of available rooms from the Student icon in the system tray. If the Student icon is hidden in the system tray, the Student can still manually enter the room by running the setroom.exe. This file is located in the Program folder on the Student machine.

   **Note:** For a roaming Student to be able to connect to a room, you must ensure that the **Acknowledge Roaming Students** option is selected in the Tutor Configurator. In the Student Configurator, one of the following mobile options must be selected: **This is a mobile computer and may be in one of the following rooms** or **This is a mobile computer and its room will be entered manually**. For Students to be able to browse all available rooms, select **Display all available rooms**.

1. Select the NetSupport School Student icon from the system tray and choose **{Commands}**-{Enter/Leave Room} from the Student drop-down menu.
   Or
   Right-click the Student icon and choose **Enter/Leave Room**.
2. The Enter/Leave Room dialog will appear and, depending on the option set in the Student Configurator, the Student can enter the required room name, choose a room from a drop-down list, or see all available rooms.
3. Click **OK** or **Enter Room**.
4. The Student will connect to the selected room and appear at the Tutor Console.
Connect to Students using Browse mode

Browse Mode allows you to browse the local network and connect to all available Students that match your search criteria.

Connecting using the Class wizard
1. In the Class wizard, select **New**.
2. Click **Browse Mode**.

![NetSupport School Browse dialog](image)

4. Enter the first few characters of the Student names that you want to connect to. For example, entering Class1 would connect to all machines whose Student name started with Class1. e.g. Class1_Wk1, Class1_Wk2 etc.
5. To make this the active connection method, select **Make this the active connection method**.
6. Click **OK**.
7. The new class will appear in the Class wizard. Click **OK**.
8. The Tutor will browse for and connect to all Students found and display their icons in the Tutor Console.

Connecting using the Tutor Configurator
1. Click **Options** in the Tutor Console and select **Network Settings** from the drop-down menu.
2. Select **Student Selection**.
3. Click **Browse and connect to Students starting with**: and enter the first few characters of the Student names you want to connect to. This can be left blank to search for all Students.
4. Click **OK**.
5. Click **Yes** to re-initialise the Tutor configurator.
6. The Tutor will browse for and connect to all Students found and display their icons in the Tutor Console.
NetSupport School 15.00

Notes:

- If a machine is not available at the time the Tutor initialised, you can subsequently connect to it by clicking the class in the status bar and choosing Refresh. This will re-search the network and connect any additional Students meeting the criteria.
- If required, a message can be displayed at the Student machine when a connection is made. See the Configuring the Student section of this manual.
- A warning icon will highlight machines you have been unable to connect to. Mouse over the icon to display the reason why the connection failed.

Connect to Students using PC mode

PC Mode allows you to connect to a fixed list of Student computers by machine name. When connecting to Students using PC mode, the Students will become part of the Fixed list of PCs. The Fixed list of PCs is a list of available Students that have been found on the network. These details are stored in the Client.NSS file.

Connecting using the Class wizard

1. In the Class wizard, click New.
2. Click PC Mode.
3. The Create Class dialog will appear.

![Create Class dialog]

4. Specify a name and description for your class.
5. Enter a prefix for the Students’ computer names in the text box (leave blank to search all computers).
6. Click **Browse**.
7. All Students matching the prefix will appear in the 'Available Students' list.
8. Select the Student icons to include in your class and click **Add**.
9. To make this the active connection method, select **Make this the active connection method**.
10. Click **OK**.
11. The new class will appear in the Class wizard. Click **OK**.
12. The Tutor will connect to the selected Students and display their icons in the Tutor Console. These Students have now been added to the Fixed list of PCs.

**Connecting using the Tutor Configurator**

1. Click **Options** in the Tutor Console and select **Network Settings** from the drop-down menu.
2. Select **Student Selection**.
3. Click **Connect to a list of Students**.
4. Click **OK**.
5. Click **Yes** to re-initialise the Tutor configurator.
6. The Class wizard will appear. Follow the above steps in ‘Connecting using the Class wizard’.

**To remove Students from the Fixed list of PCs**

1. Click the class name on the status bar and select **Modify Class**.
2. The Modify Class dialog will appear.
3. Select the Student icon from the 'Student in class' list.
4. Click **Remove**.
5. The Student is now available but is not part of the fixed list of PCs.
6. Click **OK**.
7. The Student icon will be removed from the Tutor Console.

**Note:** In order to reconnect to a removed Student, you must browse for them and add them to the 'Students in class' list.
Connect to Students using User mode

User Mode allows you to connect to a fixed list of Students by their logged on user name. When connecting to Students using User Mode, the Students will become part of the Fixed list of Users. The Fixed list of Users is a list of available Students that have been found on the network. These details are stored in the Client.NSS file.

Connecting using the Class wizard
1. In the Class wizard, click **New**.
2. Click **User Mode**.
3. The Create Class dialog will appear.

4. Specify a name and description for the class.
5. Enter the Student logon names, one per line.
6. To make this the active connection method, select **Make this the active connection method**.
7. Click **OK**.
8. The new class will appear in the Class wizard. Click **OK**.
9. The Tutor will browse for and connect to the Students and display their icons in the Tutor Console. These Students have now been added to the Fixed list of Users.

Connecting using the Tutor Configurator
1. Click **Options** in the Tutor Console and select **Network Settings** from the drop-down menu.
2. Select **Student Selection**.
3. Click **Connect to a list of Students** and then click **This is a list of student user names**.
4. Click **OK**.
5. Click **Yes** to re-initialise the Tutor configurator.
6. The Class wizard will appear. Follow the above steps in ‘Connecting using the Class wizard’.

**To modify Students in the Fixed list of Users**
1. Click the class name on the status bar and select **Modify Class**.
2. The Modify Class will appear.
3. Delete or add the required Student logon names to the list.
4. Click **OK**.

**Connect to Students using SIS mode**

NetSupport School provides direct integration with SIS (Student Information Systems) using OneRoster or Google Classroom, allowing you to instantly access your SIS classrooms and student accounts at the start of a NetSupport-managed lesson.

**Note:** The NetSupport Connectivity Server must be installed on a Windows Server to use this method.

**Configuring the NetSupport Connectivity Server**

1. Right-click the **NetSupport Connectivity Server** icon in the system tray and select **Configure Connectivity Server**.
2. Select the Classes tab. Enter your OneRoster Tenant ID and associated NetSupport School Security/API key, browse for OneRoster CSV files or if using Google Classroom, browse for the JSON file and sign into Google G Suite with administrator credentials (for information on how to set up a Google Classroom Project and create the required JSON files, see [Integrating NetSupport School with Google Classroom](#)).

**Note:** A Connectivity Server key will need to be created and also entered at both the Tutor and Student.

3. Open the NetSupport School Tutor and in the Class wizard, click **Configure**.
4. In the Tutor Network and Wireless settings, select **Use Name & Connectivity Server**, click **Settings** and enter the Connectivity Server IP address, port and key you created.
5. Click **OK**.

**Connecting to Students**

1. In the Class wizard, click **Configure**.
2. In Student Selection, select **Connect to SIS** and select the required school name from the drop-down list.

3. Click **OK**.

4. Select the required teacher from the Teacher username drop-down list.

5. A list of available classes will appear. Double click the required class. If the displayed list contains duplicate or similarly named classes that makes it difficult to identify the required item, click the **Details View** button to see additional information. The class **Location** and **Periods** columns, if defined in your data, will also be imported.

6. The Tutor will browse for and connect to all Students found and display their icons in the Tutor Console.

**Notes:**

- If you are using Active Directory, the Teacher username field in the Class wizard will be pre-populated with the logged on user's name and a list of available classes will be displayed. You can switch to a different teacher from the drop-down list or click **Configure** and choose a different school name from SIS Mode.

- If you are integrating with Google Classroom and there is a photo associated with the student account, this will be displayed instead of the standard Student icon. To turn this off, clear the **Display Student photos from Google Classroom** option in the Tutor User Interface settings.
NetSupport School 15.00

Class lists

With NetSupport School, you have the option to create Class lists, this provides you with a quick and convenient way of saving multiple Student lists for all your different classes. The Class list can then be loaded at the start of a lesson and you can quickly connect to the Student machines.

Class lists are created automatically when using PC Mode or User Mode Class connection mode, you can switch to these modes in the NetSupport School Tutor Configurator or in the Class wizard.

Note: A command line utility can be used to generate Class lists outside the Tutor program. The 'Class List Processor' enables you to produce Class lists in advance based on data that may have been supplied from an external source. The file, classlistprocessor.exe is installed in the Program Folder along with explanatory notes as to its use, classlistprocessordocumentation.txt.

To end a class
1. Click the class name on the status bar and select End Class.
2. Your current class will be ended and the Class wizard will appear, allowing you to start a new lesson.

Notes:
- If the Tutor machine does not have write access to the Class lists folder, the Tutor will not be able to create new Class lists or edit existing ones.
- You can specify the location for the Class lists to be stored by using the following registry key and then specifying a location;
  Files\Classlist
  [HKEY_LOCAL_MACHINE\SOFTWARE\Productive Computer Insight\PCCTL\ConfigList\Standard]
  "Files\Classlist"="C:\Temp"
**Connecting to NetSupport School for Mac Students**

NetSupport School for Mac is a classroom management tool providing support for Mac classrooms. The NetSupport School Tutor can also connect to NetSupport School for Mac Students if required.

Before the NetSupport School Tutor is loaded, copy the NSW.LIC into the NetSupport School program directory:

32bit C:\Program Files\ NetSupport\NetSupport School
64bit C:\Program Files(x86)\ NetSupport\NetSupport School

The NetSupport School Tutor will then allow connections to NetSupport School for Mac Students. Licence count restrictions will apply to each individual product.

**Note:** Mac Students will only have functionality that is available in NetSupport School for Mac.

To find out more information about NetSupport School for Mac, click [here](#).
The Tutor Console
The Tutor Console is the primary interface for:
• Configuring the Tutor (Control)
• Connecting to Student machines
• Maintaining Student information
• Selecting which Student machines to work with
• Selecting tasks to carry out.

NetSupport provides three modes to view the user interface: advanced, which provides full access to all NetSupport School’s features, intermediate, which provides access to the primary features and frequently used teaching tools and easy, which provides access to a focused set of classroom management features. You can switch between advanced and intermediate mode by clicking the Intermediate Mode/Advanced Mode icon on the toolbar. Easy mode can only be selected when the Tutor Console first starts up.

Note: The options described here are if you are using the Tutor Console in advanced mode. Fewer options are available when using intermediate or easy mode.

The caption bar
This indicates that you are in the Tutor Console and displays the name of the NetSupport School Tutor machine. If the Teacher Support feature is
enabled in the Tech Console, a **Support** icon appears here, allowing you to chat or message a technician.

**Note:** If you have hidden the view modes on the left-hand side of the Tutor Console, the current view mode is displayed here. Clicking the icon allows you to switch view modes.

The following options are available on the right-hand side:

- **Hamburger menu icon**
  
  Opens the Quick Access list, allowing you to add commonly used features to the caption bar. By default, **Lock All** is displayed.

- **Minimise window icon**
  
  Minimise the window.

- **Maximise window icon**
  
  Maximise the window.

- **Close window icon**
  
  Close the window.

**Options**

From this drop-down menu, you can switch the user interface to intermediate mode; turn off the colour-coded user interface; access the settings, help file, version number, licence and Technical Support information; and access any Tutor Console updates (**Options** is highlighted if there is an update available).

The ribbon provides access to all the features, tools and settings.

- **Class**
  
  From here, you can refresh and end the current class, ask Students to register their details at the start of a lesson, access individual Student features, set the level of web access and communicate with Students.

  **Note:** Additional icons may appear here depending on which view mode you are currently in.

- **Group**
  
  Provides access to the group functions within NetSupport School. From here, you can connect, organise and carry out tasks to groups of
Students.

- **Select**
  From here, you can select which Students to work with and view in the List view.

- **Feedback & Wellbeing**
  Allows you to give rewards and animated stickers to Students (these appear on the Student Toolbar), request feedback from Students to check their wellbeing, access the Test Designer and run tests at Students.

- **Journal**
  Allows you to start a Student Journal and decide what content is added for Students to review after the lesson.

- **Work Planner**
  Send files to or collect files from Students, manage the available Student resources, and create and manage lesson plans.

- **Administer**
  Provides access to the Student management functions of NetSupport School such as power on/off, reboot, log in, log out and manage user accounts, modify and apply settings to Android Students, access replay files and create user-defined tools that can automatically run a task on a Tutor Console machine.

- **View**
  Allows you to select the view mode, how Students are displayed in the List view (large icons or details view) and whether to view the group, action bar and Student Toolbar. You can also print or lock the current layout and set a background.

- **Whiteboard**
  A full-screen interactive whiteboard is provided and from here, you can access a range of screen annotation tools.

  **Note:** This option only appears when Whiteboard view is selected.

**The lesson bar**
The lesson bar allows you to create a lesson, provides tools to manage the lesson once in progress and advises you on the current activity.
**Note:** To enable/disable the lesson plan bar, select the Work Planner tab in the ribbon and click/clear the **Lesson Plan** option. It is displayed automatically when a lesson plan is running.

**The group bar**

Until you have defined groups of Students, only the 'All' group appears. Once defined, the group name and the number of members appear. With the required group selected, you can change properties such as the displayed name and icon image by clicking the **Group options** icon and selecting **Properties**.

Clicking the right-hand side of a group tab displays a drop-down menu, allowing you to access commonly used features.

To enable/disable the group bar, select the Group or View tab in the ribbon and select the **Group Bar** option.

**View modes**

The left-hand side of the Tutor Console lists the available view modes. Clicking an icon here changes the display of the List view and the icons applicable to the mode are displayed in the Class tab.

**Note:** You can hide these icons, allowing more space in the List view. Select the View tab in the ribbon and clear the **Action Bar** option. The view mode icon is displayed on the caption bar, showing which view mode you are in and clicking this icon allows you to switch views.

The following view modes are available:

- Normal View
- Monitor Mode
- Audio View
- Q&A View
- Web View
- Application View
Survey View
Print View
Device View
Typing View
Whiteboard View

**Note:** You can customise the view modes displayed by selecting the View tab in the ribbon, clicking the drop-down arrow in the Mode section and clicking **Customise**.

By default, the colour used in the Tutor user interface changes to match the current view mode. You can turn this off by clicking **Options** in the Tutor Console and selecting **Colour Coded UI** (this option is highlighted when turned on) from the drop-down menu. You can also enable/disable this in the Tutor User Interface settings.

**The List view**

The List view displays the currently connected Students or groups. You can switch the display mode between large icons and details view by clicking the **Large icons** icon or the **Details** icon on the status bar.

When you mouse over a Student icon, details of the student machine are displayed.

Student properties, such as the displayed name, can be changed by right-clicking the Student and clicking the **Properties** icon. The Student icon image can be customised; right-click the Student and click the **Customise** icon.

**Note:** Student names can also be customised using the Student Register function.
The wireless status and battery power level can be displayed next to the Student thumbnail. You can choose which indicators to display in the Tutor User Interface settings.

You can hide the action bar (where the view mode icons appear on the left-hand side of the Console) to allow more space in the List view by selecting the View tab in the ribbon and clearing the Action Bar option. If you are in a view with lower panes, these can be hidden by clicking the Minimise View icon.

The Student icon indicates the current device state:

- ![Logged in Student icon](image)
  - The device is turned on, connected to the Tutor and logged in.

- ![Logged out Student icon](image)
  - The device is turned on, connected to the Tutor and logged off.

- ![Device off icon](image)
  - The device is turned off and not connected to the Tutor.

Student icons can be rearranged in the List view to reflect the classroom layout by dragging the icon to the required position (the layout can be locked). A background image can also be added to further customise the Tutor Console.
**The status bar**

The status bar is displayed at the bottom of the Tutor Console. It shows the current class you are in (you can end and refresh the class by clicking the class name), the number of currently connected Students, currently selected Students and number of Students in the selected group.

**Note:** In Monitor, Audio and Q&A views, the thumbnail tools appear on the status bar.

You can select which Students to work with in the List view. For example, you can select all machines that are powered off, so you can power them on. The following icons are available:

- ![Logged-in Student icon](image)
  Select all Students that are logged in.

- ![Logged out Student icon](image)
  Select all Students that are logged out.

- ![Powered off machines icon - monitor](image)
  Select all devices that are powered off.

**Note:** You can also select all Students and clear the current selection from the Select tab in the ribbon.

You can choose how Students are displayed in the List view (details view or large icons) by clicking the **Details** icon or the **Large icons** icon (if the mode you are in supports that view).

**Note:** If you have minimised the lower pane(s) in the List view, you can see these again by clicking the **Maximise view** icon.
Selecting Students to work with

You can easily select which Students to work with from the Select tab in the ribbon.

Students can be randomly selected; use the slider to choose the number of Students to select randomly and click Random Student. By default, a sound is played at the Student when they are selected. Clear the Play sound at student option to disable this.

You can choose to work with logged-in, logged out or powered off Students by clicking the relevant icon in the ribbon or status bar. For example, you can select all powered off machines, allowing you to power them on.
Intermediate mode

NetSupport School provides three modes for viewing the Tutor user interface: advanced, intermediate and easy. Advanced mode provides full access to all of NetSupport School’s features and functions. Intermediate mode provides access to the primary features and frequently used teaching tools. Easy mode provides access to a focused set of classroom management features needed to maintain control over a class.

Using intermediate mode
1. Start the NetSupport School Tutor Console.
2. Click the Intermediate mode icon.
3. Click Start.
4. Enter the required details in the Class wizard, choose the class to connect to and click OK.
5. The Tutor Console will load in intermediate mode.

By default, the available view modes in intermediate mode are:

- Monitor view
- Web view
- Application view
- Survey view
- Print view
**Note:** To customise the available view modes, select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Customise**.

By default, the available features on the ribbon are:

- Student Register
- View Students
- File Transfer
- Lock/unlock Students' keyboards and mice
- Set the level of web access
- Show
- Power Students on/off
- Login Students
- Logout Students
- Student feedback and wellbeing
- Send a message
- Chat.

**To switch the user interface between modes**

1. Select **Options** in the Tutor Console and click **Reduced Interface** (it's highlighted when you are in intermediate mode).

**Note:** You can only select easy mode when the Tutor Console first starts.
**Easy mode**

NetSupport School provides three modes for viewing the Tutor user interface: advanced, intermediate and easy. Advanced mode provides full access to all of NetSupport School’s features and functions. Intermediate mode provides access to the primary features and frequently used teaching tools. Easy mode provides access to a focused set of classroom management features needed to maintain control over a class.

**Using easy mode**

1. Start the NetSupport School Tutor Console.
2. Click the **Easy Mode** icon.
3. Enter the required details in the Class wizard, choose the class to connect to and click **OK**.
4. The Tutor Console appears in easy mode.

5. From here, you can see the number of Students in your class, the time the lesson has been running (you can pause the time by clicking on it) and the available feature icons (the icon changes if the feature is active).
6. The user interface can be minimised by clicking the **Menu** icon and selecting **Minimized Interface**. When minimised, it will remain on top of any other open windows.

**Note:** Double-clicking in the window switches between minimised and maximised mode.
7. You can change the theme/colour of the user interface by clicking the **Menu** icon, selecting **Theme** and choosing the required theme from the list.

8. Click **Power On** to power on Student machines. You can request the Student names by clicking **Get Student Names**. To mute audio at all Students, click **Mute Audio**.

   **Note:** The **Power On** icon only appears if there are Student machines that need to be powered on.

9. A notification appears in the window if a Student has requested help. Clicking this opens the Help Request window, allowing you to respond to the Student.

The available features in easy mode are:

- Lock/unlock Students' keyboards and mice
- Blank Student screens
- Power Students on
- Block all internet access
- Request Student feedback and wellbeing
- Mute audio at Students
- Lesson timer
- See Student help requests
- Get Student names.
Tutor Toolbar
The Tutor Toolbar provides details of the current lesson to the Tutor and access to key NetSupport School functions when the Tutor program is minimised. The Tutor can mute sound at all of the Students, add notes to the Student Journal, Scan, Chat, Message, Announce, Show, Lock/Unlock Students, Blank Student screens and block all internet access by clicking the relevant icon. When the Tutor program is maximised, the Tutor Toolbar will disappear and any settings applied will show in the Tutor Console.

Note: The Tutor Console can be maximised by clicking Restore.

To disable the Tutor Toolbar, click Options in the Tutor Console, select Settings from the drop-down menu, choose User Interface - Tutor and clear Show Tutor Toolbar on minimizing option.

Note: There is also a Student Toolbar that can be activated at the Student, providing feedback on the current lesson.
**Student automatic login**

If a generic naming convention is used for your classroom PCs, you can automatically log the Students in to save time at the start of a lesson.

**To automatically login Student machines**

1. Select the Student machine(s) you wish to login.
   Or
   To select all Student machines that are not logged in, click the **Select Logged out Students** icon on the status bar.
2. Select the Administer tab in the ribbon and click **Login**.
3. The Auto Login dialog appears.

![Auto Login dialog](image)

4. Enter the user name, password and domain and click **Login**. The user name will appear once the login has been successful.
5. You can also view Student screens from this dialog, select the required Student and click **View**.
6. Click **Close** when complete.
Student Register

By default, NetSupport School will display the machine name of the Student machine in the Tutor Console. However, there may be times when you want the control to display the actual name of the Student and request additional information.

The Student Register option enables the Tutor to prompt the Students for their details.

**Note:** You can also change the name of the Student machine by editing the Client Properties Details tab.

**To prompt Students to log in:**

1. If specific Student details are required select the relevant Student icons in the Tutor Console. Alternatively, to prompt all connected Students, leave the icons unselected.
2. Select the Class tab in the ribbon and click **Student Register**.
3. The Student Register dialog will appear. The Tutor can then select the information that the Student will be required to complete.
4. Click **Register** to send the form to Student machines. You can monitor progress as the Students respond.
5. Click **Close** when all Students have signed in.
6. If you enabled the **Auto Save Register** option, you are prompted for a file name, extension type and location for the registration report. Click **Save**.
7. The Student icons in the Tutor Console now display the registered name.

**Note:** The Student Register will also appear if you check **Create a Student Register** in the Class wizard.
Student Register dialog
This dialog enables the Tutor to create a customised registration form, which will prompt Students for their details. By selecting a name, the Tutor can also interact with Students using the View and Chat options.

Class Details
If required, the teacher name, lesson title, room and lesson objectives can be included on the registration form that is sent to Students. These details will be completed if you have already input them in the Class wizard.

Note: By default, the start-up mode is Connect to Student in Room(s). In this mode, the Room field displays the room specified at start-up, and cannot be changed.

Required Student Details
Decide which details to prompt the Students for. You can also add two custom fields to the form.
**Note:** If the *Get Logged on User Name* option is selected, the first name and surname will be greyed out and the Student name will automatically default to the login name.

**Auto Save Register**
Student registration details can be viewed in a report, but this will be lost when the Tutor disconnects. If you want to store a copy of the report, check this option. You will be prompted for a file name, location and file format (CSV, HTML or XML).

Click **Register** to send the form to Student machines. You can monitor progress as the Students respond. Click **Close** when all Students have signed in, the Student icon in the Tutor Console will now display the registered name.

**Sign out**
At the end of a lesson, you can reset the Student names using the sign out option.

1. Select the Class tab in the ribbon, click the **Student Register** icon and choose **Sign Out**.
2. Confirm that you want to unregister the Students.

**Note:** If you don’t want to see this message in the future, click **Don’t Show this again**. It can be turned back on in the Tutor User Interface settings.
Registration report
Student registration and printer usage details can be viewed in a report, but this will be lost when the Tutor disconnects.

Note: If you want to automatically store a copy of the report, ensure the Auto Save Register option is enabled in the Register Student dialog when requesting the Student details. The report can be stored in CSV, HTML or XML format.

1. Select the Class tab in the ribbon, click the Student Register icon and choose Registration Report.

![Image of Student Registration Details]

Notes:
- To print a copy of the report, select the Class tab in the ribbon, click the Student Register icon and choose Quick Print.
- The student register can be added to the Tutor Journal. Select the Class tab in the ribbon, click the Student Register icon and choose Student Register.

To display the login name of Students
When registering Student details, rather than prompt them for their actual name you can default to their login name.

1. Click Options in the Tutor Console and select Settings from the drop-down menu.
2. Select User Interface - Tutor.
3. Check **Display Student User Names**.
4. Click **OK**.

**To save the Students login name**
Enable this option to permanently store the Students login name.

1. Click **Options** in the Tutor Console and select **Settings** from the drop-down menu.
2. Select **User Interface - Tutor**.
3. Check **Remember Student User/Login names**.
4. Click **OK**.
Working with classroom layouts

Once you have selected a classroom or group, you can rearrange the individual Student icons in the List view to reflect the layout of the classroom. A background image can also be added to further customise the Control view.

When using Room mode, the classroom layout will be automatically saved against the room selected. When you start the Tutor and select your Room, the layout will automatically load.

**Note:** For information on how to save and load layouts when not in Room mode, refer to the following article: [Changes to the layout functionality when using Room mode](#).

---

To arrange icons

1. Select the Student icon and drag it to the desired position.

To lock a layout

1. Arrange the Student icons to the required positions.
2. Select the View tab in the ribbon and click **Lock Layout**.
3. Student icons will be fixed in position and unable to be moved.

**Note:** The current classroom layout can be printed. Click **Print Layout** from the View tab in the ribbon.
Setting a background

As well as tailoring the position of Student icons in the List view to reflect the layout of the classroom, you can choose alternative images to decorate the background and enhance the layout of the icons.

**Note:** Background layouts support .bmp, .jpg, .gif, .png and transparent images.

To set a background

1. Select the View tab in the ribbon and click **Set Background**.
2. The Set Background dialog appears.

![Set Background dialog](image)

3. Select the location of the image you wish to use. The default image files are stored in the NetSupport School program folder. A preview of the selected image is provided.
4. Select the **Image position on display** drop-down to select the position of the image. If you select **Tile**, you can also choose to align the Student icons on the image.
5. If required, select a background colour.
6. Click **OK** to add the background to the List view.

If you wish to clear the currently set background, select **Clear Background** from the View tab in the ribbon.
Power management – power on/power off

Power consumption equates largely with heat generation and increased energy consumption. With millions of machines in use, and sometimes hundreds located within the same company or School, the desire to conserve energy has grown from a minor-issue to a major issue over the last ten years.

Power management is a technique that enables hardware and software to reduce system power consumption. It works by shutting down portions of the hardware during periods of downtime, meaning that the machine is ready to work when you are and conserve energy when you are not.

Student power on

To power on a NetSupport School Student, the machine must have a Wake-on-LAN network adapter and a BIOS that will support it (consult your network adapter documentation for more information), the Student must also be ‘known’ to the Tutor. The Tutor sends a Wake-on-LAN packet to the Student network adapter, which instructs the machine to power on.

To power on a NetSupport School Student

1. Select the icon(s) of the Students you wish to power on.
   Or
   To select all Student machines that are powered off, click the Select powered off machines icon on the status bar.
2. Select the Administer tab in the ribbon and click Power On.
3. The Student machines will now power on.
Student power off

NetSupport School uses the Advanced Power Management (APM) features of the Windows Operating System (where supported), to provide Student power down capabilities. APM relies on the Student machine having an ATX motherboard and ATX power supply.

A Tutor can remotely power off a Student machine using the NetSupport School Power Management function.

To power off a NetSupport School Student
1. Ensure all open applications at the Student machines are closed.
2. Select the icon(s) of the Students you wish to power off.
3. Select the Administer tab in the ribbon and click Power Off.
   Or
   Right-click a Student and click the Power Off icon.
   Or
   To power off all Student machines that are not logged in, select the Administer tab in the ribbon, click the Power Off drop-down arrow and select Power off logged out machines.
4. Click Yes to confirm that you want to power off the selected Student machines.

   Note: If you don't want to see this message in the future, click Don't show this again. It can be turned back on in the Tutor User Interface settings.
5. The Student machines will now power off.
**Student disconnects from an active session**

During an active session, you may find that Students inadvertently disconnect, for example, when they reboot their machine. Each time a Student disconnects a message will appear advising which Student has disconnected, you can dismiss this prompt or leave to timeout as it will allow you to carry on working. This message can be disabled if required.

**To disable the disconnect prompt**

1. Click **Options** in the Tutor Console and select **Settings** from the drop-down menu.
2. Select **User Interface - Tutor**.
3. Select the **Silent Disconnect** option and Click **OK**. The next time a Student disconnects no message will be displayed.

**Note:** To automatically reconnect to Students when they become available, ensure that the **Automatically Reconnect to Students** option is selected in the Tutor User Interface Settings.
Removing a Student from a class
You can delete old Student icons from a class.

1. Right-click the required Student icon and click the Remove icon.
2. A prompt will appear asking for confirmation. Click Yes.

Note: If you don't want to see this message in the future, click Don't show this again. It can be turned back on in the Tutor User Interface settings.
Configuring NetSupport School for subnet browsing

If your network is running across multiple TCP/IP subnets, you need to configure NetSupport School to use the additional subnets when browsing for Students.

Before configuring NetSupport School to browse on a remote IP subnet, it is useful to understand how IP addresses are made up and, in particular, what an IP broadcast address is. See Understanding IP Addresses.

To configure the NetSupport School Tutor to browse IP subnets
1. Click Options in the Tutor Console and select Network Settings from the drop-down menu.
3. Click Settings in the Browsing section.
4. The Configure TCP/IP Client Browsing dialog will appear.
5. Click Add and enter the broadcast address of the network you wish to browse if known.

Or
To enable NetSupport School to calculate the broadcast address, click Advanced and enter a target IP address followed by the subnet mask or enter the required address range.

6. Click OK.
Notes:
- When adding the address of a remote subnet, you must ensure that the broadcast address for the local subnet is also present. If not, the Tutor will not find any local Students when you perform a browse.
- Some network routers will suppress broadcast packets from being transmitted across WAN links. If this is the case, then even if the Tutor is correctly configured, you will not be able to browse the remote subnet.
Understanding IP addresses

An IP address is made up of 4 bytes, each byte being made up of eight bits, which can have a value of 1 or 0. This gives possible IP addresses of 0.0.0.0 to 255.255.255.255.

Each IP address is also split into two portions, a network portion, which identifies the network the device is on, and the local or host portion, which identifies a particular device.

The subnet mask defines the position of this split between the network and host portions of the address, which is associated with the address. The subnet mask is also a four-byte number. Each bit in the subnet mask that is set to 1 denotes that the corresponding bit in the IP address is part of the network portion.

For example, if we have an IP address of 10.10.2.21 and a subnet mask of 255.255.255.0

| IP Address | 10 . 10 . 2 . 21 |
| Subnet Mask | 255 . 255 . 255 . 0 |
| IP Address in Binary | 00001010.00001010.00000010.00010101 |
| Subnet Mask in Binary | 11111111.11111111.11111111.00000000 |
| Network Portion of IP Address | 00001010.00001010.00000010.00000000 |
| Host Portion of IP Address | 00000000.00000000.00000000.00010101 |
| Network Portion of IP Address | 10 . 10 . 2 . 0 |
| Host Portion of IP Address | 0 . 0 . 0 . 21 |

Therefore, when we send an IP packet to 10.10.2.21, we are actually sending a packet to device 21 on network 10.10.2.0

In the example above, the network 10.10.2.0 can have 256 host addresses, 0 to 255. However, two of the host addresses, the first and last, on each IP network are reserved. The reserved host address with all bits set to 0 is the network address, and the one with bits set to 1 is the broadcast address.

In our example network of 10.10.2.0;
10.10.2.0 is the network address
10.10.2.255 is the broadcast address.
When an IP packet is sent to a networks broadcast address each device on the IP network will receive this packet.

It is this IP network broadcast address, which is used when configuring NetSupport School Control to browse on an IP subnet other than its own.
Implementing NetSupport School in a Terminal Server environment

A NetSupport School Tutor can connect to Students within a Terminal Server environment.

For ease of implementation, NetSupport School provides a downloadable setup package which will guide you through the required installation and configuration processes. For full instructions, please visit our Knowledge Base and refer to product article Setting up NetSupport School to run in a Microsoft Terminal Server environment.

**Note:** Terminal Server and other thin clients, may not be configured to use the NetSupport School Name and Connectivity Server.

Connecting to a NetSupport School Student running in a Terminal Server session

The preferred method to connect to the Students running in the Terminal Server Sessions is using the Connect via Room Mode option. Using this method, it's possible to configure the Students running in the Terminal Server sessions to be located in a particular room depending on the user logged onto the session.

Once the Tutor is configured to the same room as the Students, it will automatically connect to all Students located in the room.

**Note:** The Student Terminal Server settings can be configured in the NetSupport School Student Configurator.
Installing and configuring the NetSupport School Tutor Assistant

For use in your existing NetSupport School-managed classroom environment, the NetSupport School Tutor Assistant delivers greater mobility for teachers around the classroom and is also the ideal tool to allow teaching assistants to help with monitoring student progress.

The NetSupport School Tutor Assistant works on iOS devices running version v9.0 and higher, Android devices running v5.0 and higher and Kindle Fire devices and is available for free from Apple iTunes, Google Play and the Amazon App store.

Stage 1 - Configuring the NetSupport School Tutor to connect to the NetSupport School Tutor Assistant

When you first run the Tutor Console, a Tutor Assistant icon appears in the Class tab in the ribbon (if this has been hidden, you can access it in the Administer tab). From here, you can set a passcode to authenticate connections from the Tutor Assistant. To access the full Tutor Assistant configuration settings:

1. Click Options in the Tutor Console, select Settings from the drop-down menu and choose Tutor Assistant.
2. The Tutor Assistant configuration settings dialog will appear.
3. Enter a name for the NetSupport School Tutor that will appear at the Tutor Assistant.
4. Enter the connection port and if required, enter a connection password that the Tutor Assistant will need to enter to connect to the Tutor.
5. Decide whether to allow Tutor Assistants to be automatically authorised or manually authorised.
6. Click Start to start the Assistant Server – The current IP address will be displayed.
7. Click OK.

Stage 2 - Installing the NetSupport School Tutor Assistant

1. Download the NetSupport School Tutor Assistant from the appropriate App store.
2. Open the Tutor Assistant app.
3. Enter the IP address of the NetSupport School Tutor Console and the connection password (if set).
4. The default port is 37777. This can be changed but would also need to be amended at the NetSupport School Tutor.
5. Select **Connect** and the Tutor Assistant will connect to the selected Tutor Console.

**Note:** Depending on the settings in the Tutor Console, the Tutor Assistant may need to be authorised before it can connect to the Tutor Console.

Once the Tutor Assistant service is started and connections are allowed, the **Tutor Assistant** icon in the Administer tab in the ribbon changes to 📋. An indicator appears on the icon showing the number of Tutor Assistants connected. Click the **Tutor Assistant** icon to start/stop the Tutor Assistant service, authorise devices if using manual authorisation (a warning indicator appears advising you that devices are waiting for approval), disconnect devices and access the configuration.

**Features supported on tablets:**
- Support for Android and iPad tablets.
- View student thumbnails.
- Send students a preset message.
- Block restricted websites.
- Set approved websites.
- Block all internet access.
- Lock/unlock student computers.
- Logoff student computers.
- Blank/unblank student screens.
- Restrict student printing.
- Set approved applications.
- Block restricted applications.
- Select a group of students.
- Details view – showing key student information in sortable columns.
- View student help request notifications.
- Zoom on student.
- Sort students by name/tutor order.
- View current application.
- View current websites.
- Set connection password.
- Tutor badge, displaying the number of currently connected Tutor Assistants.

**Features supported on smartphones:**
- Support for Android and Apple iOS smartphones.
- Send students a preset message.
- Block restricted websites.
- Set approved websites.
- Block all internet access.
- Lock/unlock student computers.
- Logoff student computers.
- Blank/unblank student screens.
- Restrict student printing.
- Set approved applications.
- Block restricted applications.
- Set connection password.
NetSupport School Windows 10 Teacher App

Provided in addition to the desktop Teacher application for Windows, the native Teacher App is designed for installation on Windows tablets and touch-enabled devices. It is a complementary component and is available for download from the Windows Store.

Note: For further information on installing and using the Teacher App, please refer to our Windows 10 Teacher App manual.

Simplicity and ease of use are at the heart of the Teacher App and many of our core classroom features are provided within the new streamlined interface:

- Transfer documents and resources directly from local or cloud-based OneDrive files, to all or selected students.
- Copy key lesson content into and work with OneNote Class Notebooks using NetSupport’s digital Student Journal feature.
- Direct integration with Microsoft School Data Sync, enabling teachers to instantly access their online Student Information Systems (SIS) classrooms and student accounts at the start of a NetSupport-managed lesson.
- Launch NetSupport School features using Cortana voice commands. “NetSupport blank screens!”
- Support for Microsoft Surface Dial - display a radial menu of NetSupport School features for quick and easy execution of common tasks.
- Multi-platform support – connect in any combination to Students using Windows, Chrome OS, Android, Apple Mac or iOS devices.
- Power on or off, log in/log out or reboot classroom computers.
- Present lesson objectives and expected outcomes.
- Gather and print a student attendance register.
- Monitor student help requests.
- Lock or blank students’ screens to gain attention.
- Monitor student screen thumbnails.
- View individual students.
- Chat and send messages to the class.
- Monitor and restrict internet use.
- Monitor and control application use (desktop and store).
- Launch applications and websites on student screens.
- Conduct quick end of lesson surveys.
- Measure progress – including peer and individual assessment, scores and more.
• Prevent data being copied to or from USB storage and CDR/DVD devices, plus mute/unmute sound at student machines.
• Virtual whiteboard supported by a wealth of drawing tools for improved classroom collaboration.
• Toggle the NetSupport School Student Toolbar on or off on the fly.
Installing and configuring NetSupport School on Google Chrome

NetSupport School delivers the tools you need to help maximise the effectiveness of computer-led teaching in a Google Chrome environment.

The NetSupport School Student for Google Chrome extension can be installed on each student machine running the Google Chrome OS. From the teacher's machine (Windows or Chrome OS), you can then connect to each Chromebook system, enabling you to monitor the screens and interact with each student quickly and efficiently.

Planning an installation
For a teacher to be able to monitor and interact with their students using Google Chromebooks, the NetSupport School NetSupport Connectivity Server must be installed on a Windows Server; the NetSupport School Tutor must be installed on either a Windows computer or on a Google Chrome device, and the NetSupport School Student for Google Chrome extension must be installed onto each of the students’ Chromebooks.

Note: The NetSupport School Tutor app for Chrome can only connect to Google Chrome Students.

Installing the NetSupport School Tutor app for Chrome
1. Download the NetSupport School Tutor app for Chrome from the Google Chrome store.
2. Locate the NetSupport Tutor app for Chrome and launch this.
3. The NetSupport School Chrome Tutor will start and the Enter Licence dialog will appear.
4. Enter the licence details you have been provided with and click Licence or, click Evaluate to use the software for up to five student Chromebooks for 30 days.
5. The Connect dialog will appear.
6. Enter the Gateway address, port number and security key. This must be the same as set in the Name & Connectivity Server.
7. Choose whether to connect to your Google Chrome Students using Room name, User mode, Browse mode or SIS mode.
8. Click Connect.

Note: You can use the Google Admin Console to centrally configure and deploy the NetSupport School Tutor app to the required teacher Chrome accounts. Click here for full instructions.
Configure NetSupport School to connect to Google Chrome Students

1. Click **Options** in the Tutor Console and select **Network Settings** from the drop-down menu.
2. Select **Network and Wireless Settings**.
3. Under TCP/IP settings, select **Include Chromebooks** and click **Settings**.
4. Enter the Gateway address, port number and security key. This must be the same as set in the Name Server. Ensure that **Connect by Hostname** is not selected.
5. Click **OK**.
6. You can now browse for Google Chrome Students in Room mode, User mode, using the Fixed list or SIS mode.

Installing and configuring the NetSupport School Student for Google Chrome extension

If your organisation uses Google Apps for Domains, you can centrally manage the NetSupport School settings within the Google Admin Console, [click here](#) for full instructions.

1. Download the NetSupport School Chrome extension from the Google Chrome store: [https://chrome.google.com/webstore](https://chrome.google.com/webstore)
2. Enter the URL chrome://settings/extensions to access the ‘Extensions’ configuration page.
3. Locate the NetSupport School Student for Google Chrome extension and click **Options**.
4. Enter the Gateway address and port number of the Name & Connectivity Server.
5. If connecting to Students using Room mode, decide what room the Student is going to be assigned to.
6. Optionally, enter a name that identifies this Student.
7. Once you have entered the required student configuration options, it is recommended that you protect the settings by entering a password.
8. Click **Save** to store the configuration.
9. Rather than having to manually configure each Chromebook, multiple installations using the stored options can be centrally managed in the Google Admin Console. Click **Export As File** to create a configuration file containing the settings. Before the file is generated, you have the option to allow changes to the Client name and MAC address fields on the Options page. By default, the generated file will disable these two settings.
10. Click **Generate File**. By default, the file will be named Config.json. This file can then be uploaded in the Google Admin Console in order
to centrally apply the NetSupport School Student configuration to the required devices. If you require any assistance with this, our support team will be happy to help.

A connection status indicator is displayed at the Student, showing the current connection state between the Student device and Tutor machine. The indicator colours are:

Red = no connection.
Yellow = attempting a connection.
Orange = connected to the NetSupport Name & Connectivity Server.
Green = connected to NetSupport Tutor/current class.

**Note:** To ensure you retain full visibility of your students' internet use, it is recommended that you 'disallow' Incognito Mode in the Chrome OS User Settings via Google Apps for Education.

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down set of features.

**Feature highlights**

**Note:** The feature set available in the NetSupport School Tutor app for Chrome OS is a subset of the Windows version:

- View a real-time thumbnail of each student Chromebook in a single view.
- Zoom in to view a larger thumbnail of any selected student Chromebook.
- Open a separate view session to discreetly monitor a selected student’s screen and take a closer look at activity – perfect for ensuring students are on task with their learning activities. (The open browser activity can be viewed in Thumbnail and View modes along with the option to view the full desktop if required.)*
- The teacher can set objectives and expected outcomes for the current lesson.
- Ask students to register at the start of each lesson.
- Show the teacher’s screen. Ensure student attention and focus when presenting by ‘showing’ the teacher’s desktop to selected student Chromebooks.*
- Multi-monitor support. If the teacher is using multiple monitors, select an individual screen to show to students or show all.*
- Show an application to selected students.*
• Lock the student’s mouse and keyboard when instructing.
• Send an instant survey or request for feedback to each student and display results in real-time.
• Open a discussion session with selected or all students, enter their comments and share with the rest of the class.
• Send an attention-grabbing message or instruction to each student Chromebook.
• Request help facility - students can send a request for help to the teacher.
• Block unauthorised websites.
• Use approved websites only.
• Block all internet access.
• Launch a website on the Student Chromebook.
• Copy the content of the clipboard between teacher and student machines during a view session.
• See details of the website that students are currently viewing.

* Features are not available when using the NetSupport School Tutor app for Chrome.

**Note:** To view the full desktop of a Student (Windows Tutor only), the Student needs to acknowledge an on-screen prompt. If you prefer not to offer this option and only want to view the Student's open browser window, the prompt can be disabled. For further information, refer to technical document: [Behaviour when viewing Student Chromebooks from a NetSupport School Windows Tutor](#).

**Licensing for Google Chrome**

Each Google Chrome device that connects to the Name and Connectivity Server needs to be licensed. Google Chrome Licences can be purchased independently of the main NetSupport School product and are registered with the Name and Connectivity Server by loading a new Licence file (NSW.LIC). This file controls the number of Google Chrome Students that can connect. If this file is not present, then the usual Name and Connectivity Licence file (NSM.LIC) will allow Google Chrome to connect, but this will reduce the Licence count available for NetSupport School Students.

e.g.
With both an NSM.LIC (10 user) and NSW.LIC (10 user) the software will independently limit to 10 connections of each type. With 10 NetSupport School Students connected, the 11th Google Chrome Student would be rejected.
With just a NSM.LIC (20 user) the software would limit to a maximum of 20 connections of regardless of whether they are from Google Chrome or standard NetSupport School Students.
Installing the NetSupport School Tutor for Android

For installation on a teacher’s Android tablet, the NetSupport School Tutor for Android extends the product’s capabilities into dedicated tablet-based classrooms, giving the teacher the power to connect to each student device and enabling real-time interaction and support.

Note: Student tablets must be running the NetSupport School Student app.

Installing the NetSupport School Tutor for Android

If you wish to manage the class as the teacher, you will need to install the NetSupport School Tutor (Control) on your device.

The NetSupport School Tutor for Android app works on Android v5.0 or later tablets and is available from the Google Play store.

For further information on installing and using the Tutor for Android, please refer to our Android Tutor manual.

Features

• View Student thumbnails
• Watch Student screen
• Real-time student assessment (Question and Answer mode)
• Class surveys
• Student register
• Lesson objectives
• Chat
• Sending messages
• Student request help
• Launch websites
• Student rewards
• File Transfer
• Lock/unlock student computers
• Blank Student screens
• WiFi/battery indicators
• Launch at Start-up. The NetSupport School Student for Android will launch when the device is powered on and will automatically sign in (where the device is located in a fixed room).
Installing and configuring the NetSupport School Student for Android

NetSupport School delivers the tools you need to help maximise the effectiveness of computer-led teaching on Android devices.

The NetSupport School Student for Android can be installed on each Android tablet. From the teacher’s desktop, you can then connect to each system, enabling you to interact with each student quickly and efficiently.

The NetSupport School Student for Android app works on Android v5.0 or later tablets and is available for free from the Google Play store.

**Note:** A NetSupport School Tutor for Android app is available to use on your Android devices.

Set up and configure the NetSupport School Student for Android

You can pre-configure each device with the required password-protected classroom connectivity settings from the device or 'push' the settings to each device from within the NetSupport School Tutor program:

1. Select the Administer tab in the ribbon and click **Apply Student Settings**.
2. The Student Settings dialog will appear.
3. Select the students you wish to send the settings to.
4. To amend the configuration settings, click **Modify**.
5. The Modify Student Settings dialog will appear.
6. Set the required options and click **Save**.
7. If a password has already been set at the Android device, enter this.
8. Click **Send**.
9. You can now browse for Android Students in Room mode.

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down set of features.

**Note:** In certain environments, the NetSupport School Tutor Console may not locate the Android Students during its browse. For further information on how to locate and connect to Android devices, please visit our Knowledge Base and refer to product article: [What to do if the Android Students are not found by a Tutor Console browse at startup](http://www.net-support.com).
Features supported on Android:
• Student register.
• Lesson objective.
• Receive messages from the Tutor.
• Student request help.
• Group or 1:1 chat.
• Student Survey.
• Lock/unlock student computers.
• Real time instruction (Show mode).
• View Student thumbnails.
• Watch Student screen.
• Student rewards.
• WiFi/battery indicators.
• Launch URL at the Student.
• Blank Student screen.
• Question and Answer mode.
• File Transfer.
• File Distribution.
• Launch at start-up. The NetSupport School Student for Android will launch when the device is powered on and will automatically sign in (where the device is located in a fixed room).

Note: When you view a Student's screen, a prompt appears asking the Student to confirm before you can connect. If they don't allow this, you are unable to view their screen.
Installing and configuring the NetSupport Browser App (iOS)

NetSupport School delivers the tools you need to help maximise the effectiveness of computer-led teaching on iOS devices.

The app also supports NetSupport DNA's core desktop management capabilities, enabling you to gather key system inventory details and monitor online activity. For more information on NetSupport DNA, visit our [website](#).

The NetSupport Browser App can be installed on each iOS device. From the teacher’s desktop, you can then connect to each system, enabling you to interact with each student quickly and efficiently.

The NetSupport Browser App works on iOS v9.3.5 or later and is available for free from the [iTunes store](#).

**Note:** NetSupport School functionality is supported on tablets only.

Set up and configure the NetSupport Browser App

You can centrally configure and push out the settings using an MDM solution. For further information, please refer to technical document: [Centrally configuring and deploying the NetSupport Browser app for iOS](#).

If you selected the 'Non-Windows' licence type during installation, the Tutor Console has a cut-down set of features.

Features supported on iOS:

- **Student register** - The teacher can request standard and custom information from each student at the start of a lesson.
- **Lesson objectives** - If provided by the teacher, once connected, students are presented with details of the current lesson along with the objectives and expected learning outcomes.
- **Sending messages** - The teacher can broadcast messages to selected devices.
- **Chat** - The student and teacher can initiate a 1:1 chat session and participate in group discussions.
- **Request help** - Students can alert the teacher when they require assistance.
- **Lock screen** - The teacher can lock the app to gain attention.
- **Restrict Internet** - The teacher can employ a list of approved/restricted websites for use during the lesson.
**Question and Answer module** - Enables the teacher to conduct instant student and peer assessment. Deliver questions verbally to the class, then select students to answer – randomly, first to answer or in teams. Bounce questions to multiple students and ask the class to peer assess a response.

**Class survey** - Teachers can conduct on-the-fly surveys to gauge student knowledge and understanding.

**Show screen** - While presenting, the teacher can show their desktop to connected devices.

**Licensing for tablets**

Each Android or iOS tablet that connects to the NetSupport School Tutor needs to be licensed. Licences for tablets can be purchased independently of the main NetSupport School product and are registered with NetSupport School by loading a new Licence file (NSW.LIC). This file controls the number of tablet Students that can connect. If this file is not present, then the usual licence file (NSM.LIC) will allow tablet Students to connect, but this will reduce the Licence count available for NetSupport School Students.

**e.g.**  
With both an NSM.LIC (10 user) and NSW.LIC (10 user) the software will independently limit to 10 connections of each type. With 10 NetSupport School Students connected, the 11th tablet Student would be rejected.

With just a NSM.LIC (20 user) the software would limit to a maximum of 20 connections, regardless of whether they are from a tablet Student or a standard NetSupport School Student.
Integration with Active Directory

NetSupport School integrates with Microsoft’s Active Directory structure enabling you to centrally manage Student configurations and Tutor configurations.

To make the task a little easier NetSupport supplies four ready-made Administrative Templates, NSS_Student_machine.adm, NSS_Student_User.adm, NSS_Tutor_Machine.adm and NSS_Tutor_User.adm containing the configurable options. When you install NetSupport the template is copied to the NetSupport program folder. In turn, you will need to copy this to the folder containing any existing ADM templates.

**To apply Student configuration changes via Active Directory**

1. At the Domain Controller, select the Active Directory Users and Computers tool.
2. Decide at which level to apply the policies, domain or organisational. Right click and select the Group Policy tab.
3. Select the desired policy to add the NetSupport template to and click **Edit**.
   Or
   Select **Add** to create a new Policy.
4. In the Group Policy Editor under Computer Configuration, select **Administrative Templates**.
5. Right click and select **Add/Remove Templates**.
6. Click **Add** and specify the location of NetSupport’s ADM file and click **Open**. The new NetSupport policy will be added.
7. Click **Close**.

By default, each NetSupport policy option is disabled.

To enable certain configurations at the Student or Tutor using the NetSupport ADM Template files, you are required to enter an encrypted value, for example, the security key policy requires an encrypted security key to be entered. When configuring this through the ADM Template files, you cannot enter the security key in plain text as this would not be recognised by the Student, so you have to enter the encrypted security key value into the policy.

**Note:** Please refer to the NetSupport website support area, [www.netsupportsoftware.com/support](http://www.netsupportsoftware.com/support) for the latest information on installing via Active Directory, Active Directory policy files, instructions on upgrading from previous versions and applying NetSupport Student profiles within Active Directory.
Using NetSupport School in a wireless classroom

It is recognised that wireless networks generally do not perform as reliably as wired networks as they use radio frequencies to transmit data and these are susceptible to interference. In addition, simultaneously connecting a large number of devices to a wireless access point will have a negative impact on the bandwidth allocated to each.

When using NetSupport School in an un-optimised wireless environment, the above can result in poor performance and student devices frequently disconnecting from the Tutor Console.

NetSupport School uses advanced techniques to limit the effects of an unreliable wireless network. For further information about planning an installation of NetSupport School within a wireless environment, please click here.

Optimising NetSupport School for use in a wireless environment

Once you have established a reliable wireless connection between the devices in your classroom, there are some settings within the Tutor Console that you can change to optimise performance on your wireless network.

A school will have a finite amount of network bandwidth available; viewing the students’ screens, distributing files or broadcasting the teacher’s screen simultaneously will consume this bandwidth.

NetSupport School provides multiple configuration options designed to reduce the amount of data sent across the network, which will result in improved performance. These options can be found under their respective configuration sections in the Tutor Console.

**Note:** For general advice on reconfiguring your access point. Please visit our Knowledge Base and refer to product article Optimising NetSupport School on wireless networks.

For a wireless environment, it is recommended that the options within the Performance section of the Tutor settings are set as follows:

**Colour reduction** – Allows you to set the maximum colour depth when viewing and showing to Students. By default, this is set to 256 (high) colours.
**Low bandwidth mode** - The number of video frames transferred will be reduced to around 5 per second. Setting this to Wireless will automatically turn on low bandwidth mode when wireless students have been detected.

Additionally, within the Network and Wireless Settings section of the Tutor Console, it is recommended that the following option is enabled when using NetSupport School on a wireless network:

**Enable Broadcast Show and File Distribution** – When broadcasting the teacher’s screen or distributing files to multiple students, enabling this option will result in the screen data or files being sent to all machines simultaneously.

Finally, performance can further be enhanced by reducing the speed that the Tutor Console sends data onto the network to match the speed that the wireless access point can deliver the data. Sending data onto the network too quickly may result in packets being lost, which will result in the students requesting the data again and additional traffic being produced on the network.

For a wireless environment, it is recommended that the following options are set:

**Wireless Network** – Select this option to optimise NetSupport School for best performance in a wireless environment.

**Maximum Throughput** – This option provides the ability to fine tune the speed that the Tutor Console sends data to the connected student devices.
Using a NetSupport Connectivity Server/Gateway to find Student PCs

The 'NetSupport Connectivity Server' or 'Name & Connectivity Server/Gateway', is provided as an optional installation component. Its purpose is to provide a simple and reliable method of locating and connecting to Student PCs in LAN/Wireless network environments. This can be particularly useful where students transport laptops from class to class, making it difficult for traditional connectivity options to find them.

Once configured, Student PCs connect to the Connectivity Server on start-up and register their availability and current IP address with the Server. At the Tutor end, when browsing to locate Students, a search of the Connectivity Server is performed rather than a UDP browse across the network. The Tutor program uses the IP address registered with the Connectivity Server.

The Connectivity Server can be used with all start-up modes.

The advantages of using a Connectivity Server over traditional browse options are:

- Negates the need to browse the network to locate Student PCs.
- Reduces the time taken to locate Students.
- Reduces the need to configure and maintain broadcast range entries in the Tutor configuration.
- More reliable connection method in wireless LAN environments. The Tutor uses the current IP address when establishing connections. Avoids problems in wireless environments where Student laptops change access points and are assigned new IP addresses.
- Connect to your SIS environment using OneRoster or Google Classroom.

The basic requirements for using a Connectivity Server are:

- It needs to be installed on a PC that is accessible to all Tutor and Student PCs.
- It needs to have a static IP address.
- The Tutor and Student PCs need to be configured to use the Connectivity Server.

The Connectivity Server, Tutor PC and Student PC must have a matching Connectivity Server Security key configured.
Installing and configuring a NetSupport Connectivity Server

A 'NetSupport Connectivity Server' or 'Gateway' is designed to run on a machine that is accessible from both the Tutor and Student PCs. It must, therefore, have a fixed or static IP address. The Connectivity Server can be installed as a standalone component on the machine you wish to use, or along with other NetSupport School components.

When performing a NetSupport School installation, select the Name and Connectivity Server component from the Custom Setup screen. You will also need to configure the Server (Gateway) properties. At the end of the installation, the Connectivity Server Configuration dialog will appear or after installation, you can launch the dialog by right clicking on the Connectivity Server icon in the system tray, or from the NetSupport Connectivity Server Console File menu.

**Note:** To display the Connectivity Server icon in the system tray, choose {Start}\{Programs}\{Startup}\{Connectivity Server}. On Windows 8 machines, right-click in the Start screen and choose **All Apps** at the bottom of the screen. Click the NetSupport School Name Server Console icon.

The Connectivity Server is configured with the IP address of the Connectivity Server machine and a security key. This same information must also be entered at both the Tutor and Student machine, thus validating connections between the various components.

Once the Tutor and Student connectivity options are set to use the designated Connectivity Server, each time the Student machine starts up, its current IP address will be registered with the Server. In turn, the Tutor will check the currently defined method for browsing for Students at start up but rather than performing a UDP browse of the network it will poll the Connectivity Server to find Students matching the criteria.

**Note:** If connecting to Students via the Name & Connectivity Server in Room mode, it is necessary to set the Name & Connectivity Server settings at the Tutor in both the Tutor Configurator and the Client Configurator.
NetSupport Connectivity Server Configuration utility – General tab

You use this dialog to configure the properties of the NetSupport Connectivity Server (Gateway).

You can access the dialog at the end of the installation, when the dialog will appear automatically, or via the NetSupport Connectivity Server icon which appears in the machines system tray. Right-click the icon and select Configure Connectivity Server. The dialog can also be accessed from the NetSupport Connectivity Server Console select {File}-{Configure Connectivity Server} from the drop-down menu. Alternatively, you can run the file Pcgwcfg.exe from the NetSupport School program folder.

Note: To display the NetSupport Connectivity Server icon in the system tray, click the Start screen, choose All apps, NetSupport School and click NetSupport School Name Server Console.
**Listening Port and Interfaces**

**Listen on all IP interfaces**
By default, the installed Connectivity Server component uses the local IP address(es) and communicates through port 443.

**Listen on specified IP interfaces**
If the Connectivity Server machine has multiple network cards installed, you can add the specific IP address to use. Click **Add** and enter the required address.

**Note:** The IP address of the Connectivity Server machine and key will also need to be configured at both the Tutor and Student machine.

**Comms. Management Packet Interval**

**CMPI (secs:)**
When configured for Connectivity Server connections, the Client machine confirms its availability by periodically polling the Connectivity Server. By default, a network packet is sent every 60 seconds, but you can change this if required.

**Event Log Files**
Connectivity Server activity during an active session is recorded in a text file, default GW001.LOG. This can be useful for checking which Clients and Controls have connected through the Connectivity Server.

**Location:**
By default, the installed Connectivity Server component uses the local IP address(es) and communicates through port 443. Select **Browse** to specify an alternative path.

**Max File Size (KB):**
Over a period of time, the log file could become quite large, you can manage this by specifying a maximum file size. When the limit is reached, the existing information in the file is overwritten by the new records.

**Note:** For changes to the log file settings to take effect, you will need to restart the Gateway32 service.
**Automatic recovery if service stops abnormally**
By default, the Gateway service will automatically recover if there is an abnormal shutdown.

**NetSupport Connectivity Server Configuration utility – Keys tab**
Access to a NetSupport Connectivity Server is protected by use of a security key.

![Image of NetSupport Connectivity Server Configuration Utility window]

The Connectivity Server will not accept connections from a Tutor or Student unless a "Connectivity Server key" is specified, and that same key is also configured at both the Tutor and Student end. The Connectivity Server can support multiple keys, at least one key must be specified.

Select **Add** to specify the key. The Key must be at least 8 characters.
NetSupport Connectivity Server Configuration utility - Licenses tab

Displays all licences stored in the NetSupport School directory, if you do not have an internet connection, you can manually activate your NetSupport School licence here.

An activation code is required, contact NetSupport or your reseller for this. Click **Activate** and enter the code. You will then need to restart the Connectivity Server.

**Note:** If an internet connection is available, the licence will activate automatically and the Connectivity Server does not need to be restarted.
NetSupport Connectivity Server Configuration utility - Security tab

The NetSupport Connectivity Server provides support for an enhanced level of encryption to be used when initiating communications from remote computers.

Enable encryption of communications to remote computers
When enabled all communications in the connection process are encrypted.

Note: The remote computers (Controls and Clients) need to be running version 10.61 or later.

Block any remote computers not using encrypted communications
Earlier versions of the Control and Client programs do not support the enhanced level of encryption. Selecting this option will block connections from remote computers running versions of the Control or Client software.
**NetSupport Connectivity Server Configuration utility - Classes tab**

The NetSupport Connectivity Server provides direct integration with OneRoster or Google Classroom, providing access to your online SIS (Student Information Systems) classrooms and student accounts.

**Class datasource**

**None**

Selecting this option will remove any previously stored SIS information.

**ClassLink OneRoster**

Select this option to link to ClassLink OneRoster and enter your school's Tenant ID. For added validation, enter the matching NetSupport School Security/API Key provided in your Roster Server Portal. (The key can be found in the OneRoster Server Portal by selecting, Applications >
NetSupport School > API Key and Secret.) For information on integrating with ClassLink OneRoster, please see the following technical document: [NetSupport School SIS integration with ClassLink OneRoster](#).

**OneRoster zipped CSV files**
Alternatively, you can use zipped CSV files. Click and browse to the required files.

**Notes:**
- For further information on creating CSV files and performing bulk and delta imports using these files, please refer to the document: [Using CSV files to import SIS/MIS data](#).
- The CSV files must conform to the OneRoster standard.
- The first time you configure the Connectivity Server to use OneRoster zip files, you must do a bulk export of your SIS data.

**Google Classroom**
Select this option to link to Google Classroom. Click to browse for and select one of the JSON files that you have copied to the machine (both files must be present, but either file can be selected). For information on how to set up a Google Classroom Project and create the required JSON files, please see the topic: [Integrating NetSupport School with Google Classroom](#).

Click **Apply** and you will be prompted to sign into Google G Suite with administrator credentials and grant access to NetSupport School.

**Syncs per day**
By default, the Connectivity Server will sync with OneRoster or Google Classroom once a day. This can be amended by entering a different value here. You can also specify the time the sync will take place.

Click **Sync now** to synchronise the Connectivity Server. Clicking **Reset Data** will clear all previous data stored and, if there is a lot of data to download, it may take some time.
NetSupport Connectivity Server Console
The key to a successful remote support solution is the ability to locate and connect to devices no matter where they are. NetSupport School provides a range of connectivity methods as standard.

The NetSupport Connectivity Server is a central hub for managing all your NetSupport connections across the internet. From the Console, you can see what NetSupport Connectivity components are installed and in use.

To open the NetSupport Connectivity Server, right-click the NetSupport Connectivity Server icon in the system tray and select Open or double click the icon.

An overview of how many Clients are currently connected is displayed. Further information can be found in each of the tabs:

Features
Shows you what components of the NetSupport Connectivity Server are installed.

Clients
Displays a list of all the NetSupport Clients that are currently connected to the NetSupport Connectivity Server.

Active sessions
Displays a list of current connections between a NetSupport Control and a NetSupport Client with the date and time that the connection started.

Services
Displays a list of NetSupport School Tutors that are active in Room mode. This allows NetSupport School Students to connect to the room through the Connectivity Server.

To configure the settings for the NetSupport Connectivity Server, select {File} {Configure Connectivity Server} from the drop-down menu.
Working with groups

NetSupport School provides you with sophisticated grouping functions to enable you to manage and organise different groups of Students. You can use the following functions on groups as a whole:

- Show
- File Distribution
- Scan
- Launch applications
- Message
- Lock/unlock
- Multimedia support
- Send/collect work
- Chat
- Question and Answer team mode

To create a group

1. Select the Group tab in the ribbon and click Add.
   Or
   Click the Group options icon on the group bar and select Add.
2. The Add a Group wizard appears asking you to provide a name and brief description of the group. It will then assist you in creating your group.

Your newly created group will appear as a tab on the group bar.
**Group Students randomly**

1. Select the Group tab in the ribbon and click **Group Randomly**.
2. The Group Randomly dialog appears.
3. Select how to group the teams:
   - **Assign Randomly**
     Students are randomly assigned to groups. Enter the number of groups required.
   - **Student chooses**
     Students can choose what team to join. Enter the group names and separate each value with a comma.
4. Click **OK**.
5. The newly created group(s) will appear as a tab on the group bar.

**To change the members of a group**

1. Select the required group on the group bar.
2. Select the Group tab in the ribbon and click **Properties**.
   Or
   Click the **Group options** icon on the group bar and select **Properties**.
   Or
   Click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click **Properties**.
3. Choose the Members tab and simply select the Student to be removed or added.
4. Click **OK**.

**Note**: You can also remove Students from a group by right-clicking the selected Student icons and selecting the **Remove from Group** icon.

**Deleting a group**

If you no longer need a group that you have defined, you can remove the group. This will not affect the Students that are members of the group.

**To delete a group**

1. Select the group that you want to delete.
2. Select the Group tab in the ribbon and click **Remove**.
   Or
   Click the **Group options** icon on the group bar and select **Remove**.
   Or
Click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click **Remove**.

3. Click **Yes** to confirm you want to remove the group.

**Note**: If you don't want to see the warning prompt again, click **Don't show this again**. You can re-enable this in the Tutor User Interface settings.
Group leaders

When working with defined groups of Students, the Tutor can assign ‘group leader’ status to a selected member of the group. The designated leader can then take control of the group, performing many of the tasks that the main Tutor can. The main Tutor retains overall responsibility while a group leader is in place and can remove the status at any time.

To select the features available to a group leader, click Options in the Tutor Console, select Settings from the drop-down menu and choose Group Leaders.

Visual group leader connections are displayed by default, allowing you easily see the link between a group leader and their Students in all views. If you don't want to see these, clear the Show Visual Group Leader Connections option.

All group leader features are enabled by default but can be removed by clearing the appropriate box.
Assigning a group leader

1. Select the required group from the Group bar.
2. Select the required Student icon.
3. Right-click the required Student and select Assign group leader.

The Student icon in the Tutor Console is highlighted to indicate that they are a group leader. A connection bar showing the link from the group leader to the Students is displayed. This can be disabled by clicking Options in the Tutor Console, selecting Settings from the drop-down menu, choosing Group Leaders and clearing the Show Visual Group Leader Connections option. Different groups will have different colour connection bars, these will be displayed in other views when in "Large Icons" layout.

The Student will receive a message indicating that they have been given group leader status. They can choose to run the group leader features immediately by clicking Run Now or at a later stage by clicking on the Run Group Leader icon on the Student Toolbar or the Run Group Leader icon on the system tray. A cut-down version of the Tutor Console opens, allowing them access to the selected features.

Notes:

- Although a Student may be in more than one group, they can only lead one group at a time.
- Each defined group can have a Group Leader, even if one of the group members is already leading another group.
- The main Tutor can continue to monitor all Clients, including Group Leaders.
Suspend group leaders
During a Tutor session where group leaders are in place, the Tutor may want to perform a task without conflicting with something the group leaders are doing. Rather than remove and reinstate each group leader individually, you can globally suspend and reinstate group leader access as required.

To suspend group leaders
1. Select the Group tab in the ribbon and click **Suspend All**.
2. All group leaders will be suspended.

To reinstate group leaders
1. Select the Group tab in the ribbon and click **Suspend All**.
2. All group leaders will be reinstated.

Remove group leader
The main Tutor can remove group leader status from Students at any time.

To remove group leaders
1. Select the group containing the required Student.
2. Right-click the Student icon and select **Remove group leader**.
   Or
   Click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click **Remove Leader**.

The Student will receive a message informing them that group leader rights have been removed.
Customise Student and group icons
The Student and group icons displayed in the Tutor Console can be customised to suit individual requirements. A choice of images can be used and you can apply these to the machine name or the logged on user.

Customise Client and/or group icons
1. Select the required Student or group from the group bar.
2. Right-click the Student and click the Customise icon
   Or
   Select the Group tab in the ribbon and click Customise.
3. The Image Customisation dialog will appear. Select one of the three tabs:
   - **All Computers**: Applies the selected image to the machine name.
   - **Logged On User Name**: Assigns the image to the user name so will load at whatever PC the Student logs onto. This option takes precedence over images applied to the machine name.
   - **Groups**: Enables you to apply an image to each defined group of Students.
4. Select the Student name or group from the list and click Modify. If using the logged on user name option, click Add and enter the Student’s logon name.
5. Browse for the required icon image. A number of default libraries (*.ncl) are provided in the Program folder, or you can select a picture of your own choosing. Highlight the required image and click OK. Repeat this process for any other Students and groups.
6. Click OK when complete.
**Note:** Individual Student and group icons can be changed by amending the properties of the selected item. Right-click the Student and click the **Properties** icon, select the Details tab and click **Customise** in the Appearance section or click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this), click **Properties**, select the General tab and click **Customise** in the Appearance section.
Using NetSupport School

In this chapter...

You will discover how to use the wealth of features available to a Tutor (Control) user. From how to initiate a remote control session to how you then monitor and manage activity at the end-users desktop.
Locking Student controls and blanking Student screens

When you perform a Show, the Students’ mice and keyboards are automatically locked. There may, however, be other occasions when you want to lock Students’ keyboards and mice.

You can only lock/unlock Students that are connected.

To lock Students
1. Select the Student(s) or groups of Students you wish to lock.
2. Select the Class tab in the ribbon and click Lock.
   Or
   Right-click the selected Student icons and click Lock.
   Or
   To lock all Students, click Lock All on the caption bar (you can do this from any window). If this is not showing, click the Configure Quick Access List icon on the caption bar and select Lock/Unlock all students from the drop-down list.

   **Note:** By default, sound is muted at the Students when locking all Students. This option can be disabled in the Student User Interface settings.

3. A graphic will appear on the Student machine, informing them that you have locked their mouse and keyboard.

To unlock Students
1. Select the Class tab in the ribbon and click Unlock.
   Or
   Right-click the selected Student icons and select Unlock.
   Or
   If you have locked all Students, click Unlock All on the caption bar.

Changing the graphic when locking a Student
A default graphic is displayed on a Student's screen when you lock a Student's keyboard and mouse. This image can be changed if required.

The image can be changed by replacing the nss_lock_image file in C:\Program Files\NetSupport\NetSupport School or using the Student Configurator to select an alternative file.
1. In the Student Configurator, select **Advanced**.
2. The image file will display the default file.
3. Click **Browse** to select an alternative file, then **Open**.
4. The image file will display the new file.
5. Click **OK**.

**Notes:**
- If you would like to display an image file that is not available on Student machines, use the NetSupport School Deploy function to Deploy a Configurator setting to all connected Student machines.
- If you view a locked Student, the display graphic on a Student screen will no longer apply.
- If an image file cannot be located on the Student machine, a flashing message “This machine has been locked by the control user” will be displayed on the Student screen.
Viewing Student screens
Having connected to a Student, you can now control it. This is called viewing. The Student’s screen will be displayed in a window on the Tutor machine. NetSupport School will allow you to view multiple Student screens, each in its own window, simultaneously.

**Note:** If required, a message can be displayed at the Student machine confirming it is being viewed. See the Configuring the Student section of this manual.

**To view a Student**
1. Double-click the required Student icon in the List view.
   Or
   With the required Student icon selected, select the Class tab in the ribbon and click **View Client**.
   Or
   Right-click the Student icon and choose **View**.
2. The View window for that Student will appear at the Tutor. To aid navigation of the Student screen, a thumbnail of the screen appears (if the Student is running multiple monitors, they are all displayed), enabling you to scroll the Student desktop more easily. Click inside the thumbnail to view specific areas. The navigation window can be enabled or disabled by clicking the **Navigation** icon on the View window ribbon.
Notes:
• For acceptable performance while viewing, ensure that the Student’s Active Desktop is turned off.
• If the Student uses multiple monitors, you can switch between the monitors or show the whole desktop by clicking the Monitor tab in the ribbon.
• If the Tutor and the Student are both using touch-enabled devices, the Tutor will be able to control the Student machine using touch commands.

To stop viewing and return to the Tutor Console
1. On the caption bar, click the Close icon.

There are three modes in which you can view a Student machine:

Share
The Student’s screen will be displayed at both the Tutor and the Student. Both the Tutor and the Student will be able to enter keystrokes and mouse movements.

Watch
The Student’s screen will be displayed at both the Tutor and the Student. Only the Student will be able to enter keystrokes and mouse movements. The user at the Tutor will be locked out.

Control
The Student's screen will be displayed at both the Tutor and the Student. Only the Tutor will be able to enter keystrokes and mouse movements. The Student will be locked out.

To change the viewing mode
1. While viewing the Student, select the Home tab in the View window ribbon and select Share, Watch or Control.

Other View window options are:

View
Allows you to select which monitor to view if the Student is running multiple monitors. You can view the whole desktop or a specific monitor. If you are viewing a specific monitor, the monitor number is displayed on the View icon image. You can see more information about the monitors by clicking the Monitor tab in the ribbon.

Note: This option only appears if the Student you are viewing has multiple monitors.
Scale to fit
Sets the display mode for how the Student screen is displayed. Turning scale to fit on enables you to display the whole of the Student screen in the available View area.

Full Screen
Uses the whole of the available screen area on the Tutor to display the Student’s screen. A floating toolbar is provided in Full Screen mode, allowing access to a selection of tools.

Note: To return to Windowed mode, select Ctrl+Left Shift+Right Shift (these shortcut keys can be customised in Tutor Configuration - Keyboard/Mouse settings) or click the Windowed icon on the floating toolbar.

Touch border
When viewing a Student on a touch-enabled device (the Tutor must also be using a touch-enabled device), you can enable a touch border. This border makes it easier to access certain functionality when using drag touch gestures.

Aspect Ratio
Maintains the correct aspect ratio of the remote screen.

Screen Scrape
NetSupport School’s favoured, and the most efficient, method for capturing screen data is to hook into the Video Driver of the machine being viewed. However, there may be occasions when this method will not work because certain applications bypass the driver. In these circumstances, you can enable screen scrape’ mode in order to take a snapshot of the screen. Although this will have a greater impact on the network, it will at least provide an accurate representation of the Student’s screen.

Navigation
To aid navigation of the Student screen, a Navigation window showing a thumbnail image of the screen is displayed (if the Student is running multiple monitors, they are all displayed). This enables you to scroll the Student desktop more easily. Click and drag inside the thumbnail to view specific areas.
**Optimise**
By default, when viewing a Student screen the colour depth is set to 256 colour (high quality). This option allows you to change the quality when viewing Student screens.
Blanking the Student’s screen while viewing
For security reasons, you may require the Student screen to be blank while you are remotely controlling it.

**Note:** This feature is only available on Students running Windows 10 v2004 and above (legacy support is provided for Students running Windows 8 and below).

1. Select the Home tab in the View window ribbon and click **Blank Screen**.
2. The Student’s screen will be blanked.
3. To restore the screen, click again.

Sending Ctrl+Alt+Delete while viewing
You can send Ctrl+Alt+Delete to a machine that you are viewing.

**To send Ctrl+Alt+Delete to a Student you are viewing**
1. Press the Ctrl+Alt+Esc keys simultaneously.

Or

1. Select the Home tab on the View window ribbon and click **Ctrl+Alt+Del**.
2. Click **Yes**, to confirm Send Ctrl+Alt+Delete.
Blank all Student screens
Although you can blank a Student screen while it is being viewed, there may be occasions when you quickly want to blank all Student screens simultaneously.

To blank all Student screens
1. Select the Class tab in the ribbon and click Blank All.
2. The Student screens will be blanked.
   
   **Note:** By default, sound is muted at Students when blanking all screens. This option can be disabled in the Student User Interface settings.

3. To restore the screens, repeat the above process.
   
   **Note:** You can blank an individual Student screen by right-clicking the Student and selecting Blank.
Remote clipboard

During a View session, you can copy the content of the clipboard between Tutor and Student PCs.

The Clipboard section on the Home tab of the View window ribbon provides the following options:

**Send**
Used when copying from the Tutor to a Student and using the {Edit}-{Cut/Copy} menu option.

**Retrieve**
Used when copying from the Student to the Tutor and using the {Edit}-{Cut/Copy} menu option.

**Auto Clipboard**
When enabled, provides the quickest method for copying data. Use the short cut keys (Ctrl+C and Ctrl+V) to automatically copy to and from the clipboard at both the Tutor and Student machines.

**Sending the content of the clipboard from a Tutor to a Student machine**

1. View the required Student.
2. Open appropriate applications on the Student and Tutor machines.
3. Select and copy the required data from the application at the Tutor.
   - If **Auto Clipboard** is enabled using Ctrl+C copies the data directly to the clipboard.
   - Or
   - If you have used {Edit}-{Cut/Copy}, return to the Student's View window and click the **Send** icon on the ribbon.
4. To paste the data at the Student application, choose {Edit} from the Student application drop-down menu, select **Paste**.
   - Or
   - Use the short cut keys (Ctrl+V) to paste the data.
Sending the content of the clipboard from a Student to a Tutor machine

1. View the required Student.
2. Open appropriate applications on the Student and Tutor machines.
3. Copy the required data from the application at the Student as above but if using menu options rather than the shortcut keys, click the **Retrieve** icon on the ribbon.
4. Return to the Tutor application and paste the data using the appropriate menu options or the short cut keys (Ctrl+V).
Scanning Students
The Scan function enables you to cycle through each connected Student in turn, displaying its screen on the Tutor.

Multiple Student screens can also be scanned in one Scan window.

To scan one Student screen at a time
1. Select the Group tab in the ribbon.
2. Select the **One Client at a time** icon.
3. In the List view, select the Students to include in the scan (if you select a group, all Students are included).
4. Use the slider to specify the interval before the scan is advanced to the next Student. The scan period can be set anywhere between five seconds and two minutes.
5. Click **Start**.
6. The Scan window will appear and immediately show you the first Student in the sequence. It will cycle through the selected Students, showing their screens on the Tutor until you end the scan.
The following icons are available for a single Student scan:

**Previous, Auto Advance and Next**
Allows you to turn auto timing on or off, or choose to move forwards or backwards between individual Students. The **Previous** icon shows the previous Student screen scanned. The **Next** icon shows the next Student's screen in the scan cycle.

**Scale to Fit**
It may be that the Student is running in a higher resolution than the Tutor. Selecting this option will resize its screen to fit the window in which it is displayed.

**Full Screen**
When scanning in full screen mode, you can use the Scan Floating toolbar to control the operation.

**Screenshot**
A snapshot of the current Student View window will be taken.

**Scanning multiple screens simultaneously**
Multiple Student screens can be scanned simultaneously in one Scan window.

---

**Note**: You can display up to 16 Student screens in one Scan window at a time.

---

**To scan multiple screens simultaneously**
1. Select the Group tab in the ribbon.
2. In the List view, select the Students to include in the scan (if you select a group, all Students are included).
3. Select the number of Student screens to be displayed in the Scan window by clicking the relevant icon:
   - Students are arranged 2x2.
   - Students are arranged 3x3.
   - Students are arranged 4x4.
4. If scanning more than four Student screens, select a scan interval using the slider. The scan period can be set anywhere between five seconds and two minutes.
5. Click **Start**.
6. The Scan window will appear.

**Note:** If scanning more Student screens than the number of screens displayed in the Scan window, by using the **Next**, **Auto Advance** and **Previous** icons, you are able to switch between multiple Scan windows.

The following icons are available for a multiple Student scan:

**Previous, Auto Advance and Next**
Allows you to turn auto timing on or off, or choose to move forwards or backwards between individual Students. The **Previous** icon shows the previous Student screen scanned. The **Next** icon shows the next Student's screen in the scan cycle.

**Scale to Fit**
It may be that the Student is running in a higher resolution than the Tutor. Selecting this option will resize its screen to fit the window in which it is displayed.

**Full Screen**
When scanning in full screen mode, you can use the Scan Floating toolbar to control the operation.

**Screenshot**
A snapshot of the current Student View window will be taken.
Maximise
Maximises a selected Student’s window. You can also click the **Maximise** icon in the top right-hand corner of the Student window.

Lock
To lock a selected Student’s keyboard and mouse.

Chat
To initiate a chat session between a Student and the Tutor.

Share
To view a Student in Share Mode.

Screenshot
A snapshot of the current Student View window will be taken.

To end the scan
1. On the caption bar, click the **Close** icon.
Monitor mode

Monitor mode enables the Tutor to view multiple Student screens simultaneously. A convenient thumbnail view of each connected Student screen is displayed at the Tutor, providing a quick and easy method for monitoring Student activity. While in Monitor mode, the Tutor still has access to the full range of NetSupport School features such as View, Chat and File Transfer.

![Monitor View interface](image)

1. Click the **Monitor View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Monitor View**.

The List view will display each Student thumbnail. By mousing over a thumbnail, you can zoom into that screen. Double-clicking on a thumbnail will open a view session to the selected Student, right-click and you can select from the full range of available Client features. For example, by selecting multiple thumbnails, you can invite those Students into a Chat session.

When viewing a 'zoomed' thumbnail, you can:
- lock the Student by clicking the **Lock** icon
• open a View window by clicking the View icon
• capture a snapshot of the thumbnail by clicking the Capture Screenshot icon. (The screenshot is saved as a .png to NetSupport School\Screenshots in your local Documents folder. You are notified if there is an error taking a screenshot).

**Notes:**
• The zoom facility can be toggled on/off by clicking Zoom In on the status bar.
• By default, the battery level and wireless strength (if applicable) are displayed on the Student thumbnails. You can turn these off in the Tutor Configurator - Tutor User Interface settings.

**Customise thumbnail size**
Student thumbnails can be resized to suit personal preferences. This is particularly useful when connected to large numbers of Student machines.

1. Use the slider on the status bar to select the required size.

**Auto-fit size of student thumbnail**
This option will automatically adjust the size of the displayed thumbnails to fit the window.

1. Click Auto on the status bar.

**Changing the thumbnail refresh rate**
Depending on how closely you want to monitor Student activity, you can adjust the frequency at which the thumbnails are refreshed.

1. Select the Class tab in the ribbon and select the required option (real-time, high, medium or low) from the Update drop-down list.

**Show active application**
When enabled, an icon will appear in the top right of each thumbnail indicating which application is currently active at the Student machine.

1. Select the Class tab in the ribbon and click the Show current application icon.
Show active website
Displays an icon in the bottom right of each thumbnail indicating which site the Student is currently visiting.

1. Select the Class tab in the ribbon and click the **Show current website** icon.

Show help requests
This option highlights when a Student has outstanding help requests (it is enabled by default). The Student thumbnail is highlighted to show when a Student requests help (the colour matches the type of alert selected: green for 'work is complete', amber for 'help needed' and red for 'urgent help required').

1. Select the Class tab in the ribbon and click the **Show Students help requests** icon.

Multiple monitors
If a Student is running multiple monitors, icons are displayed on their thumbnail, allowing you to switch between each monitor or view the whole desktop. Click the **Multi Monitor Menu** icon to view the whole desktop or select which monitor to view. Click the **Whole Desktop** icon to view the whole desktop. Click the **Number** icon to view an individual monitor.

**Note:** You can set the thumbnails to automatically show all monitors for Students by selecting the Class tab in the ribbon and clicking **Show All Monitors**.
Keyboard Monitoring

Allows the Tutor to monitor Students keyboard usage while using any approved application, providing a real-time insight into Student activity during a class. The Tutor can monitor the entire class, quickly viewing any typed content and keeping an eye on Student activity levels. To further enhance the monitoring process a Tutor can create 'target' and 'inappropriate' word lists when a Student types a word on the list it will be immediately highlighted at the Tutor.

The keyboard monitor also provides a perfect monitoring tool when Students are online in forums or search forms.

**Note:** Keyboard Monitoring is not available in the following languages: Korean, Simplified Chinese, Traditional Chinese, Arabic, Japanese and Russian.

In 'Typing' mode, you can view details of target or inappropriate words and use the available icons to:

- Create a new word list.
- Load an existing word list.
- Monitor Student typing activity.
**NetSupport School 15.00**

**Note:** Details layout is the default layout, you will be unable to view Keyboard Monitoring in any other layout.

The lower panes can be minimised to make more room for the Student icons. Click the **Minimise View** icon.

The current application will be displayed along with the text the Student is typing, any target or inappropriate words will be identified with either a green (target) or red (inappropriate) visual indicator. A count of how many target/inappropriate words that have been typed by each Student will also be displayed.

**Note:** Keyboard Monitoring can be setup at start-up. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Start Options - Restrictions**.

**Monitoring activity**

1. Click the **Typing View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Typing View**.
2. Select the Class tab on the ribbon and click **Monitor Activity**.
3. An icon showing the current application running on the Student machine is displayed next to each Student, along with any typed content and any target/inappropriate words will be identified.
4. A **Monitor Activity** icon is displayed on the status bar, showing that keyboard activity is being monitored (This appears in all view modes). Clicking this icon turns off keyboard monitoring.

**Notes:**
- Inappropriate words can be obscured at the Tutor Console; select the Class tab in the ribbon and click **Obfuscate**.
- You can clear the typed text in the Text column for Students. Select the Class tab in the ribbon and click **Clear Text**.
Setting up word lists

While Keyboard monitoring provides real-time tracking of what Students are typing, you can ensure Students are on track during the lesson by creating target or inappropriate word lists. There may be certain words that you will expect Students to include during a written lesson. When a Student types a word on the list, it will be identified with a visual indicator, green (target) or red (inappropriate).

Notes:

- Word lists can be sent to the Student Journal, allowing the Student to refer back to this after the lesson. Click the Journal icon above the Target Words pane.
- The target word list can be viewed in the Student Toolbar.

Add a word to your target or inappropriate list

1. Click the Add icon to add a word to the target or inappropriate word list.
   Or
   Right-click in the Target or Inappropriate Words pane and select Add Word.
2. The Add Word list dialog will appear.
3. Type in the word to be added.
4. Click OK.
5. The word will appear under the target or inappropriate list.

Remove a word from your target or inappropriate list

1. To remove a word from the list, highlight the chosen word and click the Remove icon.
   Or
   Right-click in the list box and select Remove Word.

Create a new word list

1. Select the Class tab in the ribbon and from the Word list drop-down menu, click Create New Word List.
2. Enter a file name and click Create.
3. A new blank Word list will appear.
Open an existing word list
1. Select the Class tab in the ribbon and from the **Word list** drop-down menu, click **Load Existing Word List**.
2. Highlight the relevant file and click **Open**.
3. The existing Word list will appear.

Save a word list
1. Select the Class tab in the ribbon and from the **Word list** drop-down menu, click **Save Word List As**.
2. Enter a file name and click **Save**.
3. The current Word list will be saved.

**Notes:**
- Any changes that have been made to the new or existing Word list will be automatically saved when a new Word list is created or when you have exited from the NetSupport School program.
- The default word list is saved as NetSupport School.wdl.
**View typing history**

This feature of Keyboard Monitoring enables you to monitor the Keyboard usage of connected Students and if required, store or print a permanent record.

1. In Typing view, select the Class tab in the ribbon and click **History**.
2. The Typing History dialog appears.
   - This provides details of the Students Keyboard activity during the currently connected session.

![Typing History dialog](image)

The available options are:

**Show History for:**

You can view the history for all Students, the currently selected Students or you can select the required Student from the list.

**Refresh**

While viewing the list, click **Refresh** at any time to update the display.

**Save**

To keep a permanent record of the displayed items, you can save the details to a text file before disconnecting.
**Export**
Exports data to a CSV file allowing the data to be imported if needed.

**Print**
Prints details of the currently displayed items.

**Close**
Closes the History dialog but details will continue to be recorded while the Control is connected.
Screen capture

Screen capture enables the Tutor to take a snapshot of the current Student screen whilst viewing or scanning and save this to a file. The machine name, Student name, date, time and product name will also be recorded when saved.

Capture a Student’s screen
1. When viewing or scanning a Student, select the Home tab in the ribbon.
2. Click Screenshot.
3. The current Student screen will be captured and automatically saved as a .png to NetSupport School\Screenshots in your local Documents folder.

   **Note:** An indicator appears on the Screenshot icon showing the number of screenshots that have been taken.

4. Clicking the Screenshot drop-down arrow lists the last nine screenshots taken (you can view or delete them as required) and you can open the folder where the images are stored.

**Notes:**
- When scanning multiple Students, a Student screen must be active (highlighted) for the screen capture feature to become available.
• When capturing in the Scan session (one Student at a time), auto scan is temporarily suspended until the screen capture operation is complete. Once complete, auto scan is re-enabled automatically and the scan of the next Student continues.

• You can take a screenshot of a Student thumbnail in Monitor mode. Zoom in to the required Student thumbnail and click the **Capture Screenshot** icon.
Showing to Students
The Show feature enables the Tutor user to emphasise key learning points by displaying the information on their screen to a selected Student or group of Students. You can also show a stored replay file, audio file a video or an application that is currently running at the Tutor.

During a Show, the Tutor can nominate a selected Student to take over the demonstration, making them the show leader.

**Note:** To improve performance when showing to a large number of machines, NetSupport School’s Broadcast Show facility is enabled by default. This results in the screen information being sent to all machines simultaneously, thus improving the speed of transfer. Turning this feature off results in the screen information being sent to each Student machine in turn.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will generate additional broadcast packets on your network. It is recommended that you consult your network administrator before using this feature.

The Show can be sent to Students using multicast. The broadcast will only be sent to machines included in the specified IP multicast address.

To include a 'snapshot' of the screen in the Student Journal, click **Print Screen** during the Show or right-click the **Show** icon on the system tray. A dialog will appear displaying the image to be added to the Journal, notes can be added to accompany the image.

**To show a Tutor screen**
1. Select the Class tab in the ribbon and click the **Show** icon.
2. Show options can be set by clicking the relevant option in the Show menu. To set further Show properties, click the **More** icon.
   
   **Note:** If you are running multiple monitors, you can choose which monitor to show Students by clicking the relevant icon.
3. Click **Quick Show**.
4. Your desktop will be displayed to all connected Students.
To end the Show
1. Double-click the Showing icon on the taskbar.
   Or
   Double-click the NetSupport School Tutor icon on the desktop.
2. This will display the Show Suspended dialog.

   ![Show Suspended Dialog]

3. Click End.

   Or

   1. Right-click the Showing icon on the taskbar.
   2. Click End Show.

   Or

   1. Use the hotkey combination CTRL+ALT+END.

To enable the Tutor to continue working in the background while Showing
1. Double-click the Showing icon on the taskbar.
2. The Show Suspended dialog is displayed.
3. Click Continue.
4. The Tutor Console is displayed and the caption bar indicates that the Show is suspended. You can now continue to use the Tutor machine without the Students seeing what you are doing. The Student screens will still display the previous Show.
To resume a Show while suspended
1. Select the Class tab in the ribbon, click the Show icon choose Resume.
   Or
   Click the Suspended icon on the status bar and click Resume.
2. The Show Suspended dialog will be displayed on the Tutor screen from which you can choose to End or Resume the Show.

To end a Show while suspended
1. Select the Class tab in the ribbon, click the Show icon and choose End Show.
   Or
   Click the Suspended icon on the status bar and click End Show.
2. Students will now see their own display.

To set a Show Leader while suspended
With the Show suspended, the Tutor can assign Show Leader status to one of the selected Students. This unlocks the mouse and keyboard of the Student, enabling them to take over the demonstration. The Tutor continues to oversee the Show and can end the Show as required.
**Show leader**

While the Tutor screen is being shown to the class, it may be appropriate for a Student to take over the demonstration. For this purpose, the Tutor can assign Show Leader status to a selected Student. The mouse and keyboard of the Show Leader’s PC are unlocked and they can continue the presentation on the Tutor’s behalf.

The Tutor can still interact simultaneously with the Show Leader and can suspend or end the session as required.

**To create a Show leader**

1. Start showing the Tutor screen to Students as normal.
2. When you are ready to create a Show Leader, click the **Show** icon on the taskbar.
3. This will display the Show Suspended dialog and the Show will be suspended. Student screens will still display the Tutor screen.
4. Click **Show Leader**.
5. The Show Leader dialog will be displayed.

![Show Leader Dialog]

**Note:** If the **Show icon on taskbar** option has previously been selected, you can create a Show Leader by right clicking on the icon and choosing **Show Leader**.

6. Click **This Client** and select the Student to make Show Leader.

**Note:** The Show Leader will have full access to your desktop.
7. Click **OK**.

8. The message ‘You are leading the Show’ will appear at the selected Students machine.

9. Click **Resume** to restart the Show.

The Show Leader and Tutor can now interact together in leading the Show.

**Note:** To remove the Show Leader, click **Show Leader** in the Show Suspend dialog and select **None**.
Exhibit - Showing one Student's screen to others

With NetSupport School, it is possible to show the Tutor’s screen to a number of connected Students. It is also possible to show an individual Student’s screen on selected or all Students’ screens. For example, Student 1 has produced some work, which you wish to show to the rest of the class.

To show a Students screen
1. Select the Student whose screen you want to show to the other Students.
2. Select the Class tab in the ribbon and click Show.
   Or
   Right-click the Student icon and choose Exhibit.
3. Show options can be set by clicking the relevant option in the Show menu. To set further Show properties, click the More icon.
4. Click Exhibit.
5. The selected Student’s screen will then be displayed on the screens of the Tutor and the other Students. Only the Tutor and the exhibiting Student will be able to change the screen.

Switching between full screen and windowed mode at the Tutor
1. Select the Home tab in the Exhibit window ribbon and click Full Screen.

Note: To return to windowed mode, click the Windowed button on the floating toolbar or use the hotkeys <CTRL>+<LSHIFT>+<RSHIFT>.

Suspend or stop the exhibit
The Tutor can choose to end the exhibit or temporarily suspend it. While suspended, the Tutor and/or Student can prepare a new demonstration in the background. The previously exhibited screen remains on the other Student screens until the exhibit is resumed.

To suspend the exhibit
1. Select the Home tab in the Exhibit window ribbon and click Suspend.
2. While suspended, the Tutor and Exhibiting Student can work in the background. The other Student screens remain frozen.
3. To resume the exhibit, choose **Resume**.

**To stop the exhibit**
1. Select the Home tab in the Exhibit window ribbon and click **Stop**.
Student Feedback and Wellbeing
NetSupport School provides a simple and quick way to receive feedback from Students; helping to capture how they feel, their confidence in a topic and whether they need extra support. Teachers can choose between several visual options to send to Students. The Student then clicks on the appropriate icon and the feedback results are reported to the Tutor in a simple list view or bar chart.

Note: NetSupport School also offers more comprehensive ways to ask Students questions and collaborate with them, see Survey mode or Question and Answer module.

1. Select the Feedback & Wellbeing tab in the ribbon and click Feedback and Wellbeing.
2. The Feedback and Wellbeing dialog appears.

3. Enter the question to ask Students in the Ask students field (a drop-down list of the previous ten entries will appear, or you can type a new one - there is a 128-character limit), or you can verbally ask the question. Select the visual indicators to send to Students. If you want the results to be anonymous, click Anonymise results.
4. Click OK.
5. At the Student, the Student Toolbar will switch to Feedback mode and a dialog will appear showing the question (if entered) and a selection
of icons for them to choose from. The Student simply clicks on the required icon.

6. At the Tutor, a Feedback and Wellbeing Results dialog will appear, allowing you to see the results as they come back. The results can be viewed in a list or bar chart. To switch between views, use the **List** or **Chart** buttons. The results can be saved or printed by clicking the appropriate icon.

7. Click **Close** when finished.
Interactive Whiteboard

A full screen interactive whiteboard is provided, enabling the Tutor to use NetSupport School’s annotation tools to highlight the screen and show the results to a selected group of Students.

**Note:** To include the whiteboard image in the Student Journal, select the Whiteboard tab in the ribbon and click **Add to Journal.**

1. Select the **Whiteboard View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Whiteboard View.**
2. Use the range of annotation tools provided in the Whiteboard tab in the ribbon to highlight the screen and add any stored graphics.
3. If required, you can save the content of the whiteboard for later use. Select the Whiteboard tab in the ribbon and click **Save.**

**Note:** You can save the currently selected area in the whiteboard by clicking the **Save** drop-down arrow and selecting **Save Selection.**
To show the whiteboard to Students

1. If showing a stored whiteboard image, select the Whiteboard tab in the ribbon and click **Load Image**.
2. You can show the whiteboard to a group of Students by selecting the required group tab in the group bar. The Student list on the right-hand side of the Tutor Console shows which Students are included.

   **Note**: You can set the whiteboard size displayed on Student screens. Select the Whiteboard tab in the ribbon, click **Canvas Size** and choose the required size from the drop-down menu.

3. Select the Whiteboard tab in the ribbon and click **Show**.
4. The content of the whiteboard will appear on the selected Student screens. The Tutor can continue to annotate the whiteboard in real-time.

   **Note**: The **Show** and **Whiteboard View** icon turns red and the **Whiteboard** icon appears next to the Student icons in the Student list, showing that the whiteboard is being displayed to Students.

5. To remove the whiteboard from Student screens, click **Show** again.

**Whiteboard Leader**

When Students are viewing the whiteboard, they cannot initially annotate the screen themselves. However, the Tutor can nominate a Student to be the ‘Whiteboard Leader’. This activates the annotation options at the selected machine. The Tutor can switch control to any of the other participants as required by selecting their icon in the Student list.

1. Select the required Student from the Student list.
2. Select the Whiteboard tab in the ribbon and click **Give Control**.
   
   Or
   
   Right-click on the required icon in the Student list and select **Give Control**.

3. The Student can now use the available tools to add content to the whiteboard.
**Note:** The **Whiteboard** icon in the Student list turns red to show that the Student is now in control. A flashing **Leader** icon is also displayed on their Whiteboard toolbar.

4. Control can be switched to another Student by simply selecting their icon in the Student list and repeating step 2.

**Note:** The whiteboard leader can send the current whiteboard image to their Journal by selecting `{Options}`-{Add to Journal} from the Whiteboard toolbar.
Annotating screens
The Show, Exhibit and View features provide a useful annotate tool that can be used to highlight areas of a Tutor or Student’s screen in order to emphasise a key learning point.

To annotate a Show screen
While the Tutor screen is being shown, the teacher may want to draw the student’s attention to a particular area. The Annotate tools can be used to highlight the relevant part of the screen.

1. While showing, right-click the Showing icon in the system tray and select Annotate Screen.
   Or
   Double click the Annotate icon.
2. The Annotate toolbar will appear.
3. Select the tool, colour etc and use the mouse to draw over the relevant part of the Tutor screen.

Note: If you do not want the Student’s to see the screen being annotated in real-time, click Suspend Show. This freezes the Show enabling the Tutor to continue working in the background. Click Suspend Show again to restart the Show, this refreshes the display at the Student screens.

To annotate a screen while viewing
While viewing, the Tutor can use the annotate tools to highlight a particular area of the Student screen. In Share and Watch mode, the Student can also use the Annotate toolbar options. The Tutor can still use the other View window options while annotating, Chat, File Transfer etc.

1. View the required Student.
2. Select the Tools tab in the View window ribbon and click Annotate.
3. The Annotate toolbar will appear.

To annotate a screen while exhibiting
The screen of a Student that is being exhibited can be annotated in order to draw the attention of the other Students to a particular learning point. Depending on the mode being used, both the Tutor and/or the exhibited Student can use the Annotate options.

1. Exhibit the required Student screen.
2. Select the Home tab in the Exhibit window ribbon and click **Annotate**.

3. The Annotate Toolbar will appear.

**Annotate toolbar**

The following options are available:

- **File**
  - Save Screen: Saves the annotated screen to a file.
  - Save Selection: When the ‘select region’ tool is active, you can highlight an area of the screen and save it to a file.
  - Exit: Ends annotate but stays in Show, Exhibit or View mode.

- **Edit**
  - Clear Annotations: Clears the annotations.
  - Undo: Undo the most recent annotation.
  - Redo: Redo an annotation that has been undone.

- **Tool**
  - Choose from a range of tools with which to annotate the screen. For example, freehand draw, draw arrow, select region.

- **Colour**
  - Sets the pen colour.

- **Width**
  - Sets the width of the line.

- **Font**
  - Sets the text font.

- **Suspend Show**
  - Suspends the Show (not available when viewing or exhibiting).

- **End Show**
  - Ends the Show and takes you back to Tutor Console. (Not available when viewing or exhibiting.)
Audio Monitoring

Audio Monitoring allows the Tutor to monitor audio activity on all Students’ machines. The Tutor is instantly alerted to any microphone or speaker/headphone activity at the Student and can select one of the displayed Student thumbnails to listen to the audio being played on that PC. Audio activity can also be recorded and played back to Students.

**Note:** If the Student toolbar is enabled, Students will be advised when their audio activity is being listened to or recorded.

1. **Select the Audio View 🎧 icon on the left-hand side of the Tutor Console.**
   
   Or
   
   **Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Audio View**.**

A thumbnail of each connected Student screen is displayed and the microphone or headphone icon will indicate that there is audio activity at the Student machine.

**Note:** Audio Monitoring can be set up at start-up. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Start Options - Restrictions**.
Listen to Student audio
1. Select the required Student in the List view.
2. Select the Class tab in the ribbon and click Listen.
   Or
   Right-click the Student and click Listen.
3. Details of the Student you are listening to and how long you have been listening is displayed on the status bar.
4. To stop listening, click Listen again.

Record audio activity
1. While listening to audio activity, select the Class tab in the ribbon and click Record.
2. A red flashing icon is displayed on the status bar to show you are recording the audio.
3. To stop recording and carry on listening to the audio, click Stop.

Note: Once you have stopped recording, an indicator on the Recordings icon in the ribbon shows that a recording has been saved. Click the Recordings icon to access the saved recordings.

Volume control
You can control the volume at both the Tutor and the Student.

1. Select the Class tab in the ribbon and click the Volume icon.
2. From here, you can adjust and mute the volume at the Tutor, adjust the volume for all Students, lock the volume at Students and set the maximum volume for Students (Students cannot increase their volume higher than this).

Or

1. While listening to audio, the volume sliders appear in the ribbon, allowing you to adjust the Tutor and Student volume.

Mute sound at the Student
Sound can be muted at all Student machines.

1. Select the required Student in the List view.
2. Select the Class tab in the ribbon and click Mute Sound.
3. An icon appears on the selected Student thumbnail(s), showing that the sound has been muted.
4. Click Unmute Sound to reinstate the sound.
**Notes:**
- By default, sound will be muted at Students when locking the mouse/keyboard or blanking screens. This option can be disabled in the Student User Interface Configuration settings.
- You can quickly mute all Student machines by clicking **Mute All** on the caption bar. If this is not displayed, you can add by clicking the **Configure Quick Access List** icon and selecting **Mute/Unmute audio at students**.

**Mute sound at the Tutor**
Sound can be muted at the Tutor machine.

1. Select the Class tab in the ribbon and click the **Volume** icon.
2. Click **Mute** next to the Your volume slider.

**Customise thumbnail size**
Student thumbnails can be resized to suit personal preferences. This is particularly useful when connected to large numbers of Student machines.

1. Use the slider on the status bar to select the required size.

**Auto-fit size of Student thumbnail**
This option will automatically adjust the size of the displayed thumbnails to fit the window.

1. Click **Auto** on the status bar.

**Notes:**
- You can send an audio announcement to Students’ headphones or speakers. Select the Class tab in the ribbon and click **Announce**.
- Recordings can be played back to Students using the Show function.
Using Audio support
NetSupport School allows you to use audible communications to connected Students, via microphones, headphones and speakers during View and Show. NetSupport School will only operate audio if the machines have audio support installed.

Notes:
- NetSupport School also allows you to monitor all Student audio activity, see Audio Monitoring for further information.
- You can quickly mute all Student machines by clicking Mute All on the caption bar. If this is not displayed, you can add by clicking the Configure Quick Access List icon and selecting Mute/Unmute audio at students.

The Announce function
This feature sends the audio announcement to all the selected students headphones or speakers. They will be able to hear the Tutor but will not be able to speak back.

To make an announcement
1. Select the Class tab in the ribbon and click Announce.
2. The Announce dialog box appears. Include or exclude Students from the announcement and click Announce.
3. A dialog appears, indicating that you can now announce. Click OK when you have finished speaking.
Using audio while viewing
When viewing a Student, you can conduct an audible chat session.

To use audio while viewing
1. The audio options are displayed in the Audio tab of the View window ribbon. From here, you can:
   • Turn audio on or off
   • Enable only the Tutor or the Student to talk
   • Listen to the Student.

Note: Click Settings 🎧 to access the Audio settings. From here, you can also set the microphone sensitivity and select the audio quality.

Using audio while showing
When showing to a Student, you can conduct a two-way audible chat session.

To use audio while showing
1. Select the Class tab in the ribbon, click the Show icon and select the Enable audio during show option.
2. During the show only the Tutor has announce functionality. If you are only showing to one Student, both the Tutor and Student can speak. If you are showing to many, only the Tutor can speak (announce).

The audio settings set in the Tutor Configurator Audio option will apply during these sessions.
**Adjusting audio settings**
You can adjust the audio settings within NetSupport School to match the capabilities of your multimedia machines or to fine tune performance. However, you should note that the higher the quality of sound you select, the greater the volume of data that needs to be sent. This can affect screen update performance on slower machines.

**To access the volume controls**
1. Right click the **Speaker** icon in the taskbar.

To change other options such as sound quality, do one of the following:

**Global Method (changes default setting for all Students)**
1. Click **Options** in the Tutor Console and select **Settings** from the drop-down menu.
2. Select **Remote Control - Audio**.

**Individual Student method (while viewing)**
1. Go to the Audio tab in the View window ribbon and click **Audio Settings**.

In both cases, the Audio settings are displayed and you can set the following properties:

**Volume Settings Adjustments**
- **Threshold**  Microphone sensitivity.
- **Microphone**  Volume of microphone.
- **Speaker**  Volume of speakers.
- **Test**  Tests all of the above settings (this is only available when applying settings to all Student sessions).

**Enable Options**
- **On**  Turn audio on.
- **Off**  Turn audio off.
- **Talk only**  Set the Tutor audio to talk function only.
- **Listen only**  Set the Tutor audio to listen function only.

Selecting **Change Transmission Format** allows you to change the transmission format. Use only the level you need for acceptable quality. High-quality settings can affect screen update performance.
**NetSupport School Video Player**

NetSupport School provides exceptional multimedia support with full audio, video and remote control capabilities.

While the Video Player can be used to run a video file on the local machine, NetSupport School’s remote control capabilities combined with full audio support enable you to use this tool to enhance training sessions and demonstrations across multiple PCs simultaneously.

All standard video files, for example, .avi and .mpg, are supported. The Video Player runs locally on each Student machine and the video file can be accessed locally or from a network drive. If video files are stored locally the impact on the network is minimised as only the data to control the player, e.g. start, stop, pause and synchronisation packets, are sent. If each Student machine retrieves the video file from a network drive, you will place additional demands on the network.

For optimum performance, store the video files locally on each machine, you may wish to use File Distribution to do this.

**Other influencing factors will be:**

- The number of Student machines accessing the file.
- The speed of the network, e.g.: 10/100 MB.
- The size of the video file.
- Student machine memory/performance specification.
- Other traffic on the network.

**Notes:**

- If the video file to be played does not exist on the Student machine NetSupport School will automatically send it to the Student.
- If a Student machine is required to retrieve files from a Server, for smooth operation, ensure that the Student machine has sufficient access rights to the relevant drive and files.
- The quality of the display will be affected by the video adapter of the machine and how the screen resolution is configured.
Play a video file on a machine

1. Select the Class tab in the ribbon, click the Show icon and choose Show Video.
2. The Show Video dialog will appear.

![NetSupport School - Show Video dialog](image)

In the Video File field enter the location and name of the required video, you can select the Open icon to browse for the file.

3. Click Show.

A check will be made to ensure that the video file is available at the Student. If not, the video file will be automatically copied to the Student machine.

4. When the video file is launched, the Video Player Control Panel appears. Standard operations are available, play, stop, pause etc.

**Note:** While the video is running, the Student machines are locked.
NetSupport School Video Player Control Panel

The Video Player Control Panel operates in a similar manner to all audio and visual aids. Although the commands on the toolbar perform the same actions as would be expected please find a detailed explanation below.

File Menu - The File drop-down menu contains the following options:
Open
Allows you to select and load the appropriate video file.

Close
Closes the open video file.

Exit
Shuts down the Video Player.

View Menu - The View drop-down menu contains the following options:
Toolbar
Hides and displays the Video Player toolbar.

Status Bar
Hides and displays the Status bar of the Video Player.

Zoom
Resizes the video screen.

Play Menu - The Play drop-down menu contains the following options:
Play
Starts the loaded video file.

Stop
Returns to the beginning of the loaded video file.

Pause
Blanks the Students video screen and pauses the video file at the Tutor machine.
Repeat
The video file will be repeated until the Tutor stops this.

Start
Returns to the beginning of the video file.

End
Fast forwards to the end of the video file.

Mute Clients
If students are not using headphones while they are watching a video, the sound coming from each machine can be distracting. This option turns audio off at the Student machines but leaves it on at the Tutor machine.

Help Menu - Provides access to the on-line help and general version information.
Using replay files

When a Tutor remote controls a Student machine, they can record the screen, keyboard and mouse activity taking place. In addition, if the PCs are configured for audio, any narration that takes place can also be recorded.

The information is stored in a file that can be replayed at the Tutor machine and, if required, shown to other Students.

The Replay facility can be configured to record at all or individual Student machines. Local activity at the Tutor machine can also be recorded.

Once enabled, activity is recorded as soon as a View session is opened. Recording stops when the View session is closed, at which point the stored Replay File becomes available for playback.

A Show session can also be recorded, enabling Students to playback the demonstration at their convenience.

By default, a Replay File is saved as a .rpf file, these can be converted to AVI or WMV video files. Pre-set options will be provided for converting Replay Files to video files. More advanced users can access the Replay conversion utility where you can control video resolution, audio quality, start and end points of the video and much more. To launch the Replay Conversion utility, select {Start}{Programs}{NetSupport School}{NetSupport School Replay}. On Windows 8 machines right-click in the Start screen and choose All Apps at the bottom of the screen. Click the NetSupport School Replay icon.

**Note:** Replay Files store screen images and can, therefore, become very large. Good housekeeping plays a vital role in maintaining files of this nature. It is recommended that old files are deleted on a regular basis.
Record replay files for all Students

This procedure enables the Tutor to create a replay file at any Student machine that it remote controls.

1. Click **Options** in the Tutor Console, select **Settings** from the drop-down menu and choose **Replay Files**.
2. Enable the **Record Replay Files** checkbox. A replay file will be created each time the Tutor opens a view session at any Student machine.
3. **Include Audio**
   In addition to the screen, mouse and keyboard activity, if the machine is configured for audio, you can record any microphone narration from the Tutor. Check this option to enable.
   
   **Note**: Desktop sounds, music, etc, are unable to be recorded.

4. **Prefix Files with Client name**
   In order to identify each replay file, file names are prefixed with the Student name and the date/time of the recording. Alternatively, by unchecking this box, the files will be named sequentially in the format 00000001.rpf etc.

5. **In Directory**
   Specify where the replay files are to be stored.

6. Click **OK**.
Record replay files for individual Students
This procedure enables replay files to be created at selected Student machines.

1. View the required Student machine.
2. Click the Settings icon in the caption bar and select Replay Files.

3. Enable the Record Replay Files checkbox. A replay file will be created each time the Tutor opens a view session at this Student machine.

4. Include Audio
In addition to the screen, mouse and keyboard activity, if the machine is configured for audio, you can record any microphone narration from the Tutor. Check this box to enable.

   Note: Desktop sounds, music, etc, are unable to be recorded.

5. Prefix Files with Client name
In order to identify each replay file, file names are prefixed with the Student name and the date/time of the recording. Alternatively, by unchecking this box, the files will be named sequentially in the format 00000001.rpf etc.
6. **In Directory**
   Specify where the replay files are to be stored. A separate folder can be specified for each Student.

7. Click **OK**. Recording will start immediately, close the View session to stop recording.

8. Repeat steps 1-7 for any other Student machines.

**Record replay files at the Tutor**
Activity at the local machine can be recorded and shown to Students.

1. Select the Administer tab in the ribbon and click **Replay Files**.
   Or
   Select the Class tab in the ribbon, click the **Show** icon and choose **Replay Files**.

2. The Replay Files dialog will appear. Existing replay files will be listed.

3. Click **Change** to specify where you want the replay files stored.

4. Click **Create Replay** to start recording.

5. A dialog will appear, you can choose ‘include audio’ if the machine is configured for audio. Click **OK**.

6. The **Recording** icon appears in the system tray (double-click this to stop recording).
By default, file names will be prefixed with ‘Local’ and the date and time of the recording. You can rename the file by overtyping the default name. The replay file will appear in the list.

**Watching replay files**

Stored replay files can be watched by Tutors and, if required, shown to Students.

At a local level, the NetSupport School Student program also provides a Replay option enabling Students to launch files.

**At the Tutor**

1. Select the Administer tab in the ribbon and click **Replay Files**.
   Or
   Select the Class tab in the ribbon, click the **Show** icon and choose **Replay Files**.
2. The Replay Files dialog will appear. Existing replay files will be listed.
3. Select the required Replay File and click **Play Replay File**.
4. The Replay window will open and start playing the file.

5. Use the replay controls in the ribbon to start/stop the file.
At the Student
1. Right-click the NetSupport School Student icon in the system tray and choose **Replay**.
   Or
   Double-click the Student icon and choose {Commands}→{Replay} from the drop-down menu.
2. Navigate to the folder where the replay files are stored.
3. Select the file to replay.
4. Click **Open**. The Replay window will appear. Use the replay controls to start/stop the file.

Replay window - Control Panel
When viewing a replay file in full screen mode a control panel is displayed, this provides the controls for playing the recorded information. The control panel contains a replay time index that indicates where in the replay file you currently are and displays information about the file being played.

![Replay Controls](image)

The individual sub-menus and available functions are:

**Stop and play**
The **Stop** button is shown when you are playing a replay file and the **Play** button when the file is stopped. Only one of these buttons is displayed at a time. The file is played until the end is reached or the pause marker is encountered.

**Rewind**
Start playing the file from the beginning if it is already playing otherwise moves the replay index to the beginning of the file.
**Skip to previous marker**
Moves the replay index to the previous activity marker or to the beginning of the file if there isn’t one. These markers are added at points when lots of activity was recorded at the Student.

**Frame advance**
Advance the replay index to the next frame. Press and hold this button to fast-forward through the replay file.

**Skip to next marker**
Moves the replay index to the next activity marker or to the end of the file if there isn’t one.

**Mute**
Turn audio on/off within the replay file.

**Other information**
The current time index is displayed to the right of these controls in the hh:mm:ss.ms format. The name of the Student that the replay was recorded on, the date and time are displayed at the bottom of the window.

**Replay marker**
This marker can be positioned anywhere within the time frame of the replay file. The marker is the small black triangle beneath the time index control. Click and drag this to the position where you want the file to stop playing. When the marker is encountered the replay stops, and you can then press play to continue past it.
Showing replay files to Students
Using NetSupport School’s Show feature, a Tutor can show a stored replay file to any number of connected Students.

1. Select the Class tab in the ribbon, click the Show icon and choose **Show Replay**.
   Or
   Select the Administer tab in the ribbon, click **Replay Files**, select the required replay file and click **Show Replay**.

2. The Show Replay dialog will appear.

3. Browse for and select the required Replay File.

4. Click **Show**.

5. The Replay window will open at the Tutor machine and start playing the replay file to the selected Students.

6. On the caption bar, click the **Close** icon to end showing the replay file.
Converting replay files to video files
NetSupport School replay files can be converted to video files allowing them to be played outside of NetSupport School on a range of media players. Replay files can be converted to WMV and AVI formats.

Converting a replay file
1. Select the Administer tab in the ribbon and click Replay Files.
   Or
   Select the Class tab in the ribbon, click the Show icon and choose Replay Files.
2. The Replay Files dialog will open.
3. Select the replay file to convert and click Convert File.
4. The wizard will guide you through the conversion process.

Using the Replay Conversion utility
For more advanced options when converting replay files, a Replay Conversion utility is provided allowing you to control video resolution, audio quality, start and end points of the video and much more.

Note: The Replay Conversion utility is installed by default when installing the NetSupport School Tutor or Tech Console. You can also install the utility as a standalone component.

1. Select {Start}\{Programs}\{NetSupport School}\{NetSupport School Replay Conversion Utility}.
   
   Note: On Windows 8 machines right-click in the Start screen and choose All Apps at the bottom of the screen. Click the NetSupport School Replay Conversion Utility icon.
2. The Replay Conversion utility will open.
3. Browse for the required replay file and set the required properties.
4. Click Start Encoding.
Show Application

The Show feature enables you to display the Tutor screen to Students. However, if a number of programs are open at the Tutor, there may be occasions when you want to show a single application in isolation.

To show an application
1. Select the Class tab in the ribbon and click the Show icon.
2. Show options can be set by clicking the relevant option in the Show menu. To set further Show properties, click the More icon.
3. Click Show Application.
4. The Show Application dialog will appear.

```
5. Drag the icon to the required application on the Tutor’s desktop and release. (A pink border will appear around the selected application as you move the mouse around the desktop)
   Or
   Click Select and choose the application from the displayed list.
6. Click Show.
```
Chatting to Students

NetSupport School allows you to Chat to any number of connected Students simultaneously, via a scrolling text window.

**Note:** A history of all chat sessions can be saved to a .txt file. You can enable this in the Tutor Chat settings.

To Chat to Students

1. Select the Students or group of Students you want to Chat to in the List view. If you do not select a Student icon, all connected Students will be included.
2. Select the Class tab in the ribbon and click Chat.
   Or
   Right-click an individual Student and choose Chat.
3. The Create Discussion dialog appears.

![Create Discussion dialog](image)

The Chat Properties dialog has the following options:

**Topic**
If required, enter a title or description for the subject to be discussed in the Chat session. This will appear in the Title bar of the Chat window that is displayed at the Student machines. If left blank, the Tutor name will appear.
**Members**
Shows the Students included in the Chat session.

**Options**

**Members can decline to join**
If checked, a message will appear at the Students machine, inviting them to join the Chat session. They can choose to join or decline.

**Members can’t leave the chat**
If checked, the option for Students to leave the Chat session will be removed.

**Chat Window is always visible**
If checked, the Chat window remains on the Students’ desktop for the duration of the Chat session. Members cannot minimise the window.

**Add to Journal**
Adds the contents of the Chat session to the Student Journal.

Select the properties that will apply to the Chat session. Click **OK** to start the Chat session.

4. The Chat window will appear at the Tutor and Student machines.
The Chat window
This window is displayed at each participating member’s machine and lists the progress of the Chat session. Only the Tutor or Group Leader can add or remove Students from the session.

Unless the option is disabled in the Chat Properties dialog, Students can choose to leave the session.

The following options are available from the Chat Window:-

Chat Menu
The content of a Chat session can be stored for future reference.
Choose **Save As** to create a file containing the text or choose **Copy** to be able to paste the Chat content into another application or file.

Each message is restricted to 128 characters. Check **Auto Send long message** to automatically send the message when the limit is reached.

You can add the content of the Chat session to the Student Journal by selecting **Add to Journal**.

Window Menu
Only the Tutor’s Chat window will have a window drop-down menu. This menu enables you to swap between opened screens or tile them.

Chat Progress
The main body of the Chat window is used to record the progress of a Chat session. It holds details of members who have joined or left the discussion, as well as the messages that have been sent by each member.

Send Message
This is where you type your comments. Type the message and press Enter or click **Send**. Each message is restricted to 128 characters. You can automatically send the message when the limit is reached, select {Chat}-{Auto Send long Message} from the Chat window drop-down menu.

**Note:** Emoticons can be included within the message.

Close
Ends the Chat session.
Members
Members currently included in the Chat session are listed here. The Tutor can add or remove Students from the Chat session as required. Unless disabled, Students have the option to leave the session of their own accord.

Invite
To add Students when the Chat session is in progress, click Invite. The Add Members dialog will appear, select the required Students and click Add. You can send a copy of the Chat progress to new members by checking the Send discussion history box.

Note: Students that have been removed or have decided to leave the Chat session can be invited back.

Eject
To remove Students from the Chat session, select the Student in the Members list and click Eject. Ejected Students can be invited back into the session if required.

Notes:
- Students can also initiate Chat sessions by opening the Student main window (click the Student icon in the system tray) and choosing {Commands}{Chat} or by clicking the Chat icon on the Student Toolbar.
- By default, the Student can only chat to the Tutor. However, you can enable Students to chat with each other by selecting the Student to Student Chat option in the Student User Interface settings.

Chat to a Student whilst viewing
1. Select the Tools tab in the View window ribbon and click Chat.
2. The Chat window will appear on the Tutor and Student machine.

To end a chat
1. Click Close in the Chat window.
   Or
   Select {Chat}-{Close} from the Chat window drop-down menu.
Sending a message to Students

With NetSupport School, you can send a message to all connected Students or the currently selected Students. If you send the same message on a regular basis, you can store up to five pre-defined messages.

To enter and send a new message

1. Select the Students you want to send the message to.
2. Select the Class tab in the ribbon and click Message.
   Or
   Right-click and choose Message.
   Or
   To send a message to a group, select the Group tab in the ribbon or click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click Message.
3. The Send Message dialog will appear. Choose whether to send the message to all connected Students, the currently selected Students or group. Enter the message (any URLs entered are clickable at the Student), you can choose an icon to be displayed alongside the message from the drop-down list and decide whether to show it at Student machines for a specified time. You can further highlight the message by playing a sound at the Student's machine. Click the Play a sound icon.
   Note: If the Student Journal has been started, you will have the option to add the message to this.
4. Click Send. The message will be displayed in a dialog at the Student screens and will remain until the user closes the dialog or the specified time limit expires.
To send a quick message
1. Select the Class tab in the ribbon and click the Message icon drop-down arrow.
2. Enter the message in the Quick Message field and click the Message icon.
3. The message will be sent to all connected Students.

Creating preset messages
You can store up to five commonly used text messages that can be quickly broadcast to Students using the Message feature.

1. Select the Class tab in the ribbon, click the Message drop-down arrow and select Preset Messages. Or Right click a Student icon, click the Message drop-down arrow and select Preset Messages.

2. Enter the required text message.
3. Set any additional properties for the message.
   - Choose an icon to be displayed alongside the message. This can be used to quickly identify the type of message, information, question, warning or stop.
   - Indicate how long the message should remain on the Student's screen.
• You can further highlight the message by playing a sound at the Student's machine. Click the Play a sound icon.

4. To add a new message, click the Add a new message icon.
Use the arrows to arrange the order of messages in the list. Click the Remove this message icon to delete a message.

5. Click OK.

6. The message will show in the Message icon drop-down list in the ribbon, allowing you to quickly send this to Students.

**To send a pre-defined message**

1. Select the required Student icons.

2. Select the Class tab in the ribbon and click the Message icon drop-down arrow.
   Or
   Right-click and select the Message icon drop-down arrow.
   Or
   To send a pre-defined message to a group, select the Group tab in the ribbon or click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click the Message drop-down arrow.

3. Each of the pre-defined messages will be displayed, click the required item to send the message to Students.
   Or
   To create a new message, select Preset Messages.
Help requests

NetSupport School allows a Student to request help from a Tutor. They do this either by selecting the Request Help command from the Student menu (assuming that it has not been configured for quiet mode, which hides the Student icon) or by pressing the hotkeys set in the Student Configurator.

Note: If the Student Toolbar is enabled, Students can request help by clicking on the Help request icon.

To request help

1. Click the Help Request icon in the Student toolbar.
   Or
   Press the hotkeys, usually ALT+LSHIFT+RSHIFT.
   Or
   Right click the Student icon in the taskbar and select {Request Help}.
2. This opens a dialog box into which they type the message.

![Message dialog box]

3. Click OK.
4. The help request will then be sent to the connected Tutor.

Note: Students can send an alert to the Tutor when work is complete, they need help or they need urgent help. They do this by clicking the Help Request icon in the Student toolbar, selecting an option from the Alert Teacher drop-down list and clicking OK. The Student toolbar will change colour depending on the alert selected. The Student icon at the Tutor will change colour to notify the Tutor what alert has been raised; green for work is complete, amber for help needed and red for urgent help needed.
The Tutor can request support directly from a technician. A **Support** icon can be displayed in the Tutor Console caption bar, allowing the Tutor to chat or send a message directly to the technician. This feature will need to be enabled in the Tech Console.

If a Student raises a help request an alert will be raised at the Tutor, provided it currently has that Student connected. Any outstanding help requests will be visible to the Tutor with a Help Request icon displayed next to the Student and a badge indicating the number of outstanding help requests on the ribbon. This will show until that help request has been cleared.

**To display current help requests**

1. Select the Class tab in the ribbon and click **Help Requests**.
2. The Help Request window will open and list the requests.

If there are any help requests pending since the last time the Tutor connected to the Student, the Help Request window will open as the Tutor initialises.
3. By clicking on the **View Client** or **Chat** toolbar buttons, you can reply to the Student’s help request.

**Note:** If a Student has raised an alert at the Tutor, the Student icon at the Tutor will change colour to notify the Tutor what alert has been raised; green for work is complete, amber for help needed and red for urgent help needed. You can switch these alerts off in the Tutor configuration.

4. Once the help request has been dealt with, click the required Student's request in the Help Requests window and click **Clear** or right-click the required Student icon and click **Clear**. To clear all help requests, click **Clear All** in the Help Requests window. A Student can also clear previous help requests from the Request Help dialog.
Transferring files
NetSupport School includes sophisticated File Transfer functionality that enables you to transfer files to and from the Tutor and Student.

File Transfer functionality can be configured by clicking **Options** in the Tutor Console, selecting **Settings** from the drop-down menu and choosing **File Transfer**.

**Note:** While viewing a Student, you can drag and drop files from the Tutor Windows Explorer directly to the Student's desktop.

To transfer files and folders between a Tutor and a Student
1. Select the required Student in the List view.
2. Select the Class tab in the ribbon and click **File Transfer**. Or
   Right-click the Student and choose **File Transfer**. Or
   If you are viewing the Student, select the Tools tab in the View window and click the **File Transfer** icon.
3. The File Transfer window to that Student opens.
4. From the local or remote pane, select the destination drive or folder into which the items will be copied.

**Note:** The path to any open folders (Explorer windows) on the Student desktop is displayed at the top of the remote pane to enable quick selection.
5. From the local or remote List view, select the item(s) to be copied to the Student. To select all files, click the Files icon on the ribbon. To select all folders, click the Folders icon. If you want to transfer all files and folders, click the All icon.

**Note:** NetSupport School provides a list of files the Tutor has recently worked with that can be sent to a Student. Click Recent Files (the last 20 files are displayed) and select a file from the list. The file will be copied to the current folder at the Student.

6. Click Copy File.

**Note:** The selected item(s) can also be ‘dragged’ from the List view and ‘dropped’ into the destination drive or folder.

7. A confirmation dialog will be displayed. Click Yes.

8. A Copy Progress dialog will be displayed, showing the progress of the File Transfer. You can choose to ignore error messages and overwrite prompts until the operation is completed. These will then be displayed in a summary window at the end of the operation.

**Note:** When a file is transferred to Android Students, it will be copied across to the File Explorer for the Students to access.

---

**To transfer files between Students**

It is also possible to copy files and folders between two Students.

1. Display the File Transfer window for each Student.
2. Arrange the File Transfer windows so you can see both Students and simply drag file/folders from one to the other.

**Note:** You can see more of a Student's files and folders by clicking Window □, located above the remote pane.
Managing files and folders
You can easily manage the file and folders you wish to work with during a File Transfer operation.

To create folders
New folders can be created at the Tutor or the Student.

1. Select the local or remote Tree view.
2. Select the drive or folder in which the folder you want to create will appear.
3. Click the Create Folder icon on the ribbon.
4. The Create Folder dialog will be displayed.
5. Enter a name for the folder and click OK.

Add a folder to Favourites
Folders that need to be accessed regularly can be added to the Favourites folder in the Tree view.

1. Select the required folder in the local or remote pane.
2. Click the Add icon on the ribbon.
3. The folder will appear under Favourites in the Tree view.

To rename a file
1. Select either the local or remote pane List view.
2. Select the file to be renamed.
3. Click the Rename File icon on the ribbon or press F2.
4. Enter the new name for the file.
5. Press Enter.

Changing file attributes
You may want to change the attributes of a file, for example, to read-only.

1. Select the file whose attributes you want to view or change.
2. Click the Properties icon on the ribbon.
   Or
   Right-click and choose Properties.
   Or
   Select the tab displaying the file name in the ribbon and click Modify.
4. Check or clear the attributes you wish to set.
**Editing a remote file**
You can edit a file on the Student machine at the Tutor machine and send the updated version back to the Student.

1. Double-click the required file in the remote pane.  
   Or 
   Select the required file in the remote pane. Click the **Open Item** icon on the ribbon to open the file using the default application, or click the drop-down arrow to select an application to open the file with.
2. A dialog will appear asking you to confirm that you wish to upload the file and open it. Click **Open**.
3. Make the relevant changes to the file and save and close it.
4. A prompt will appear. Click **Yes** to send the updated file to the Student. You can change the name of the file by entering a new name in the **Save As** field. If you click **No**, the file won't be copied to the Student and any changes you made will be lost.

   **Note:** You will be advised if the file has changed while you were editing it. You can choose to save your copy of the file with a different name, overwrite the remote file at the Student or cancel and lose any changes you made.

**Note:** You can quickly edit a file using NetSupport School's internal text editor by right-clicking the required file and selecting **Quick Edit**.

**Deleting files and folders**
You can delete files and folders from either a Tutor or Student machine.

**To delete a file**
1. Select the file you wish to delete.
2. Click the **Delete File** icon on the ribbon.
3. A confirmation dialog will be displayed. Click **Yes**.

**To delete a folder**
1. Select the folder you wish to delete.
2. Click the **Delete Folder** icon on the ribbon.
3. The Remove Folder dialog will be displayed.
4. Select the **Include Contents** checkbox.
5. Click **Yes**.

**Notes:**
- You cannot remove more than one folder at a time. If you have several folders selected in the List view when performing the delete operation, only the last selected folder will be removed.
By default, all files deleted from the local pane will be sent to the Recycle bin. This can be changed in the File Transfer settings.

Synchronising folders
You can synchronise the contents of selected folders on the Tutor and Student. When you synchronise two folders, any new or updated files in either folder will be automatically copied to the other folder.

To synchronise folders
1. Select the folder from the local pane Tree view to be synchronised with the Student.
2. Select the folder from the remote pane Tree view to be synchronised with the Tutor.
3. Click the Synchronise Folders icon on the ribbon.
4. The Synchronise Folders dialog appears.
5. Check the displayed paths of the two selected folders.
6. Choose to include the subdirectories by selecting the Include Subfolders.
7. To automatically overwrite newer versions of existing files, select Overwrite All.
8. Click OK.
9. Click Yes to confirm.
10. The Folder Synchronisation progress dialog appears.
11. When completed, the result will be displayed in the Folder Synchronisation Results dialog.
12. Click OK.
Distributing files

As well as enabling you to transfer files to and from individual Students, NetSupport School also allows you to distribute files to multiple Students simultaneously.

**Note:** To improve performance when distributing files, NetSupport School's Broadcast File Distribution facility is enabled by default. This results in the files being sent to all machines simultaneously, thus improving the speed of transfer. If this feature is turned off, the files are sent to each Student machine in turn.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will generate additional broadcast packets on your network. It is recommended that you consult your network administrator before using this feature.

File Distribution can be sent to Students using multicast. The broadcast will only be sent to machines included in the specified IP multicast address.

**To distribute files to Students**

1. Select the Group tab in the ribbon and click **File Distribution**.

   **Note:** To distribute files to a group, select the required group from the group bar.

2. The File Distribution window will appear.
3. In the remote pane, indicate which Students you wish to copy files to (remove the checkmark next to the Student to exclude them).

4. From the local pane, select the item(s) to be copied to the Students. To select all files, click the **Files** icon on the ribbon. To select all folders, click the **Folders** icon. If you want to transfer all files and folders, click the **All** icon.

   **Note:** NetSupport School provides a list of files that the Tutor has recently worked with which can be sent to a Student. Click **Recent Files** (the last 20 files are displayed) and select a file from the list. The file will be copied to the current folder at the Student.

5. The location on the Student machines where the files/folders are copied to is called the destination folder. Unless otherwise specified, the Student destination folder will be the same as the item(s) location on the Tutor machine. If the Student does not have the same folder available, the item(s) will be copied to the C Drive by default and the folders automatically created.

   Or

   To set a specific destination folder on the Student machine, right-click the Student icon in the remote pane and choose **Set Destination**. Specify a destination and click **OK**.

   **Note:** To set the destination folder for all Students, click the **Set Destination** icon on the ribbon. You can lock the destination folder at Students by clicking **Lock Folder**.

6. Click **Copy File**.
7. A confirmation dialog is displayed. Click **Yes**.
8. A Copy Progress dialog will be displayed, showing the progress of the transfer. You can choose to ignore error messages and overwrite prompts until the operation is completed.

   **Note:** When a file is distributed to Android Students, it will be copied across to the File Explorer for the Students to access.
Sending and collecting work
The Send/Collect Work feature enables you to send a document or a number of documents to individual or multiple Student machines. You can then collect Students’ responses on your machine.

To send work
Two methods are available for sending pre-prepared work files to Student machines:

- **Quick Send** is useful for one-off operations where you want to send work to all connected Students or a defined group of Students.
- **Advanced Send** enables you to store the properties of an operation that will be performed regularly and provides greater flexibility as to which Students the work is sent to.

To send work using quick send
1. Decide which Students to send work to, all or a defined group. You cannot select individual Students using Quick Send.
2. Select the Work Planner tab in the ribbon and click **Send Work**.
3. The Quick Send dialog will appear.

![Quick Send dialog]

4. List the file(s) or specify a folder to send to the Students. Files should include a full path and optionally a wildcard specification. You can include multiple specifications by separating them with ‘;’
   Or
   Click the **Browse** button to locate the file(s).
Or
Enter the path for the file or folder in the edit box and click **Add**.

5. If you are sending a folder to Students, you can also send any subfolders. Click **Include subfolders**.

6. Specify the folder at the Student machine to copy the files to. You can choose **Desktop** or **Documents** from the drop-down list. A new folder will be created if necessary.

7. Click **Send**.

8. The result of the operation will be displayed for you to check that the work has been sent successfully.

9. Click **OK**.

**To send work using advanced send**

1. Select the Work Planner tab in the ribbon and click **Send/Collect Work**.

2. The Send/Collect Work wizard will open.

3. Existing send/collect work operations are listed.

4. To add a new operation, click **New**. The Send/Collect Work wizard appears. Follow the instructions in the wizard.

5. Select an operation from the list and click **Send Work**.

6. The Select Students dialog will appear.

7. You can send work to all Students or click **These Clients** to select the required Students (remove the check mark next to the Student icon to remove them).

8. Click **OK**.

9. The result of the operation will be displayed for you to check that the work has been sent successfully.

10. Click **OK**.
Once work has been sent to the Students, a Send work status pane appears in the ribbon showing the current status. You can show Students who have completed their work or those with items remaining by clicking the appropriate option. The overall progress allows you to keep track of how many Students have completed the work.

The Students can open work items from the Student Toolbar and click when a work item is complete. This updates the status in the Send work status pane.

**To collect work**
Two methods are available for retrieving completed work files from Student machines:

- **Quick Collect** remembers the last file(s) sent via quick send and provides a quick and easy method for retrieving the work back at the end of a session.
- **Advanced Collect** lets you select the file(s) to retrieve from a list of pre-defined send/collect operations and provides greater flexibility as to which Students the work is collected from.

**To collect work using quick collect**
1. Select the Work Planner tab in the ribbon and click **Collect Work**.
2. The Quick Collect dialog appears.
3. Specify the name of the file(s) to collect, e.g. `.*` or `Test1.TXT;Test2.TXT`

4. Specify the folder that the file(s) are stored in, e.g. C:\TEMP, and whether you want to remove the file from the Student machine after it has been collected.

   **Note:** The **Collect files** and **Collect from folder at Student** fields are pre-populated with the last files sent using quick send.

5. Specify the folder on the Tutor machine to collect the file(s) in. You can choose Desktop or Documents from the drop-down list or click **Browse** to specify a different folder.

6. Click **Collect**.

7. The result of the operation will be displayed for you to check that the work has been collected successfully.

8. Click **OK**.

**To collect work using advanced collect**

1. Select the Work Planner tab in the ribbon and click **Send/Collect Work**.

2. The Send/Collect Work dialog appears.

3. Select the required operation from the list and click **Collect Work**.

4. The Select Students dialog will appear. Select the Students that you want to retrieve the file(s) from.

5. Click **OK**.
6. The result of the operation will be displayed for you to check that the work has been collected successfully.
7. Click OK.

**To change the properties of an operation**
1. Select the Work Planner tab in the ribbon and click **Send/Collect Work**.
2. The Send/Collect Work wizard appears.
3. Select an operation from the list and click **Properties**.
4. The Properties dialog will appear.
5. Adjust as necessary.
6. Click **OK**.
Remotely launching applications and websites at Students

This feature allows you to launch (execute) applications and websites on an individual Student machine or a group of Student machines without the need to remote control them. For example, after showing Students how to use an application, you might want to launch it on their machines.

**Note:** Applications must be installed on, or available to, the Student machines.

Launch an application or website at a Student from the Tutor Console

1. Select the required Student.
2. Select the Class tab in the ribbon and click **Quick Launch**.
3. The Quick Launch pane appears.

4. Click **Add Application** or **Add URL**.
5. If adding an application, enter the name and path of the application to launch at the Student.
   Or
   Click the **Browse** button and select an executable application on the Tutor machine.
**Notes:**
- When adding applications on Windows machines that have the Microsoft Store, two tabs will be displayed in the Application Properties dialog. The 'Desktop Application' tab allows you to add standard Windows applications as detailed above. The 'Windows Store Application' tab lists Windows applications.
- Check that Student applications are stored in the same location as the Tutor to ensure successful execution.
- If you want to launch a specific file with the application, you must separate the two instructions with quotes. For example, "C:\Program Files\Microsoft Office\Excel.exe" "C:\My Documents\Accounts.xls".

6. Click **OK**.
7. If adding a website, enter the URL and click **OK**.
8. The application or website icon is displayed in the Quick Launch pane and saved for future use.

**Notes:**
- If you only want to launch applications or websites to Students who are logged on, select the **Logged in** option.
- You can choose to display just applications or websites by clicking the **Show Applications** or **Show URLs** option.

9. Select the required application or website and click **Send to Students**.

**Launch an application at a Student from the Tech Console**
1. Select the required Student.
2. Select the Home tab in the ribbon and click **Launch Application**.
   Or
   Right-click the Student and choose **Launch Application**.
3. The Execute Application at Client dialog appears.
4. Select the Execute tab.
5. Enter the name and path of the application to launch at the Student.
   Or
   Click **Local Browse** to browse for the application on the Tech Console machine.

**Note:** Check that Student applications are stored in the same location to ensure successful execution.

6. Select **Add to List** to save the application for future use in the Saved List tab. Confirm the description and path.

**Note:** The application is added to the Launch Application drop-down list in the ribbon.
7. If you only want to launch the application to Students that are logged on, select **Execute only if the Client is logged on**.
8. If you don't want to view the result of the operation, click **No result required**.
9. Click **Execute**.
10. The application will now be launched at the selected Student and if applicable, the result of the operation is displayed in the Results pane.

Or

1. If you have saved a list of applications, you can select the required application from the **Launch Application** drop-down list.
2. Click **Client must be logged on** to launch the application at Students that are logged on and if you don't want to see the results of the operation, click **No result required**.
3. The application will be launched at the Student and the Execute Application at Client dialog appears, displaying any results.

**Note:** You can quickly add applications to the saved list by clicking the **Launch Application** icon in the ribbon and selecting **Add Application** from the drop-down menu.

**To launch an application on a group of Students**
1. Click the drop-down icon on the required group tab (mouse over the right-hand side of the group tab to display this) and click **Quick Launch**.
2. The Launch Application dialog appears.
3. Click **Add**.
4. Enter the name and path of the application to launch at the Students. Or
   - Click **Browse** and select an executable application on the Tutor machine.

**Note:** Check that Student applications are stored in the same location as the Tutor to ensure successful execution.

5. Click **OK**.
6. The application icon will be displayed in the Launch Application dialog and saved for future use.

**Note:** If you only want to execute applications to Students that are logged on select the option **Execute Only if the Client is Logged on**.

7. Select the required application and click **Launch**.
Launch an application on a Student machine whilst viewing
A list of applications can be saved in the View window, allowing you to quickly launch these at a Student.

1. Select the Home tab in the View window ribbon.
2. Click Add.
3. Enter the name and path of the application.
   Or
   Click the Folder icon to browse for the application on the Tutor machine.
4. Click OK.
5. The application will be listed in the Quick Launch pane.
   
   **Note**: Click Manage to edit or remove a listed application.

6. You can now launch the application at the Student. Select the application in the list and click Launch or double-click the application.
7. The application will run at the Student.

   **Note**: You can also remotely launch an application that has been saved in the Quick Launch pane in the Tutor Console. Select Launch Application, select the required application (or click Add to add a new one) and click Launch.

To edit a saved application or website
1. Select the Class tab in the ribbon and click Quick Launch.
2. Right-click the application or website to edit and select Properties.
3. Edit the required details and click OK.
4. Click Close.

To remove a saved application or website
1. Select the Class tab in the ribbon and click Quick Launch.
2. Right-click the application or website to remove and select Remove.
3. Click Close.
User defined tools
As well as allowing a Tutor to launch applications at Student machines, you can automatically run a task on a Tutor machine using a Defined Tool.

To add a tool
1. From the Tech Console, select the Tools tab in the ribbon.
   Or
   From the Tutor Console, select the Administer tab in the ribbon.
2. The Add Tool dialog will appear.
3. Enter the required information.
4. Click OK.
5. Click Close.
6. The tool appears in the User Defined pane.

To run a tool
1. From the Tech Console, select the Tools tab in the ribbon.
   Or
   From the Tutor Console, select the Administer tab in the ribbon.
2. Select the required tool in the User Defined pane.
3. Click Run.
4. The tool will automatically run.

To edit a tool
1. From the Tech Console, select the Tools tab in the ribbon.
   Or
   From the Tutor Console, select the Administer tab in the ribbon.
2. Select the required tool in the User Defined pane.
3. Click the Edit.
4. The Edit dialog will appear.
5. Edit the appropriate information, click OK.

To delete a tool
1. From the Tech Console, select the Tools tab in the ribbon.
   Or
   From the Tutor Console, select the Administer tab in the ribbon.
2. Select the required tool in the User Defined pane.
3. Click the **Remove**.
4. A confirmation dialog will appear, click **Yes**. The tool will be removed.
Rebooting or logging out Students

Having connected to a Student or group of Students, you are able to remotely log out or reboot the Student machines at the end of a session. This is a simple way to prepare multiple machines for the next group of students.

To reboot or log out a Student
1. Select a Student or group of Students.
   Or
   To select all logged-in Students, click the Select logged in Students icon on the status bar.
2. Select the Administer tab in the ribbon and click Reboot or Logout.
   Or
   Right-click a Student and click the Reboot or Logout icon.
3. A message appears confirming the Student(s) included in the reboot/log out.
   Note: If you don't want to see this message in the future, click Don't show this again. It can be turned back on in the Tutor User Interface settings.
4. Click Yes.

To reboot or log out a Student whilst viewing
1. Select the Home tab in the View window ribbon and click Reboot or Logout.
2. Click Yes to confirm the reboot/logout.
Manage user account

NetSupport School allows you to manage users (reset and unlock passwords) that are part of Active Directory, allowing you to easily reset Student passwords at the end of a lesson, if required. You can see user accounts that have been locked, unlock the account or assign a new password.

If non-domain administrators want to use this facility, you will need to apply the appropriate rights to them. Please contact our Support team for full instructions on how to do this.

To reset a Student password
1. Select the Student to reset the password for.

   **Note:** You can select all or a group of Students to reset the password for.

2. Select the Administer tab in the ribbon and click **Manage Account**.
3. The Active Directory User Account dialog will appear. The logged on user name for the selected Student will be displayed. Click **Modify**.

![Manage Directory User Account](image)
From here, you can see the current user details, unlock the account and set a new password. When setting a new password, you can force the user to change this when they next log in.

**Note:** If you selected multiple Students, you will only be able to set a new password and not unlock accounts or force a password change.
Web Control module

The Web Control Module is used to monitor and control the websites visited by connected Students. A record of sites visited in a session can be stored and, if required, the Tutor can restrict or approve the use of specific websites. In addition, the Tutor can temporarily suspend all internet access.

**Note:** Supported Internet Browsers for internet metering and restrictions are Microsoft Edge, Firefox and Google Chrome. The following supports Internet restrictions only: Opera 9 and higher.

1. Click the **Web View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Web View**.

In Web mode, you can view details of approved or restricted websites and use the available icons in the ribbon to:

- Revert back to unrestricted access if restrictions have been in place.
- Activate the Approved Websites list. The Student will only be able to view websites that are in the Approved Websites list. All other websites are blocked. When the Student accesses the internet, they are forced to choose an approved website rather than being able to surf at will.
• Activate the Restricted Websites list. The Student will not be able to view websites that are in the Restricted Websites list but will be able to view all other websites.
• Restrict access to the internet.
• Allow web access for a limited time.

Notes:

• A padlock will be displayed next to the Web View icon when there are global policy restrictions in force. You can override the restrictions in the Tutor configuration.
• To temporarily block web access for all Students, select Internet on the caption bar (this can be done from any window). If this is not showing, click the Configure Quick Access List icon and select Web access from the list. An indicator will appear next to the Student icons to confirm internet usage is suspended.

The Web Control module can be used to perform the following functions:

Identify websites currently running on the Student machine

You can monitor websites that are currently running at Student machines.

In the List view, the Student icons can be viewed in two different ways, large icons or details view. Click the Large icons icon or the Details icon on the status bar.

The lower panes can be minimised to make more room for the Student icons. Click the Minimise View icon.

When viewing Students in large icons view, an icon is displayed next to the Student icon if a Student has a web browser open. This icon is either the default web browser icon or a personalised website icon. If the List view is in details view, the current website is displayed along with a list of all other website's running on the Student machine.

Large icons
Details

<table>
<thead>
<tr>
<th>Name</th>
<th>Current Web Site</th>
<th>All Web Sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andy</td>
<td>Gothic literature - BBC Bitesize [<a href="https://w">https://w</a>...</td>
<td><img src="https://example.com" alt="Facebook" /> <img src="https://example.com" alt="Twitter" /> <img src="https://example.com" alt="Google" /></td>
</tr>
<tr>
<td>Emma</td>
<td><img src="https://example.com" alt="Image" /></td>
<td><img src="https://example.com" alt="Facebook" /> <img src="https://example.com" alt="Twitter" /> <img src="https://example.com" alt="Google" /></td>
</tr>
<tr>
<td>Mark</td>
<td>The Women in Black by Susan Hill - BBC B...</td>
<td><img src="https://example.com" alt="Image" /></td>
</tr>
<tr>
<td>Sarah</td>
<td>English poets - Google Search [<a href="https://ww">https://ww</a>...</td>
<td><img src="https://example.com" alt="Image" /> <img src="https://example.com" alt="Facebook" /> <img src="https://example.com" alt="Twitter" /> <img src="https://example.com" alt="Google" /></td>
</tr>
</tbody>
</table>

When viewing either of the two views, the order of the Student icons can also be rearranged. Right-click in the List view and choose **Arrange**. The following options are available:

- **By Name**: Student icons will be arranged in alphabetical order according to their Student name, display name, or Student register name.
- **By Current Website**: Student icons will be arranged in alphabetical order according to the current website the Student is viewing.
- **By All Websites**: Student icons will be arranged in alphabetical order according to the running websites on the Student machine.
- **By Policy**: Student icons will be arranged in alphabetical order according to the current policy set in the Tech Console. This option will only be displayed if there is a policy in force.

A tick identifies the selection of one of the above options.

- **Ascending**: If this option has been selected, the Student icons will appear in ascending order according to the option selected above. A tick identifies selection of this option. Click this option again to clear. This will arrange the Student icons in descending order.

- **Align to Image Centres**: This option is only available if a background image has been set to tile. This will align the Student icons to the centre of the image.

- **Auto Arrange**: If a new Student has been added to the list, or a new website is running on a Student machine, this option will automatically arrange the icons into the
order selected above. A tick identifies selection of this option. Click this option again to clear.

Managing websites on Student machines
Not only can you identify the websites running on Student machines, you can also change, close and launch websites at Students.

Change the current website running on a Student machine
This method allows you to change the current website running on a Student machine to another website that the Student has open.

1. Switch to details layout by clicking the **Details view** icon on the status bar.  
   Or  
   Right-click in the List view and select **Details**.
2. Right-click the required website icon listed in the All Web Sites column.
3. Select **Activate**.
4. The newly activated website will now replace the current website running on the Student machine.

Close the current/running website on a Student machine
1. Switch to details layout by clicking the **Details view** icon on the status bar.  
   Or  
   Right-click in the List view and select **Details**.
2. Right-click a website in the Current Web Site or All Web Sites column.
3. Select **Close Browser**.
4. The website will be closed at the Student machine and the website icon will disappear from the List view.

**Note:** You can close a website at all connected Students by clicking the **Close at Students** icon above the Approved or Restricted Websites pane or right-clicking in the pane and choosing **Close at Students**.

Launch a website on all connected Students
1. Select a website in the Approved Websites list.
2. Click the **Send to Students** icon above the list.  
   Or  
   Right-click and select **Send to Students**.
3. The website will be launched on all connected Student machines.
4. In the List view, the launched website icon will appear in the Current Web Site column or on the Student icon.

Or

1. Highlight a website in the **Approved Applications** list.
2. Drag and drop the highlighted website into the List view.
3. The website will be launched on all connected Student machines.
4. In the List view, the launched website icon will appear in the current website list.

### Setting up an Approved or Restricted Website List

**Approved Sites**

When activated, the Student is only able to view the URLs specified on this list. The list of approved websites is displayed on the Student Toolbar. If this is disabled, a page is displayed at Student machines.

**Restricted Sites**

When activated, the Student is unable to view the URLs specified on this list. However, all other sites can be viewed.

### Notes:

- To ensure Students are only viewing the appropriate pages in a website you can approve/restrict Sub-URLs, specific web pages and have different parts of the same website approved/restricted. i.e. www.bbc.co.uk/learning can be restricted but www.bbc.co.uk/learning/history can be approved. Students will only be able to view pages relating to History and not view pages relating to Science or English.
- Web restrictions can be applied at start-up. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Start Options - Restrictions**.
- You can set the web access from the Class tab in the ribbon in all view modes.
Add a website to the Approved or Restricted Website list

1. Click the **Add** icon.
Or
Right-click in the Approved or Restricted Website pane and select **Add Website**.
2. The Add Website dialog appears.

![Website Properties dialog]

3. Type in the website address under **URL**.
4. Type in the description, e.g. Google (this is optional).

**Note:** By default, keywords are entered to prevent/ allow a Student to view a URL that includes these keywords. This can be used to deal with websites that are re-directed.

5. By default, websites added to the Approved Websites list appear in the Student Toolbar. If you don’t want Students to see this website, you can hide it by clearing the **Visible at Student** option.
6. Click **OK**.
7. The website icon and description will appear under the Approved Websites or Restricted Websites pane.

Or

1. Switch to details layout by clicking the **Details view** icon on the status bar.
2. Right-click a website icon in the List view in the Current Web Site or All Web Sites column.
3. Choose **Add to Approved List**.
Or
Choose **Add to Restricted List**.
4. The Website Properties dialog appears with the website details pre-populated.
5. Click OK.
6. The website icon and description will appear under the approved or restricted list.

**Remove a website from the Approved or Restricted Websites list**
1. Highlight the chosen website and click the Remove X icon.
   Or
   Right-click the website and select Remove Website.

**Apply approved or restricted websites**
Restrictions can be applied to individual Students or all connected Students. Students can view the current restrictions in the Student Toolbar.

1. If you want to apply restrictions to individual Students, select their icons in the List view.
   Select the Class tab in the ribbon and click Approved Only or Block Restricted.
2. To acknowledge which restriction has been activated, an appropriate indicator will appear next to the Student icons. Red for restricted, green for approved.
3. If a Student is currently viewing a website included in the activated restriction list, they will be redirected to a message stating that the website has been blocked by the Tutor.

**Notes:**
- You can amend the URL that restricted websites will be redirected to. Click Options in the Tutor Console, select Network Settings from the drop-down menu, choose Administration - Security and enter the required URL in the URL that restricted websites will be redirected to field.
- Full internet redirection is supported on Edge, Firefox and Chrome. For other browsers, the browser window will close.
- You can specify a time limit that certain internet permissions apply for. Select the Class tab in the ribbon and click Time Limited Access.
End approved or restricted websites
1. To remove the restrictions for individual Students, select their icons in the List view.
2. Select the Class tab in the ribbon and click **Unrestricted**.
3. The green or red indicator will be removed from the selected Student icons.

**Note:** Because internet browsers often hold the results of recent web access attempts in cache memory, lifting an internet restriction may not appear to take effect immediately. If this happens, you may have to restart the browser. The same situation may arise if you are using an application which requires internet access to a site that has been blocked. Once the restriction has been lifted, you may need to restart the application for it to recognise the change.

Block all web access
Allows you to block all access to the internet for Students. An indicator will appear next to the Student icons to confirm internet usage is suspended.

1. If you want to block web access for individual Students, select their icons in the List view.
2. Select the Class tab in the ribbon and click **Restrict All**.
3. All web access will be blocked for the selected Students.
NetSupport School 15.00

Notes:
• You can instantly block all web access for all Students by clicking **Internet** on the caption bar (this can be done from any window). This changes to **Blocked** to show web access is now blocked. If this is not displayed, you can add it by clicking the **Configure Quick Access List** icon and selecting **Web access** from the list.
• You can also block web access for all connected Students from the Tutor Toolbar.

Create a new website list
You may need to create more than one Website list, for example, if you want different websites approved or restricted for different classes. The default Website list is saved as NetSupport School.web

1. Select the Class tab in the ribbon and from the **Website list** drop-down menu, click **Create New Website List**.
2. Enter a file name and click **Create**.
3. A new blank Website list will appear.

Open an existing website list
1. Select the Class tab in the ribbon and from the **Website list** drop-down menu, click **Load Existing Website List**.
2. Highlight the relevant file and click **Open**.
3. The existing Website list will appear.

Save a website list
1. Select the Class tab in the ribbon and from the **Website list** drop-down menu, click **Save Website List As**.
2. Enter a file name and click **Save**.
3. The current Website list will be saved.

Notes:
• Any changes that have been made to the new or existing Website list will be automatically saved when a new Website list is created, or when you exit out of the NetSupport School program.
• The approved Website list can be added to the Student Journal by clicking the **Journal** icon above the Approved Websites pane.
**View web history**

This feature of the Web Control Module enables you to monitor the websites being visited by connected Students and, if required, store or print a permanent record.

**Note:** Students' web history can be automatically saved to the Tutor Journal when the Tutor Console is shut down. To enable this setting, click **Options** in the Tutor Console, select **Settings** from the drop-down menu, choose **User Interface - Tutor** and click the **Save Student Web history to Tutor Journal** option.

1. In Web view, select the Class tab in the ribbon and click **History**.
2. The Web History dialog appears.
   This provides details of the sites visited by the Student(s) during the currently connected session.

![Web History dialog](image)

The available options are:

**Show Web History for:**
You can view the history for all Students, the currently selected Students or you can select the required Student from the list.
**Refresh**
While viewing the list, click **Refresh** at any time to update the display.

**Save**
To keep a permanent record of the displayed items, you can save the details to a text file before disconnecting.

**Print**
Prints details of the currently displayed items.

**Export**
Exports data to a CSV file allowing the data to be imported if needed.

**Close**
Closes the History dialog but details will continue to be recorded while the Control is connected.
Application Control module

The Application Control module is used to monitor and control the applications used by connected Students. A record of applications used in a session can be stored and, if required, the Tutor can restrict or approve the use of applications.

1. Click the **Application View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Application View**.

In Application mode, you can view details of approved or restricted applications and use the available icons in the ribbon to:

- Revert back to unrestricted access if restrictions have been in place.
- Activate the Approved Applications list. Students can only run applications that are in the approved list. All other applications are blocked.
- Activate the Restricted Applications list. Students can't run applications that are in the restricted list but will be able to run all other applications.
**Note:** A padlock will be displayed next to the **Application View** icon when there are global policy restrictions in force. You can override the restrictions in the Tutor configuration.

The Application Control module can be used to perform the following functions:

**Identify applications currently running on the Student machine**

You can monitor applications that are currently running on Student machines.

In the List view, the Student icons can be viewed in two different ways, large icons or details view. Click the **Large icons** icon or the **Details** icon on the status bar.

The lower panes can be minimised to make more room for the Student icons. Click the **Minimise View** icon.

When viewing Students in large icons, an icon is displayed next to the Student icon, showing the current application in use. If the List view is in details view, the current application, along with a list of all other applications running on the Student machine is also displayed.

**Large icons**

![Large icons](image)

**Details**

<table>
<thead>
<tr>
<th>Name</th>
<th>Current Application</th>
<th>Running Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andy</td>
<td>The Woman in Black by Susan Hill - BBC...</td>
<td><img src="image" alt="App1" /> <img src="image" alt="App2" /></td>
</tr>
<tr>
<td>Emma</td>
<td></td>
<td><img src="image" alt="App1" /></td>
</tr>
<tr>
<td>Mark</td>
<td>Untitled - Paint</td>
<td><img src="image" alt="App1" /> <img src="image" alt="App2" /></td>
</tr>
<tr>
<td>Sarah</td>
<td>Document - WordPad</td>
<td><img src="image" alt="App1" /> <img src="image" alt="App2" /></td>
</tr>
</tbody>
</table>
When viewing either of the two views, the order of the Student and application icons can also be rearranged by the Tutor. Right-click in the List view and choose **Arrange**. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>By Name</strong></td>
<td>Student icons will be arranged in alphabetical order according to their Student name, display name, Student register name.</td>
</tr>
<tr>
<td><strong>By Current Application</strong></td>
<td>Student icons will be arranged in alphabetical order according to the current application.</td>
</tr>
<tr>
<td><strong>By Running Applications</strong></td>
<td>Student icons will be arranged in alphabetical order according to the running applications on the Student machine.</td>
</tr>
<tr>
<td><strong>By Policy</strong></td>
<td>Student icons will be arranged in alphabetical order according to the current policy set in the Tech Console. This option will only be displayed if there is a policy in force.</td>
</tr>
</tbody>
</table>

A tick identifies the selection of one of the above options.

- **Ascending**
  - If this option has been selected, the Student icons will appear in ascending order according to the option selected above. A tick identifies that this option is selected. Click this option again to clear. This will arrange the Student icons in descending order.

- **Align to Image Centres**
  - This option is only available if a background image has been set to tile. This will align the Student icons to the centre of the image.

- **Auto Arrange**
  - If a new Student has been added to the list or a new application is running on a Student machine, this option will automatically arrange the icons into the order selected above. A tick identifies that this option is selected. Click this option again to clear.
Managing applications on Student machines
Not only can you identify what applications are running on Student machines, you can also change, close and launch applications at Students.

Change the current application running on a Student machine
This method allows you to change the current application running on a Student machine to another application that the Student has open.

1. Switch to details layout by clicking the Details view icon on the status bar.
   Or
   Right-click in the List view and select Details.
2. Right-click on an application icon listed in the Running Applications column.
3. Select Activate.
4. The newly activated application now replaces the current application running on the Student machine.

**Note:** You can minimise all applications at Student machines. Select the Class tab in the ribbon, click the Student Desktop icon and choose Show Desktop.

Close current/running applications on a Student machine
There are two options when closing an application on a Student machine:

**Close Application**
Close down an application but respect any applications requests at the Student, e.g. to save file before closing.

**Kill Process**
Force the application to close, without any application prompts.
To close an application running on a Student machine
1. Switch to details layout by clicking the Details view icon on the status bar.
   Or
   Right-click in the List view and select Details.
2. Right-click on an application icon listed in the Current Application or Running Application column.
3. Select Close Application or Kill Process.
4. The application will be closed at the Student machine and the icon will disappear from the List view.

Note: You can close an application at all connected Students by clicking the Close at Students icon above the Approved or Restricted Applications pane or right-clicking in the pane and choosing Close at Students.

To close all applications at the Student
All running applications at the Student will be forced to close.

Note: This feature is not supported for Windows Store applications. Only standard Windows desktop applications will be closed.

1. Select the Students you wish to close applications at.
2. Select the Class tab in the ribbon, click the Student Desktop icon and click Clear Desktop.
   Or
   Right-click on an application icon listed in the Current Application or Running Application column and select Close All Applications.
**Note:** You can switch Windows 8 Students to either the desktop or Start screen by selecting the Class tab in the ribbon, clicking the **Student Desktop** icon and choosing **Switch to Desktop** or **Switch to Start screen**.

---

**Launch an application on all connected Students**

1. Select an application in the Approved Applications list.
2. Click the **Send to Students** icon above the list.  
   Or  
   Right-click on an application icon in the Approved or Restricted Applications list and choose **Send to Students**.
3. The application will be launched on all connected Student machines.
4. In the List view, the launched application icon will appear in the Current Application column or on the Student icon.

Or

1. Highlight an application in the Approved or Restricted Applications list.
2. Drag and drop the highlighted application into the List view.
3. The application will be launched on all connected Student machines.
4. In the List view, the launched application icon will appear in the Current Application column or on the Student icon.

---

**Setting up Approved or Restricted Applications**

<table>
<thead>
<tr>
<th>Approved Applications</th>
<th><strong>Approved Applications</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Student is only able to run the applications specified on this list.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Restricted Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restricted Applications</strong></td>
</tr>
<tr>
<td>The Student is unable to run the applications specified on this list.</td>
</tr>
</tbody>
</table>

**Note:** Application restrictions can be applied at start-up. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Start Options - Restrictions**.
Add an application to the Approved or Restricted Applications list

1. Click the Add + icon.
   Or
   Right-click in the Approved or Restricted Applications List pane and select Add Application.
   Or
   Drag and drop applications from your desktop or Start Menu into the Approved or Restricted Application list pane.
2. The Application Properties dialog appears.

![Application Properties dialog]

3. Type in the .exe file name (e.g. winword.exe) under Filename or browse for your chosen application.
4. Type in the description, e.g. Microsoft Word.

**Note:** When adding applications on Windows machines that have the Microsoft Store, two tabs will be displayed in the Application Properties dialog. The Desktop Application tab allows you to add standard Windows applications as detailed above or you can add Windows Store Applications.

5. Click OK.
6. The application icon, name and description will appear in your Approved or Restricted Applications list pane.

   Or

1. Switch to details layout by clicking the Details view ≡ icon on the status bar.
2. Right-click an application icon in the List view in the Current Application or Running Applications column.
3. Choose Add to Approved List.
Or
Choose Add to Restricted List.
4. The application icon and description will appear in the Approved or Restricted Applications list pane.

Remove an application from the Approved or Restricted Applications list
1. Highlight the chosen application and click the Remove \(\times\) icon.
   Or
   Right-click the application and select Remove Application.

Apply approved or restricted applications
Restrictions can be applied to individual Students or all connected Students. Students can view the current restrictions in the Student Toolbar.

1. If you want to apply restrictions to individual Students, select their icons in the List view.
2. To apply these restrictions, select the Class tab in the ribbon and click Approved Only or Block Restricted.
3. To acknowledge which restriction has been activated, an appropriate indicator will appear next to the Student icons (when viewing Large icons only). Red for restricted, green for approved.
4. If a Student is currently running an application included in your activated restriction list, an Application Blocked dialog will appear on their screen, stating the application that has been blocked by the Tutor. This will also appear if a Student attempts to run any of the applications included on the restriction list.
End approved or restricted applications
1. To remove the restrictions for individual Students, select their icons in the List view.
2. Select the Class tab in the ribbon and click Allow All.
3. The green or red indicator will be removed from the selected Student icons.

Note: Removing a restriction may not appear to take effect immediately. You may need to restart the application for it to recognise the change.

Create a new application list
You may need to create more than one application list, for example, if you want different approved or restricted for different classes. The default application list is NetSupport School.app.

1. To create a new Application list, select the Class tab in the ribbon and from the Application list drop-down menu, click Create New Application List.
2. Enter a file name and click Save.
3. A new blank application list will appear.

Note: Application lists can be assigned to different Tutor users by setting up a Tutor Profile. See Tutor Profiles.

Open an existing application list
1. To open an existing application list, select the Class tab in the ribbon and from the Application list drop-down menu, click Load Existing Application List.
2. Highlight the relevant file and click Open.
3. The existing application list will appear.

Save an application list
1. To save the current application list, select the Class tab in the ribbon and from the Application list drop-down menu, click Save Application List As.
2. Enter a file name and click Save.
3. The current application list will be saved.
**Note:** Any changes that have been made to the new or existing applications lists will be automatically saved when a new applications list is created, or when you exit the NetSupport School program.

**View application history**

This feature of the Application Control Module enables you to monitor the applications being used by connected Students and, if required, store or print a permanent record.

1. In Applications view, select the Class tab in the ribbon and click **History**.
2. The Application History dialog appearz.
   This provides details of any application used by the Student(s) during the currently connected session.

![Application History dialog](image)

The available options are:

**Show Application History for:**
You can view the history for all Students, the currently selected Students or you can select the required Student from the list.
Refresh
While viewing the list, click Refresh at any time to update the display.

Save
To keep a permanent record of the displayed items, you can save the details to a text file before disconnecting.

Print
Prints details of the currently displayed items.

Export
Exports data to a CSV file allowing the data to be imported if needed.

Close
Closes the History dialog but details will continue to be recorded while the Tutor is connected.
Student Surveys

The Student Survey tool enables the Tutor to get instant feedback from Students during or at the end of a session. The Tutor sends connected Students a question, together with a selection of pre-defined responses. Student responses are gathered at the Tutor with the results shown as an overall percentage and by individual Student. Results can be shown to Students in the form of a pie chart, Students must respond before they can view the results.

Students can also be temporarily ‘grouped’ by response enabling you to see in an instant who selected the same answer. This could be useful if you felt a quick follow-up question or message to particular Students was required.

Sending a survey to Students

1. Select the **Survey View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Survey View**.
2. Select the Students to include in the survey. This can be all Students in the list view, selected Students or a defined group of Students.
3. Enter a question in the Survey pane Question field.
4. Select the responses/answers to the question. These can either be chosen from the drop-down list of defaults or you can enter your own
options, using a comma to separate each one. Up to 6 choices can be entered.

**Note:** You can select a pre-defined survey from the Survey list by selecting the Class tab in the ribbon, clicking the **Question** icon and selecting the required survey. Pre-defined surveys can be selected from the **Question** drop-down arrow in the ribbon.

5. Send the survey to Students by clicking **Send** in the Survey pane or selecting the Class tab in the ribbon and clicking **Send**.
6. A dialog appears at the Student machines displaying the question and responses. Students choose the appropriate response and submit the answer.

![Survey Question](image)

7. As Students submit their answers, the Survey Results pane will display the percentage response for each option. The Student icon will also flag how the individual Student answered. By switching the List view to details view (click the **Details** icon on the status bar), you can sort the Students by result. Alternatively, you can sort the Students into temporary groups by response. From the Class tab in the ribbon, click **Auto group**.

8. When the survey is complete, remove it from the screen by clicking **Cancel Survey** in the ribbon.
Notes:
- The survey will be cleared from all machines whether the Student has responded or not.
- Once the question has been sent to Students, it will be added to the Survey list, allowing you to re-use this.

Show survey results to Students
1. Select the Class tab in the ribbon and click **Show Results**.
2. The results will be displayed as a pie chart on the Students screen.

**Note:** Survey results will only be displayed if the Student Toolbar is running and the Student has submitted their answer.

Save survey results
The survey can be saved to a .CSV file.

1. Select the Class tab in the ribbon, click **Survey List** and choose **Save** from the drop-down menu.

Print survey results
Before clearing the survey, you can print a permanent record of the results.

1. Select the Class tab in the ribbon and click **Print**.

**Note:** The Student results can be added to the Student Journal. Select the Class tab in the ribbon and click **Journal**.
Survey lists
Surveys can be re-used by adding them to a Survey list. NetSupport School provides a default list, NetSupport School.sul, into which questions and responses are automatically stored, but you can create custom lists if you want to categorise different types of question.

Create a Survey list
1. In Survey view, select the Class tab in the ribbon, click Survey List and choose New from the drop-down menu.
2. Enter a name for the file and click Create.
3. Any new surveys you enter will be added to the list.

Load a Survey list
1. In Survey view, select the Class tab in the ribbon, click Survey List and choose Load from the drop-down menu.
2. Select the required list and click Open.

Using Survey lists
With the required Survey list loaded, you can enter new questions or use and manage previously stored questions and responses.

To add a new question to a Survey list
1. In the Student Survey pane, enter the question and choose the required responses from the Response drop-down list or add new options if the defaults aren’t appropriate.
2. Click Send. The survey will automatically be stored in the current list.

Note: You can also add a question in the Select Survey dialog.
To use an existing survey
1. Select the Class tab in the ribbon and click **Question**.
2. The Select Survey dialog will appear.

![Select Survey dialog](image)

3. Select a question from the list and click **OK**.
4. The question will be displayed in the Survey pane ready to be sent to Students.

**Note:** Recent questions can also be selected by clicking the **Question** drop-down arrow in the ribbon. You can send the question directly to Students by clicking the **Send** icon.

Manage questions and responses
As well as enabling you to choose an existing Survey, the Select Survey dialog can be used to add new questions/responses and edit questions/responses if the current examples are not appropriate.

1. Select the Class tab in the ribbon and click **Question**.
2. The Select Survey dialog will appear.
3. If the Survey list does not currently include the required question, enter the new question along with the responses, in the boxes provided and click **Add**.
   Or
To edit an existing question, select it from the list, change the question and/or the responses and click Add.

**Note:** If you change the question it will be added to the list in addition to the original. If you only change the responses, the original will be overwritten.

4. To use the question in a survey, select it from the list and click **OK**.
5. The question will be displayed in the Survey pane ready to be sent to Students.

**Note:** When you use customised responses in a survey, they will be attached to that question only. If you want to make the responses available to other surveys, they need to be added to the default drop-down list. Click **Manage**, the Manage Responses dialog will appear, enter the required responses and click **Add**.
Question and Answer module

NetSupport School's Question and Answer module is a unique collaborative tool that enables teachers to reinforce key learning points and instantly gauge student understanding during a lesson. You can verbally ask questions to the whole class, gauge student answers and understanding, bounce questions around the classroom, develop peer assessment opportunities as well as track rewards against both the individual and, where appropriate, teams.

Note: The Student Toolbar will be enabled and displayed at the Student, even if the toolbar is turned off at the Tutor.

1. Click the Q&A View icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Q & A View**.
2. The Tutor will display the Student thumbnails. Once a question and answer session has begun, you can see who has responded and mark their answers.

Starting a question and answer session

1. Select the Class tab in the ribbon and click **Question Types**.
2. There are five types of questions to choose from:

First to answer
Enter an answer
Pot luck
Team first to answer
Team enter an answer

3. Select a question type to continue.
4. Set the required properties for the question and click OK.

5. Click Go to start the Question and Answer session.
6. A dialog appears at the Student, allowing them to answer the question.
7. The Student thumbnails show who has responded and you can mark their answers.
8. A Question and Answer dialog is displayed at the Student, showing the current question type and any awards the Student has received. Students will be able to see the current state of all Students for each question. You can also choose to show the results to Students, this can be set in the Question & Answer Options dialog.
**Question and Answer Module - First to Answer Question Type**
The teacher asks a verbal question and the Students click to answer. The 'top x' fastest responders will be displayed and the quickest Student is asked for their answer. You then decide whether this is correct or not and rewards can be awarded or deducted.

**Note:** Questions can be bounced to the next quickest Student when more than one Student has been selected. This can be done automatically by selecting the **Automatically bounce to next Student** option in the Ask the question dialog or manually by selecting the Class tab in the ribbon and clicking **Bounce**.

A thinking time limit can be applied, the **Answer** button is disabled during this period, giving Students a chance to think about their answer before they click. A time limit for answering the question can also be set.

You can choose to exclude a Student from the next round if they have already answered a question, ensuring all Students have a fair chance to answer a question.

**Question and Answer Mode - Enter an Answer Question Type**
The teacher enters the answer to the next question in advance and then verbally asks the question. Students are prompted to enter their answer. Results are instantly displayed to the class and rewards can be awarded or deducted.

**Note:** You can determine whether the answer is case sensitive or not.

A thinking time limit can be applied, the **Answer** button is disabled during this period, giving Students a chance to think about their answer before they click. A time limit for answering the question can also be set. You can choose to exclude a Student from the next round if they have already answered a question, ensuring all Students have a fair chance to answer a question.

**Question and Answer Mode - Pot Luck Question Type**
The teacher decides how many Students to select randomly, NetSupport School will pick and order them. A Student is then randomly selected and you verbally ask a question and the Student answers. You then decide whether this is correct or not and have the option to 'bounce' the question to another random Student. Rewards can be awarded or deducted.
Note: Questions can be bounced to the next quickest Student when more than one Student has been selected. This can be done automatically by selecting the **Automatically bounce to next Student** option in the Ask the question dialog or manually by selecting the Class tab in the ribbon and clicking **Bounce**.

If a Student has answered correctly, you can allow them to select the next random Student.

Note: If a Student has answered, they will not be randomly selected again during this session, unless the **Only Select Students Once** option is unselected.

You can also select a Student randomly by selecting the Select tab in the ribbon and clicking **Random Student**.
Question and Answer module - Tutor interface
Once the question type has been selected and the options chosen, Student thumbnails will be displayed in the Tutor. The thumbnails allow you to see who has responded and mark their answers more easily.

Customise thumbnail size
Student thumbnails can be resized to suit personal preferences.

1. Use the slider icon on the status bar to select the required size.

Auto-fit size of Student thumbnail
This option will automatically adjust the size of the displayed thumbnails to fit the window.

1. Click Auto on the status bar.

The following icons can be displayed at the Tutor:

- Student has not yet answered.

![Student has not yet answered.](image)

- The Student has answered. You can mark their answer correct or incorrect by clicking on the tick or cross. Clicking the thumbs up/down button allows the rest of the class to peer assess the answer. The yellow number indicates which position the Student has answered in.

![The Student has answered.](image)

- Student has been marked correct. The number of rewards the Student currently has is also displayed.

![Student has been marked correct.](image)

- Student has been marked incorrect.

![Student has been marked incorrect.](image)

- Student is excluded from the round.

![Student is excluded from the round.](image)
The time ran out in enter an answer mode before the Student answered.

A Student is being peer assessed. The green and red area will fill in a bar chart style as the Students respond.

Student thought the answer was correct in peer assess mode.

Student thought the answer was incorrect in peer assess mode.

During a pot luck question student icons flash in this state to indicate they might be selected. A corresponding large ‘?’ is also shown at Student screens.
Using the Question and Answer module

Once a Question and Answer session has begun, you will be able to see who has responded and mark Student answers by clicking the tick or cross on the Student’s thumbnail. Awards can be given for a correct answer and deducted for an incorrect answer, you can configure these options in the Question & Answer options dialog. Students can see their current awards in the Question and Answer dialog.

**Note:** Rewards can be allocated/deducted outside of a Question and Answer session by selecting the Feedback & Wellbeing tab in the ribbon.

Questions can be bounced around the class encouraging discussion. You can also ask Students to peer assess an answer to find out if they thought it was correct or not.

You can move on to the next round by selecting the Class tab in the ribbon and clicking **Next Round**. You can stop the current question type and clear the Question and Answer Mode windows on the Student machines by clicking **Stop** in the ribbon.

**Excluding Students**

To ensure all Students are involved equally in the process, you can choose to exclude specific students, those that have already answered a question, from the next round of questioning.

Students are automatically excluded from a round if either of the **Exclude** options in the Question & Answer options dialog have been selected. Students can be manually excluded, right-click the Student and select **Exclude Student from round**.

**Sound effects**

You can include sound effects to be played at the Tutor and Students. Sounds will be played at the Tutor when a Student answers, at the Student when the Answer dialog is displayed and at both when randomly selecting a Student and when the thinking time or time limit is at 5 and 2.5 seconds. Sounds effects will be turned on by default.
1. Select the Class tab in the ribbon and click **Volume**.
2. Select the relevant option to turn sound effects on/off at the Tutor or Student.
3. Use the slider bar to adjust the volume.

**Bouncing questions**
To encourage discussion across the class, you can bounce a question to the next Student asking if they have an answer or what they thought of the previous answer.

**Note:** You can only bounce a question for first to answer and pot luck question types when more than one Student has been selected.

Questions can be automatically bounced to the next Student who has responded as soon as you click the tick or cross. Select the **Automatically bounce to next Student** option in the Ask the question dialog. The question will be bounced around the Students for the number of times specified.

**Manually bounce questions**
If you haven't selected the automatically bounce option, you can still bounce questions to the next available Student.

1. Select the Class tab in the ribbon and click **Bounce**.
   Or
   Right-click the Student and select **Bounce Question**.

When a question has been bounced the display changes to show who now has the question and where it came from. The next Student can answer and this can continue around the whole class until all Students who have answered have been included.
Peer assessment
Peer assessment allows Students to give feedback in response to an answer given by one of their classmates. After a question has been answered, you can ask the rest of the class to assess the answer by clicking on the button. A dialog appears at Student screens asking them to decide if the answer was correct or not. As the Students answer the Student thumbnail at the Tutor will change to reflect the number of Students who think their answer is right or wrong.

Question and Answer Team Mode
Students can be placed in teams allowing them to compete for rewards as a group. You can use team mode when selecting Team first to answer or Team enter an answer question types. Teams can be created randomly or Students can pick a team to join. Custom team names can be created and you can customise the colour allocated to the team.

Using team mode
1. Select the Class tab in the ribbon, click Question Types and choose Team first to answer or Team enter an answer from the menu.
2. Select the required properties for the question in the Ask the question dialog. Click OK.
3. The Create Teams appears.

4. Select how to group the teams. If randomly, enter the number of teams. If you allow the Student to choose a team, enter the team names; the Student can then pick a team from a drop-down list. Click OK.
5. The Team Summary dialog appears showing how many Students are in each team. NetSupport School randomly allocates colours to teams; you can change this by clicking the colour and selecting a new colour.

6. Click **OK**. The question and answer session will start as normal.

The Tutor screen will display which team each Student is in. The teams are displayed in the group bar. You can hide/show these by clicking the **Teams** icon on the group bar. The team statistics will be displayed to students in the Question and Answer dialog. Rewards are awarded to both the individual Student and the team.

**Note:** To delete the teams that have been set up, select the Class tab in the ribbon, click the **Question Types** icon and select **Delete Teams**.
**Printer Management**

Print Management gives the Tutor total control over printer usage within the classroom, the Tutor can monitor and control all printing activity by connected Students or printer. Students can be prevented from printing, be assigned page limits or require Tutor authorisation to print.

The print management feature supports multiple printers within a classroom, prevents the addition, deletion or modification of existing printers and provides printing usage summaries as part of the Student register.

**Notes:**
- Printers must be added to Student machines before the Tutor connects.
- A padlock will be displayed next to the **Print View** icon when there are global policy restrictions in force. You can override the restrictions in the Tutor configuration.

1. Click the **Print View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Print View**.
In the List view, the Student icons can be viewed in two ways, large icons or details view. Click the **Large icons** icon or the **Details** icon on the status bar.

When viewing the "Large icons" layout, an icon is displayed next to the Student icon, informing the Tutor of the current print activity. If the List view is in "Details" layout, a summary of the print activity for each Student is displayed.

The lower panes can be minimised to make more room for the Student thumbnails. Click the **Minimise View** icon.

To keep track of print usage while in other areas of the Tutor Console, select the Class tab in the ribbon and click **Show Printers**. The printer icon will be displayed in all other views allowing you to see jobs as they happen, pause, delete and resume printing.

**Notes:**

- All printers will be displayed when you select **Show Printers**. You can remove printers by deselecting the printer in the Printer list.
- When a Student is printing, a connection bar will be displayed from the printer to the Student who is printing. The connection bar will only be displayed for local printers.
Using Print Management
Printers must be added to the Student machine before the Tutor connects, once connected to Students, printers cannot be added, removed or modified. All printers that are attached to Student machines will appear in the Printer List. Student print jobs will be displayed in the Print Queue, giving you an overview of who is printing, what is being printed, how many pages are printing and the current print status. From here, you can delete or resume printing for Students.

Notes:
• If Show printers is enabled, you can pause, delete and resume jobs via the printer icon in any view.
• Print restrictions can be applied at start-up. Click Options in the Tutor Console, select Network Settings from the drop-down menu and choose Start Options - Restrictions.

If the Student Toolbar is enabled, Students will be notified of the current print status.

Setting print thresholds
Print thresholds can be applied for an individual print job, allowing the Tutor to specify the maximum number of pages Students can print. If the Student exceeds this limit, the print job will be automatically paused or deleted.

1. Select the Class tab in the ribbon and click Set Print Thresholds.
2. The Print Thresholds dialog will appear, allowing you to apply the relevant settings.

Pause printing
1. Select the required Students in the List view.
2. Select the Class tab in the ribbon and click Pause printing.
3. The Print status for the selected Student(s) will now show as paused.

Or
1. Select the required printer in the Printer list.
2. Right click and choose Pause.
3. Printing will be paused for the selected printer.

Block all printing
1. Select the required Students in the List view.
2. Select the Class tab in the ribbon and click Block printing.
3. The Print status for the selected Student(s) will now show as blocked.

Or

1. Select the required printer in the Printer list.
2. Right click and choose **Block**.
3. Printing will be blocked for the selected printer.

**Delete print jobs**
You can delete all print jobs, selected print jobs or all print jobs for a Student.

1. Select the required print job(s) in the print queue.
2. Click the **Delete** icon above the Print Queues pane.
   Or
   Right click and choose **Delete/ Delete All/ Delete All jobs for xxx**.
3. The selected print job(s) will be deleted.

**Deleting duplicate print jobs**
1. Select the Class tab in the ribbon and click the **Delete Duplicates** option.
2. Duplicate print jobs will now be deleted.

**Resume printing**
Allows you to restart printing after it has been paused or blocked.

1. Select the required Students in the List view.
2. Click the **Resume** icon above the Print Queues pane.
   Or
   Select the Class tab in the ribbon and click **Unrestricted**.
3. Printing will now be resumed.

Or

1. Select the required printer in the Printer list.
2. Right click and choose **Resume**.
3. Printing will be resumed for the selected printer.

**Note:** You can also resume printing for Student(s) in the print queue.  
Select the required print job, right click and choose **Resume**.
**Printer properties**
Allows you to change the image, display name of the printer and reset the total page and job count.

1. Select the **Printer** icon in the List view.
   Or
   Select the required printer in the Printer list.
2. Right click and choose **Properties**.
3. Amend the required properties.
4. Click **OK**.
**View print history**

This feature of Print Management enables you to monitor the print usage of connected Students and if required, store or print a permanent record.

1. In Print view, select the Class tab in the ribbon and click **History**.
2. The Print History dialog will appear. This provides details of the Students print activity during the currently connected session.

![Print History dialog](image)

The available options are:

**Show History for:**
You can view the history for all Students, the currently selected Students or you can select the required Student from the list.

**Refresh**
While viewing the list, click **Refresh** at any time to update the display.

**Save**
To keep a permanent record of the displayed items, you can save the details to a text file before disconnecting.

**Print**
Prints details of the currently displayed items.
**Export**
Exports data to a CSV file allowing the data to be imported if needed.

**Close**
Closes the History dialog but details will continue to be recorded while the Control is connected.
Device Control

The Device Control feature allows the Tutor to protect against external sources during a Lesson. The Tutor can prevent data from being copied to or from USB devices and CD/DVD drives. In addition, the Tutor can provide read-only access, allowing Students to view files from devices but prevents them from copying files to them. The Tutor can also prevent Students from using the webcam on their device.

1. Select the **Device View** icon on the left-hand side of the Tutor Console.
   Or
   Select the View tab in the ribbon, click the drop-down arrow in the Mode section and choose **Device View**.

   ![Device Control Screen](image)

**Note:** A padlock will be displayed next to the Device Control view icon when there are global policy restrictions in force. You can override the restrictions in the Tutor configuration.

In the List view, the Student icons can be viewed in two ways, large icons or details view. Click the **Large icons** icon or the **Details** icon on the status bar.

When viewing the "Large icons" layout, an icon is displayed next to the Student icon, informing the Tutor of the current device restrictions. If the
List view is in "Details" layout, a summary of device restrictions for each Student is displayed.

**Note:** Device restrictions can be applied at start-up. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Start Options - Restrictions**.

**Block access to CD/DVD or USB devices**
1. Select the required Students in the List view.
2. Select the Class tab in the ribbon, click the **USB** or **CD/DVD** icon and choose **Block Access** from the drop-down menu.

**Read-only access to CD/DVD or USB devices**
Provide Students with read-only access to CD/DVD or USB devices.

1. Select the required Students in the List view.
2. Select the Class tab in the ribbon, click the **USB** or **CD/DVD** icon and choose **Read Only** from the drop-down menu.

**Unrestricted access**
Provide Students with full access to CD/DVD or USB devices.

1. Select the required Students in the List view.
2. Select the Class tab in the ribbon, click the **USB** or **CD/DVD** icon and choose **Unrestricted** from the drop-down menu.

**Disable execute**
Prevent Students from running programs from CD/DVD or USB devices.

1. Select the required Students in the List view.
2. Select the Class tab in the ribbon, click the **USB** or **CD/DVD** icon and choose **Prevent Execute** from the drop-down menu.

**Note:** To allow access to execute, click the **USB** or **CD/DVD** icon and choose **Allow Execute** from the drop-down menu.

**Mute sound on Student machines**
1. Select the Class tab in the ribbon and click **Mute Sound**.
2. Sound will be muted on the Student machines.
3. To enable sound at the Students, click **Unmute Sound**.

Disable the webcam on Student machines
Prevent Students from using the webcam.

1. Select the required Students in the List view.
2. Select the Class tab in the ribbon and click Disable Webcam.
3. The webcam at the selected Students will be disabled.

**Note:** To allow access to webcams, click Enable Webcam in the ribbon.
Tutor profiles

NetSupport School allows you to set up multiple Tutor profiles for different Tutor users, each with a pre-defined set of options. On starting the Tutor Console, if multiple profiles have been created, a dialog is displayed that allows the user to select which profile to use.

The main benefit of creating a profile is to be able to store ready-made lists of approved/restricted applications, websites and keywords rather than have the user create these at the start of each lesson.

Having created your Application, Website or Word list, as detailed in the Web Control, Application Control and Keyboard Monitoring sections, the files can then be added to a Tutor profile.

**Note:** As well as Website, Application and keyword lists, other areas of the program that can be profiled are Layouts, Student Surveys, Client lists, Group lists, the location for storing test results, exams and Class lists.

To create a Tutor profile

1. Create the files, containing details of approved/restricted websites, applications etc that are to be included in the profile.
2. Click **Options** in the Tutor Console, select **Network Settings** from the drop-down menu and choose **Administration - Profile**.
3. To create a new profile, select **Add**. The Create New Configuration dialog appears.
4. Enter a name for the profile. Functionality for the profile can be ‘copied from’ an existing Tutor configuration, the default NetSupport School or a user defined profile. Click **OK**. The name will be added to the profile list.
5. To change the content of the profile, click **Edit**. The File Locations dialog will appear.
6. In each category, select the file to be used in the profile. The Folder locations dialog allows you to change where items are located.
7. Click **OK**.

Each time the Tutor Console is started, the user will be presented with a list of locally stored Profiles to choose from. Should you wish to share Profiles across a network, the /R command line instruction can be used to launch the Tutor program with a centrally available profile.
For example, from the NetSupport School program folder run the command; \pcinssui /rN:\SampleProfile.cfg. If the profile, in this example SampleProfile.cfg, does not currently exist a default will be loaded, enabling you to add your own values. Once you exit the Tutor Console the profile will be stored in the specified location.
Manage Student resources

Students can now easily access any resources required during a lesson. The Tutor can create a resource list and add links to websites, applications and documents, this list is then displayed in the Student Toolbar providing Students with a quick and easy way to access the required resources.

To create a resource list
1. Select the Work Planner tab in the ribbon and click **Student Resources**.
2. The Resources List dialog will appear.
3. Select the required resource from the Available Items list and either drag and drop to the Resource List or click the **Add** icon. You will be prompted to enter a description and location for the resource.
4. The order of the list can be sorted using the appropriate arrows.
5. Click **Save** and specify a file name for the list, once saved the resources will be displayed in the Student Toolbar.
**Student Journal**

NetSupport School provides a Journal feature, allowing key lesson resources to be captured and automatically included in a PDF file for post-lesson review by each student and as a record of content covered for teachers. Not only can teachers add notes and resources used during the lesson directly to each Student Journal, the Students are able to add their own notes making this a truly personalised document.

**Note:** A PDF reader will be required to view the Journal.

By default, the Journal is located in:

C:\Users\"Logged on User"\Documents\Journals

**Configuring the Journal**

You can customise the settings for the Journal (at both the Student and Tutor) and change the location of where the Journal is stored.

**Tutor Journal**

1. Click **Options** in the Tutor Console, select **Settings** from the drop-down menu and choose **Journal**.

**Student Journal**

1. In the Student Configurator, select **Journal**.

**Items that can be included within the Journal are:**

- Lesson details and objectives.
- Student Register
- The Approved Websites list
- Copies of any class chat transcripts.
- Class or group survey results.
- Individual Student test results.
- Virtual whiteboard screens.
- Screenshots (and supporting explanation).
- Target keywords.
- Teacher notes.
- Individual Student notes.

**Notes:**

- Students' web history can be automatically saved to the Tutor Journal when the Tutor Console is shut down. To enable this setting, click **Options** in the Tutor Console, select **Settings** from the drop-down
menu, choose **User Interface - Tutor** and select the **Save Student Web history to Tutor Journal** option.

- Student rewards and stickers are automatically added to the Journal when they are given to Students.

---

**Starting a Journal**

The Journal will automatically start when any of the **Send to Journal** options are selected. You can also start a Journal in the Class wizard.

1. Select the Journal tab in the ribbon and click **Start**.
Note: If the Tutor Console is closed or the Student is restarted, the current Journal will be closed. You can open an existing Journal. Select the Journal tab in the ribbon, click the Start drop-down arrow and choose the previous Journal from the list.

Add Tutor notes to the Journal
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Notes.
3. The Add Notes to Journal dialog will appear.
4. Enter the required note and choose which Student Journals to send the screenshot to from the Send To drop-down list (all connected Students or the currently selected Students).
5. Click OK.

Note: You can also add a note to all Student Journals. Select the Journal tab in the ribbon, enter the required note in the Note section and click Add. Or, click the Add notes to the journal icon on the caption bar, enter the required note and click Add. If this is not displayed, you can add by clicking the Configure Quick Access List icon and selecting Add notes to the student journal from the list.

Add a screenshot to the Journal
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click Screenshot.
3. Click Desktop to add a screenshot of your desktop.
4. Click Application and select the required application from the list to add a screenshot of the selected application.
5. Click Paste to add an image you have copied to your clipboard.
6. You can enter a note to accompany the screenshot if required.
7. Choose which Student Journals to send the screenshot to from the Send To drop-down list (all connected Students or the currently selected Students).

Add a note or screenshot to the Journal at the Student
Students can add their own notes and screenshots to their Journal.

1. Click the Journal icon on the Student Toolbar and select Add notes to Journal.
   Or
   Right-click the NetSupport School Student icon on the system tray and
select **Add Notes to Journal**.
Or
Click the NetSupport School Student icon on the system tray and choose **{Commands}{Add Notes to Journal**} from the drop-down menu.

2. Enter the required note and/or screenshot, following steps 3-5 above.
3. Click **OK**.
4. The note and/or image will be added to the Student Journal.

**Note:** Students cannot add notes if the Student Toolbar and Student icon are not visible.

---

**Add the student register to the Journal**
The student register can be added to the Tutor's Journal.

1. Select the Journal tab in the ribbon and click **Student Register**.
   Or
   Select the Class tab in the ribbon, click the **Student Register** icon and choose **Student register**.

**Add the Approved Websites list to the Journal**
1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click **Websites**.
3. Enter a note if required, and choose whether to send to all connected or the currently selected Students.
4. Click **OK**.

**Note:** If you haven't set up an Approved Websites list in the Web Control module, the Website Properties dialog appears, allowing you to add a website to the list.

---

**Add the target word list to the Journal**
You can add a target word list to the Journal.

1. Select the required Students in the List view.
2. Select the Journal tab in the ribbon and click **Word List**.
3. Enter a note if required and choose whether to send to all or the currently selected Students.

**Note:** If you haven't already created a word list in Keyboard Monitoring, you are prompted to add the target words. Click **OK**.

4. Click OK.
Add the survey results to the Journal
If you have conducted a Student survey, you can add the results to the Journal.

1. Select the Journal tab in the ribbon and click Survey.
2. A message will appear advising that the results have been added.
3. Click OK.

Add the contents of the interactive whiteboard to the Journal
1. Select the Journal tab in the ribbon and click Whiteboard.

   **Note**: This option is only active if the whiteboard is being shown to Students.

2. Enter a note to be added with the whiteboard image if required.
3. Click OK.

Add a chapter to the Journal
Chapters can be added, allowing the Journal to be organised into sections. Each chapter starts on a new page.

1. Select the Journal tab in the ribbon.
2. In the Chapter section, enter a name for the chapter and click Add.
3. Items are now added to the new chapter.

Remove an item from the Journal
You can remove the last item added to the Journal.

1. At the Tutor, select the Journal tab in the ribbon and click **Undo last add**.

   Or

1. At the Student, right-click the NetSupport School Student icon on the system tray and select **Delete Last Journal Item**.

   Or

   Click the NetSupport School Student icon on the system tray and choose **{Commands}{Delete Last Journal Item}** from the drop-down menu.

View a Journal
1. Select the Journal tab in the ribbon and click **View Journal**.
**Note:** Students can view a copy of their Journal by clicking the **Journal** icon in the Student Toolbar and selecting **View Journal**.

**Print the Journal**
You can print a copy of the current Journal.

1. Select the Journal tab in the ribbon and click **Print**.

**Synchronise Journals**
You can synchronise the Tutor Journal with the Students to ensure the Student Journals are up-to-date. Any items that are missing will be added to the Student Journals, this will not affect any information that the Student has added.

1. Select the Journal tab in the ribbon and click **Synchronise**.

**End the current Journal**
1. Select the Journal tab in the ribbon and click **Stop**.
Lesson planner
A NetSupport School lesson plan enables a Tutor to structure a session around a pre-defined set of tasks with appropriate timings and prompts allocated to each part of the plan.

Common NetSupport School functionality can be built into the plan, such as run test, send/collect work, scan and show.

To create a lesson plan
1. Select the Work Planner tab in the ribbon and click Manage Plans. Or
   If displayed, click the Show the Lesson Planner icon on the Lesson Plan bar.
2. The Lesson Plan window appears.

3. To create a new lesson, click New Plan on the toolbar or, to re-load a saved lesson, click Open Plan.
4. From the Available Items list, drag the required task and drop it into the window. Enter any additional properties that are required. You can edit and move tasks in the lesson plan using the appropriate icons on the toolbar.
5. If required, enter the author and a description for the lesson plan.
6. Click Save Plan and enter a name for the plan.
7. Click Save.
8. The Lesson Plan window will display the lesson content, total time, author and description of the lesson.
9. To start the currently loaded lesson, click OK and then Yes or click Cancel to close the window.

Running a lesson plan
1. Select the Work Planner tab in the ribbon and click Execute Plan.
2. Select the required lesson plan and click Open.
3. A cut-down version of the Lesson Plan window appears, showing the tasks included in the plan.
   
   **Note:** You cannot edit the tasks in a lesson plan from here.

Managing a lesson plan
When a lesson is activated, a progress bar will appear at the Tutor. The Tutor will be prompted before each task is due to begin and they can choose whether to continue or abort. At any point during a task, you can use the tools on the Lesson bar to pause, skip to next item or abort the lesson.

Lesson timer
You can have a timed session without running a pre-defined lesson plan.

**Notes:**
- Students running pre-version 15.00 won't show the lesson timer.
- You can also set the time that the lesson ends in the Class wizard.

1. Click the Lesson Timer icon on the caption bar (if this is not displayed, you can add it by clicking the Configure Quick Access List icon and selecting Show the lesson timer).
2. Select the lesson duration (15, 30 or 45 minutes) or you can enter your own time in the field. Click Start.
3. A timer appears on the caption bar and the Student Toolbar.
4. Click the timer to add an extra ten minutes, pause or stop.
Student Toolbar

The Student Toolbar provides feedback to the Student on the current lesson, time remaining, current websites and applications that are available, the status of print, audio and keyboard monitoring and quick access to initiate a Chat session and request help. Students can also access their USB memory stick, Student Journal, work items that have been sent and any resources from the toolbar. It can be set to be always visible at the top of the Student screen or to auto-hide.

All features included on the toolbar can be customised by the Tutor. To select the features available on the toolbar, click Options in the Tutor Console, select Settings from the drop-down menu and choose Student Toolbar.

The toolbar is enabled by default and set to always visible. Alternatively, if the toolbar is not always set to be visible, the Student can mouse over the top of their screen to make it appear. If the Tutor changes a setting that affects a toolbar option, a message will appear. For example, enabling internet restrictions.
**Note:** You can quickly show/hide the Student Toolbar by selecting the View tab in the ribbon and selecting the **Student Toolbar** option.

The following toolbar options can be turned on or off as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the image associated with this Student.</td>
<td>Displays the Student icon image.</td>
</tr>
<tr>
<td>Shows the Students logged on user name or the name entered on the Student Register.</td>
<td>Shows the Students logged on user name or the name entered on the Student Register.</td>
</tr>
<tr>
<td>Class and teacher information.</td>
<td>Displays details of the current class, teacher name, subject and room.</td>
</tr>
<tr>
<td>Show amount of time left in the lesson.</td>
<td>If a timed lesson is in progress, indicates the time remaining.</td>
</tr>
<tr>
<td>Indicate when typing is being monitored.</td>
<td>Advises the Student when keyboard monitoring is active.</td>
</tr>
<tr>
<td>Shows the current printer status (blocked, paused etc).</td>
<td>The Students will see the current printer status.</td>
</tr>
<tr>
<td>Show Application Monitoring status and give access to approved applications.</td>
<td>Indicates to Students the current status of Application Monitoring, restricted or unrestricted access. If restrictions apply, the list of approved applications will be displayed when Students click the <strong>Toolbar</strong> icon.</td>
</tr>
<tr>
<td>Show Internet Monitoring status and give access to approved websites.</td>
<td>Indicates to Students the current status of Internet Monitoring, restricted or unrestricted access. If restrictions apply, the list of approved websites will be displayed when Students click the <strong>Toolbar</strong> icon.</td>
</tr>
<tr>
<td>Allow the Student to initiate a Chat.</td>
<td>Enables the Student to initiate a Chat session.</td>
</tr>
<tr>
<td>Allow the Student to send a request for help.</td>
<td>Enables the Student to send a help request to the Tutor.</td>
</tr>
<tr>
<td>Show clock.</td>
<td>Displays the time and date.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show rewards.</td>
<td>Shows any rewards that have been given to the Student.</td>
</tr>
<tr>
<td>Show objectives.</td>
<td>If lesson objectives have been set, they will be displayed.</td>
</tr>
<tr>
<td>Show CD/DVD/USB device restrictions status</td>
<td>Allows Students to access their USB memory stick from the Toolbar and display any device restrictions.</td>
</tr>
<tr>
<td>and provide shortcut to USB memory stick.</td>
<td></td>
</tr>
<tr>
<td>Allow Students to access their Journal.</td>
<td>Allows Students to view and add notes to their Journal from the Student Toolbar.</td>
</tr>
<tr>
<td>Allow Students to access resources (applications, websites, documents or folders) that you define.</td>
<td>Allows Student to access any resources you have defined from the toolbar.</td>
</tr>
<tr>
<td>Show when you are listening to or recording the audio at the Student.</td>
<td>Advises Students when they are being listened to or if you are recording their audio.</td>
</tr>
<tr>
<td>Show list of files sent to work on.</td>
<td>Displays the files that have been sent via the Send/Collect work feature. The Student can work through these and indicate when they have been completed.</td>
</tr>
</tbody>
</table>

**Note:** A Tutor Toolbar is also available, this provides access to key NetSupport School features when the Tutor program is minimised.
**Student rewards**

NetSupport School provides the Tutor with the ability to 'reward' Students for good behaviour. During a lesson, a Tutor can give individual Students a reward, in the form of a star, which is reflected on the main toolbar. The number of rewards a Student has can be viewed by mousing over the Student icon in Normal view.

**Note:** The Student Toolbar must be switched on to use this feature.

**Giving rewards to Students**

1. Select the required Student in the List view.
   - Select the Feedback & Wellbeing tab in the ribbon and click **Give Reward**.
   - Or
   - Right-click an individual Student and select **Give a Reward**.
2. A star will appear on the Student Toolbar.

**Note:** If a Student Journal is active, the reward is automatically added to it.

**Removing rewards**

1. Select the required Student in the List view.
2. Select the Feedback & Wellbeing tab in the ribbon and click **Remove**.
   - Or
   - Right click an individual Student and select **Reward**.
3. A star will be removed from the Student Toolbar.

**Notes:**

- If a Student Journal is active, an entry is added to show that the reward has been removed.
- All rewards can be removed from a Student by selecting the Feedback & Wellbeing tab in the ribbon and clicking **Remove All**.
**Student stickers**

NetSupport School allows you to send animated stickers to Students recognising students' good behaviour. During a lesson, you can send a sticker to individual Students, which is reflected on the Student Toolbar.

**Notes:**
- The Student Toolbar must be switched on to use this feature.
- This feature is only available for Windows Students running v15.00 or higher.

**Sending a sticker**
1. Select the Student(s) in the List view.
2. Select the Feedback & Wellbeing tab in the ribbon.
3. A selection of stickers is available to choose from. Select the required sticker from the gallery (click the **Show drop-down** icon to see all stickers in the gallery) and click **Send Sticker**.

4. A large version of the sticker appears on the Student screen before animating to the Student Toolbar.

**Note:** If a Student Journal is active, the sticker is automatically added to it.
Configuring the Student machine

NetSupport School Students are configured using the NetSupport School Student (Client) Configurator from the NetSupport School Program Group.

**Note:** A search bar is provided at the top of the window, allowing you to locate the settings you're looking for. Type in the search bar (you can enter a full or partial term) and click the **Search** icon. Any sections containing the search term will be highlighted. Click the **Close** icon to close the search.

The Student Configurator has eight options:

**Network settings**
Set the network transport that the Student will use for communicating with the Tutor program. It must be the same as that set at the Student.

**Room**
Specify where to connect the Student when using Room mode.

**Security**
Set passwords to protect the configuration and prevent unauthorised access to the Student machine.

**Audio**
Set the audio settings for the Student. Both the Student and the Tutor machines must have audio hardware installed in order to use NetSupport School’s audio features.

**User Interface**
Customise the interface between the Student and Tutor.

**Advanced**
Set a personalised Student name and the behaviour of certain remote control features.

**Student Journal**
Customise the settings for the Student Journal.

**Terminal Services**
Allows you to configure the Terminal Services settings for the Student.
**Network Settings**

Allows you to set up the network transport for a Student. It must be the same as that set at the Tutor.

**TCP/IP**

*Port*

The TCP/IP protocol requires that a port number be allocated for applications to communicate through. The default registered port for NetSupport School is 5405.

**Send Keep Alive Packets**

Some TCP stacks send Keep Alive Packets. In some circumstances, it may be desirable to disable this. For example, on an ISDN line where a TCP/IP client is loaded a symptom may occur where the ISDN line is brought up unintentionally.

**Use Name & Connectivity Server (Gateway)**

Enable this option if you want the Students current IP address to register with a designated 'NetSupport Connectivity Server/Gateway' on start up. Click **Configure** and enter the IP address of the Connectivity Server along with the matching security key.
**Multicast address**
This is the IP multicast address that the Student is listening on.

**Notes:**
- If you are using routers, you must ensure that they are configured to pass through data using this port.
- Changing port could interfere with other TCP/IP applications.

Click **Test** to check that the protocol is correctly installed on this machine.

**Room settings**
Allows you to specify the room settings for Students when connecting via Room mode.

![NetSupport School Client Configurator](image)

**This Computer is always located in the following room:**
If the computer is always located in the same room, select this option and enter the required room.
This is a mobile computer and may be in one of the following rooms:
Select this option if the computer could be located in different rooms, enter the required rooms and separate each value with a comma.

This is a mobile computer and its room will be entered manually
Select this option if the computer is a mobile computer. The Student will then have an option from the Student icon in the taskbar to manually enter the room.

Display available rooms
A list of available rooms will be displayed, allowing Students to choose which one to connect to.

Note: If the Student icon is hidden in the taskbar, the Student can still manually enter the room by running the setroom.exe. This file is located in the NetSupport School Program folder on the Student machine.

Security settings
This option is used to set security at the Student.
**Student Security**

**Security Key**
This sets a security key that must be the same as that set at the Tutor before the Tutor will be allowed to connect. This setting is optional. If there is no security key set here, any Tutor may connect, regardless of the security key set at the Tutor.

**Enable User Acknowledgement**
If enabled, a Remote Control session cannot take place until the Student has confirmed that they accept the link being made.

**Display Customisable Text**

**When Connected**
The message entered here is displayed at the Student machine when a Student connects to it.

**When Viewed**
The message entered here is displayed at the Student machine when it is being viewed by the Tutor.

**Configurator Security Settings**

**Configurator Password**
As an extra level of security, you can associate a password with a Configuration file. This prevents unauthorised amendment of this Student’s configuration. When the Configurator is next started, the user must enter the required password before being able to change any Student parameters in this Configuration file. Choose **Set**, to set your password.

**Enable user acknowledgement for Tech Console connections (applies to Tutor only installs)**
If enabled, the Tech Console will not be able to connect to a Tutor machine until the Tutor has confirmed that they accept the link being made.

**Don't apply central policies to this computer**
Any policy restrictions set in the Tech Console will not be applied at this Student machine.
Audio settings

Set the audio settings for the Student. Both the Student and Tutor machines must have audio hardware installed in order to use NetSupport School’s audio features.

Volume
Threshold microphone sensitivity.
Microphone volume of microphone.
Speaker volume of speakers.

Hook audio acceleration
Sets the hardware acceleration level for the Students.

Never
Leaves the acceleration level at full.

While Connected
The acceleration level will be moved to basic while connected.

Always
The acceleration level will be moved to basic.
User Interface settings
This option is used for customising the interface between the Student and Tutor.

![User Interface settings](image)

**Student icon**

**Quiet Mode**
If this box is checked, there will be no indication at the Student machine, that the Student program is loaded. This is useful for preventing Students from manually unloading or otherwise misusing the Student program.

**Request Help**

**Disable Request Help**
Prevents the Student user from being able to use the request help function.

**Hotkeys**
These are the keys that the user at the Student will need to press to obtain access to the Request help function. The default is ALT + Left Shift + Right Shift. Note that some keyboards do not recognise a three key combination so if you experience problems try changing to a two-key combination.
Menu Items

Disable Join Class
Prevents the Student from being able to use the Join Class function.

Disable Chat
Prevents the Student from being able to use the Chat function.

Disable Replay
Prevents the Student from being able to open Replay Files.

Disable Journal
Disables the Journal options in the NetSupport School Student icon on the taskbar. Students will still be able to access the Journal from the Student toolbar.
Advanced settings

This property sheet enables further personalisation of the Student’s configuration. A meaningful Student name can be used rather than the machine name, or you can specify a particular image to load when the Student’s keyboard and mouse are locked rather than use NetSupport School’s default.

Student Identification

Student name

This is the name that the Student will be known as on the network for NetSupport School purposes. It must be a unique name of up to 15 characters.

You should try to use a sensible naming convention to help you identify which machine is which. It is also important to prefix each name in a group of related Students with the same few characters, as this will be used when the Tutor connects to establish the workgroup. For example, you might start the name of each machine in the same room with the prefix CLASS1_. Then configure the Tutor to connect to all Students starting with CLASS1_ will avoid Student machines outside of this room being inadvertently connected and receiving a show.
You can use an asterisk (*) to cause the Student name to default to the machine name (also known as the computer name).

**Note:** Although internally the Tutor connects to Students by referring to their Student name, the user at the Tutor can configure the Tutor program to display a different name.

**While Viewed**

**Silent Mode**

Allows the Tutor to connect and view a Student without the Student’s knowledge. If Silent Mode is not selected the Student’s screen and mouse icon will flicker notifying the Student that a connection has been made and their screen is being viewed.

**Send Physical Fonts**

When a Windows Student is sending its screen to a Tutor, it passes the font information by reference to reduce the volume of data sent.

The Tutor refers to its own internal font mappings and uses the closest matching that it has to the one being displayed at the Student. In most cases, the same fonts will be available at both the Student and the Tutor and so what is displayed on the screen will appear identical.

However, there may be occasions when a close match cannot be found. In these cases, it is desirable that the Student sends the Tutor the full information that it requires to display the data in the same font.

Setting this option forces *TrueType* text to be sent as glyphs (i.e. character shapes), rather than character codes. This guarantees that they will be displayed correctly at the Tutor.

This will, however, impact on performance, especially on Dial-up lines, and is not usually required.

**Enable Screen Scrape**

NetSupport School’s favoured, and the most efficient, method for capturing screen data is to hook into the Video Driver of the machine being viewed. However, there may be occasions when this method will not work because certain applications bypass the driver. In these circumstances, you can enable ‘screen scrape’ mode in order to take a snapshot of the screen. Although this will have a greater impact on the network, it will at least provide an accurate representation of the Student’s screen.
Performance

Cache size
Screen data that has been recently sent to the Tutor by the Student is cached to improve performance. A larger cache improves performance, at the expense of using more memory at both the Student and the Tutor.

Setting this option enables you to tailor the cache size in order to achieve maximum performance. The Student and the Tutor use the same size cache, the lowest cache value will be used so you must ensure that you set this at both the Student and the Tutor for this to be effective.

Image Option

Image File
When a Student’s keyboard and mouse have been locked, a default image, nss_lock_image.jpg, appears on their screen. Alternatively, you may prefer to specify an image personal to your organisation.

Enable DVD Playback and Direct 3D support
NetSupport School uses the Microsoft Mirror Driver to capture screen data for view sessions. However, while hooked into the Mirror Driver it is not possible to play DVD’s. Therefore, if you do need the capability to play DVD’s, NetSupport School provides options which load and unload the Mirror Driver as required.

Except While Viewed
If checked, DVD support is enabled but will be disabled for the duration of a view session while the Mirror Driver is loaded.

Except While Connected
If checked, DVD support is suspended while a connection to the Student is in place.

Keyboard Filter Driver
Should you encounter any issues with your keyboard filter driver, we provide a choice of drivers to switch between. Select the required driver from the drop-down menu.
Student Journal settings

A Student Journal is provided allowing key information from the lesson to be stored in a portable PDF file. You can use these options to customise the settings for the Student Journal.

Margins (mm)
If required, you can adjust the top, bottom, left and right margins for the Journal.

Page Size
Select the required page size for the Student Journal.

Font Size (points)
Set the font size to be used in the Journal.

Jpeg Quality (0-100)
Allows you to set the quality of images in the Journal, this is set to 75 by default.

Journal Folder
Specify where you want the Student Journal to be stored.
Terminal Services settings
You can configure the settings for the Student Terminal Server here.

Note: Terminal Server and other thin clients, may not be configured to use the NetSupport School Name and Connectivity Server

Terminal Services Settings

Run Student in Console Session
Unchecking this option will stop the Student from running in a Console session.

Run Student in remote sessions
Unchecking this option will stop the Student from running in remote sessions.

Note: The above two options are not supported on Windows MultiPoint Server 2012.

Base Port
Enter the required base port number, the default value is 25405.
**Student name**
Enter the required name for the Student, if left blank a unique ID will be displayed (defaults to %CLIENTNAME%). When entering a Student name, you must include at least one environment variable, e.g. %computername%.

**Use lookup file to set room**
Checking this option allows you to allocate Students to different rooms when connecting via Room mode, a 'lookup file' containing the Student name and required room must be used. The ‘lookup file’ should be saved with a .csv extension and should be in the format “Student Identifier”, ”Room value”.

**Note**: For full instructions, please visit our Knowledge Base and refer to product article [Setting up NetSupport School to run in a Microsoft Terminal Server environment](#).
Configuring the Tutor machine

The NetSupport School Tutor is configured by clicking **Options** in the Tutor Console and selecting **Network Settings** from the drop-down menu.

**Note:** A search bar is provided at the top of the window, allowing you to locate the settings you're looking for. Type in the search bar (you can enter a full or partial term) and click the **Search** icon. Any sections containing the search term will be highlighted. Click the **Close** icon to close the search.

The Tutor Configurator has the following options:

**Start Options**

Allows you to specify the start-up options for the Tutor and also set the level of access for the various modes.

**Network and Wireless Settings**

This is used for setting the network transport that the Tutor will use for communicating with the Student program. It must be the same as that set at the Student. You can also set the name and description for the Tutor.

**Performance**

Allows you to set low bandwidth and colour reduction settings to lower data sent across the networking when performing a View or Show.

**Student Selection**

This is used to specify the mode to connect to Students when the Tutor program starts.

**Administration**

Enables you to set an additional password if the Configuration options are to be protected and to create pre-defined Tutor profiles.
Start Options
Use these options to specify the start-up options for the Tutor.

At Start-up

Start Viewing
If this box is checked, when the Tutor initialises, it will connect to all Students and immediately start viewing them. You can choose which mode to view the Students in: Share, Watch or Control.

Start Showing
If this box is checked, when the Tutor initialises, it will connect to all Students and immediately start showing the Tutor’s screen to them.

Start Scanning
If this box is checked, when the Tutor initialises, it will connect to all Students and immediately start scanning them.

Display Class Wizard
If this box is checked the Class wizard will appear at start-up.
What best describes your environment?

All your students are within a MultiSeat thin client environment
If you are connecting to students within a MultiSeat thin client environment, you may want the NetSupport School Tutor to display only the features that apply to these Students.

All your students are using Tablets
If you are connecting to students using tablets, you may want the NetSupport School Tutor to display only the features that apply to these Students.

All your students are using Chromebooks
If you are connecting to students using Chromebooks, you may want the NetSupport School Tutor to display only the features that apply to these Students.

All your students are using Windows 10S
If all your students are using Windows 10S, you may want the NetSupport School Tutor to display only the features that apply to Windows 10S Students.

Selecting one of these options will provide you with a cut-down version of the NetSupport School Tutor.

Note: A restart of the NetSupport School Tutor will be required each time a change to these options is made.
Tutor start-up restrictions

Access levels and restrictions for NetSupport School features can now be defined at start-up, ensuring they come into force as soon as the Tutor is started.

![Settings for Configuration: NetSupport School]

Apply global policy
Applies the global policy restrictions that have been created in the Tech Console.

Applications
Set the level of access for the Application Control Module.

Apply global policy
Applies the global policy restrictions that have been created in the Tech Console.

Print
Choose the level of access for the Printer Management mode.

Use global policy
Applies the global policy restrictions that have been created in the Tech Console.
Devices (CD/DVD/USB)
Choose the level of access for the Device Control mode.

Use global policy
Applies the global policy restrictions that have been created in the Tech Console.

Webcam
Choose whether to allow or block access to webcams at Student machines.

Audio
Enable Audio monitoring or mute audio at the Students machines.

Typing
Choose whether or not to monitor Students keyboard usage in Keyboard Monitoring mode.
Network and Wireless Settings
This is primarily used for setting the network transport that the Tutor will use for communicating with the Students. It must be the same as that set at the Students. You can also set the name and description for the Tutor.

**Tutor Identification**
Use these options to personalise the Tutor machines configuration.

**Name**
This is the name by which the Tutor will be known on the network. Setting it to an asterisk defaults to the machine or computer name.

**Description**
This is used to provide a description for the Tutor program itself. This is displayed in the Title bar of the Student program.
**TCP/IP Settings**

**Connect by Hostname** (DHCP/WINS networks)

Normally, the Tutor connects to a Student by IP address rather than by name. In an environment that uses DHCP (Dynamic Host Configuration Protocol), this may be undesirable as the address may change when the Student machine is restarted. Checking this option forces the Tutor to connect by hostname.

**Port**

The TCP/IP protocol requires that a port number be allocated for applications to communicate through. The default registered port for NetSupport School is 5405.

**Note:** If you are using routers, you must ensure that they are configured to pass through data using this port.

**Include Chromebooks**

NetSupport School provides support for Google Chromebooks. This option includes Google Chromebooks when performing a search.

**Note:** The IP address of the Connectivity Server/Gateway along with the matching security key needs to be entered - click **Settings**.

**Use Name & Connectivity Server (Gateway)**

Enable this option if you want to search for Students whose IP addresses are registered with a defined NetSupport Connectivity Server/Gateway. The currently configured browse at Start-up option will still apply, but rather than perform a UDP browse of the network, the Tutor program will search the Connectivity Server for Students matching the specified criteria. Click **Settings** and enter the IP address of the Connectivity Server/Gateway along with the matching security key.

**Note:** When using the Name & Connectivity Server, please ensure **Connect By Hostname (DHCP/WINS)** is disabled to avoid conflicts.

**Browsing**

**Subnets used when browsing for students**

When you are running a network with multiple subnets or addresses, you need to configure the broadcast addresses for each effective network. When a browse is performed, the broadcast messages are sent to these addresses.
Accelerate Browse
Increases the browse and connection speed to Students. This is set by default.

Note: A warning icon will highlight machines you have been unable to connect to. Mouse over the icon to display the reason why the connection failed.

Broadcast Settings
Enable Broadcast Show and File Distribution
When performing a show or distributing files to Students, the screen information/files are sent to each Student machine in turn. Enabling Broadcast Show and File Distribution results in the screen information and files being sent to all machines simultaneously. In some network environments, where there is limited network bandwidth available or when broadcasting to larger numbers of machines, this will provide significant performance benefits.

Whilst reducing overall network traffic generated by NetSupport School, using this feature will generate additional broadcast packets on your network. It is recommended that you consult your network administrator before using this feature.

Note: Show and File Distribution can be sent using multicast instead of UDP/broadcast. This means that the multicast packet will only be sent to machines included in the specified IP multicast address. Select Use Multicast to switch to this method.

Settings
If the Broadcast Show and File Distribution option is enabled, select this option to set the multicast or broadcast address. The Broadcast Settings dialog will appear. If multiple Tutors are attempting to use UDP/Broadcast Show simultaneously on the same subnet, it is recommended that each uses a unique port to avoid conflict.

Wireless Network
Check this option in order to optimise Show performance across a wireless network.

Note: NetSupport School will automatically detect any wireless Students and enable this option to improve performance.
**Maximum throughput**
Controls the level of data sent across the network to your wireless access point. The default data rate is 8 Mbps. If required, this can be altered to reflect the speed of the router.

**Note:** When a Tutor detects wireless Students or is itself wirelessly connected, it will automatically reduce the maximum data output to whatever has been configured in the Maximum throughput settings, regardless of whether the wireless network checkbox has been selected. This behaviour cannot be turned off.

**Deploy**
Opens the NetSupport School Basic Deploy dialog, allowing you to deploy Student software to PCs in a particular room.
Performance settings

Allows you to set low bandwidth and colour reduction settings to lower the amount of data sent across the network.

**Performance**

**Low bandwidth mode**

This mode is designed for network environments where low data usage is a priority. When enabled, video performance will be reduced to limit network activity.

Select the mode from the drop-down list: Never, Always or Wireless. The Wireless option will automatically turn on low bandwidth mode when wireless students have been detected.

**Colour reduction**

**View**

Allows you to select the maximum colour depth when viewing Students. By default, this will be set to 256 (high) colours.
Show
Allows you to select the maximum colour depth when showing to Students.

**Note:** These options will have negligible visual impact when remotely viewing or showing applications but may be seen when viewing or showing multimedia. Typically, these options should be applied only when network utilisation is a priority.

**Student Selection**

Use these options to pre-determine the Students to connect to when the Tutor program starts and in what mode.

**Note:** If a 'NetSupport Connectivity Server/Gateway' has been configured, the Tutor program will use the details registered here rather than perform a browse across the network.

**Room Mode**

**Connect to Students in Room(s)**

Allows you to connect to the machines in a given room. Specify the room you wish to connect to. Multiple rooms can be entered (separate each value with a plus symbol), one class will be created containing the rooms.
Select from a list of rooms
Allows you to choose from a list of rooms to connect to at start-up. Enter the required rooms and separate each value with a comma.

Prompt at startup
Allows you to specify an ad-hoc room to connect to in the Class wizard.

Acknowledge Roaming Students
Allows roaming Students to connect to your room.

Note: The Room settings can be configured at the Student in the NetSupport School Student Configurator.

Browse Mode
Browse and connect to Students starting with
If this box is checked NetSupport School will browse and immediately connect to all Students starting with the prefix set in the text box.

Fixed List Mode
Connect to a List of Students
Allows you to connect to a fixed list of Student computers by machine name.

This is a list of student user names
Select this option if you are connecting to a list of Student logged on user names.

Note: You can set the list of Student machine/user names in the Class wizard.

SIS Mode
Connect to SIS
Allows you to connect to your SIS data. The NetSupport Connectivity Server needs to be synced with OneRoster/Google Classroom to use this connection method. Once connected, select the required school name from the drop-down list.
Notes:
- If the expected Students are not found, it may be because NetSupport School has not been configured to browse the required networks. See Configuring NetSupport School for Subnet Browsing for more information.
- If connecting to Students via the Name & Connectivity Server in Room mode, it is necessary to set the Name & Connectivity Server settings at the Tutor in both the Tutor Configurator and the Student Configurator.

Administration - Security settings

Protect the Configuration

The Tutor Configuration can be protected by setting a password. This acts independently of the Tutor password if set.

Check the Protect box to set the password.

Each time a Tutor user subsequently wants to make changes to the configuration, they will be prompted to enter the password.
Options
Password
Setting a password will mean that the next time the Tutor program is started the user will be prompted to enter a password. If they do not enter the correct password, they will not be able to start the Tutor.

Security Key
You can set a security key that will ensure that only Tutors and Students with matching keys are able to connect. Setting an asterisk * defaults the security key to be the same as the serial number. Note that this must set at both the Tutor and the Student. If a security key is set here, this Tutor will only connect to Students with the same, or no, security key.

Redirect URL
Allows you to specify the URL that Students will be redirected to if they try to access restricted websites.

Shared Data
Checking this option allows you to share data files with other users.

By default, on a new install, this option will be disabled.
By default, on an upgrade, this option will be enabled.
Administration - Profiles
This property sheet enables you to add, edit or delete Tutor Profiles.

After creating, for example, an approved or restricted list of websites and applications, you can add the files containing this information to a Tutor Profile. On entering the Tutor program, the user simply selects the required profile to load the pre-defined settings. See the Tutor Profiles section of this manual for more information.

- Click **Add** to create a new Tutor Profile.
- To remove a profile, select the profile name and click **Delete**.
- To choose the files to include in a new or existing profile, select the profile name and click **Edit**.

The following areas of the product can be profiled. Click **Change** and browse for the appropriate files to include in the Tutor Profile.

**File Locations**
**Applications File**
Contains details of approved and restricted application packages. The default file name is NetSupport School.app. See Application Control
Module for more information about creating pre-defined lists of approved or restricted applications.

**Web Site File**
Contains details of approved and restricted websites. The default file name is NetSupport School.web. See Web Control Module for more information about creating pre-defined lists of approved or restricted websites.

**Survey File**
Identifies the location of stored Student Surveys. The default file name is NetSupport School.sul. See Student Surveys for more information.

**Layout File**
Stores the position of the Student machines as they appear in the Tutor Console and, if specified, a background image. The default file name is LAYOUT.LYT. See Working with Classroom Layouts for more information.

**Word List File**
Contains details of target and inappropriate keywords. The default file name is NetSupport School.wdl. See Keyboard Monitoring for further information.

**Folder**

**Testing Console Report Folder**
Specify a location for storing test results.

**Testing Console Exam Folder**
Specify a location for storing exams.

**Class List Folder**
Specify a location for storing Class Lists.

**Journal Folder**
Specify the location for storing Student Journals.

**Audio Recordings Folder**
Specify the location for storing audio recordings.

**Advanced**
Pre-defined Student and Group lists can also be included in a Tutor Profile, but these aren’t enabled by default. Before deciding to apply
these to a profile, consider the current method of browsing for Students on start-up as you may not want to override this.

**Client File**
Contains a list of Known Client machines that the Tutor program attempts to connect to when loading. The default file name is CLIENT.NSS. See Class lists for more information.

**Group File**
Contains the details of any Student Groups that have been created. The default file name is GROUP.NSS. See Working with Groups for more information.

**Use shared data files**
Checking this option allows you to share data with other users.
Configuring Remote Control Settings

NetSupport School provides a range of customisable options enabling you to tailor each Remote Control session to suit specific requirements and conditions.

The Tutor has the option of applying settings globally or, in some instances, at individual Student level.

To adjust global configuration settings
1. Click Options in the Tutor Console and select Settings from the drop-down menu.
2. The following options are available:
   - Remote Control
     - View
     - Keyboard/Mouse
     - Replay Files
     - Audio
   - Chat
   - File Transfer
   - User Interface
     - Tutor
     - Student
   - Tutor Assistant
   - Group Leaders
   - Student Toolbar
   - Journal
   - Show

3. Configure the required options.

   **Note:** A search bar is provided at the top of the window, allowing you to locate the settings you're looking for. Type in the search bar (you can enter a full or partial term) and click the Search icon. Any sections containing the search term will be highlighted. Click the Close icon to close the search.

4. Click OK when complete. The selected settings will apply to all Students and will automatically be saved for future Tutor sessions.

To adjust settings for individual Students
The View, Keyboard/Mouse, Replay Files and Audio settings can be customised for individual Students.
1. View the required Student.
2. Click the Settings icon on the caption bar.
3. The Settings dialog will appear, select the relevant option, View, Keyboard/Mouse, Replay Files or Audio.
4. Configure the options to be enabled or disabled during the View session.

**Note:** If you want to change the settings permanently, check the Update Configuration NetSupport School box.
Tutor View settings

This option provides configuration options for the viewing of Student machines.

The View settings can be configured in two ways:
1. To apply the settings for all Student View sessions, click **Options** in the Tutor Console, select **Settings** from the drop-down menu and choose **View**.
2. To apply the settings for an individual Student View session, click the **Settings** icon on the View window caption bar and select **View**.

![Settings for Configuration: NetSupport School](image)

**A brief description of the available options follows:**

**BIOS Keyboard**
Checking this option causes the Tutor to emulate keystrokes on the Student, at the BIOS level rather than the hardware level. Use this if an application at the Student does not appear to be correctly accepting keystrokes from the Tutor. Only use this option if you are experiencing problems with the default low-level keyboard option.
Confirm Switch to Full Screen
When this box is checked, you will be prompted to confirm switching to full screen mode.

Full Screen
Checking this option will force the Tutor to view a Student in full screen mode rather than in a windowed mode.

Scale to Fit
Check this option if you want the contents of the View window to be automatically shrunk to fit the sizeable frame.

Disconnect when closed
Check this option to disconnect from a Student when a View window is closed.

Screen Scrape
NetSupport School’s favoured (and the most efficient) method for capturing screen data is to hook into the Video Driver of the machine being viewed. However, there may be occasions when this method will not work because certain applications bypass the driver. In these circumstances, you can enable screen scrape mode in order to take a snapshot of the screen. Although this will have a greater impact on the network, it will at least provide an accurate representation of the Student’s screen.

Scrollbars
You can turn off scrollbars on the view windows by checking this option. This is useful when using auto-scroll, as you gain a little extra workspace.

Use Compression
Check this box to enable compression when viewing a Student’s screen. The state of this checkbox is also reflected in the Client Properties.

Wallpaper
Check this box if you want the Student’s wallpaper to be visible when viewing. Normally this is turned off to improve performance, so expect the screen update speed to be impacted by selecting this option.

Blank Client screen
This enables the Tutor to blank the Student screen in any of the View modes.
**Note:** This feature is only available on Students running Windows 10 v2004 and above (legacy support is provided for Students running Windows 8 and below).

**Video Skipping**
A Tutor’s viewing performance can be configured using video skipping. The Tutor program will not display Student screen updates if a subsequent update to the area of the screen is made. Unticking the box will result in all Student screen updates being displayed at the Tutor.

**Auto Clipboard**
When enabled, provides the quickest method for copying data. Use the short cut keys (Ctrl-C & Ctrl-V) to automatically copy to and from the clipboard at both the Tutor and Student machines.

**Default Mode**
When you view a Student, by default, you start viewing in Share mode. If you prefer to start viewing in a different way, change the style from the list provided.

**Cache Size**
The NetSupport School Tutor contains a cache to help improve overall performance. The cache sizes range from 256KB to 16Mb and a separate cache is allocated to each Student connection. If you are running applications on the Student that use lots of or large bitmaps, increase the cache size to improve the performance.

**Max Colour Depth**
When you connect to a Student, you can restrict the colour depth that is sent. This is done to reduce the amount of traffic between the Student and Tutor.

**Change DOS Font**
Use this dialog to select the font to use when displaying DOS screens. This will be from Windows Students running full screen DOS boxes. Windows uses a graphic character set for displaying DOS screens. The higher the resolution that you are running Windows in the larger the font size you will need to set to get an accurate representation of a DOS screen.

**Change Japanese Font**
Use this dialog to select the font to use when displaying Japanese DOS screens.
**Tutor Keyboard/Mouse settings**

![Image of the Tutor Keyboard/Mouse settings window]

#### Keyboard Layout
- **International keyboard**
  
  An international keyboard layout will be used at the Tutor during a view session.

To specify a different keyboard layout to be used at the Tutor while viewing, select the required layout from the drop-down list. Select from the list provided a keyboard layout to be used at the Tutor while viewing. These layouts map keys on the Tutor to keys on the Student machine. If both Student and Tutor are using the same keyboard layout, you should select **Unmapped Keyboard** from the list.

#### Hotkeys

- **Hotkeys**
  
  When you are viewing a Student in full screen mode, hotkeys provide a way of returning to the possibly hidden user interface. If the screen resolution at the Student is smaller than the resolution of the Tutor, you can simply click your mouse button outside the View window to stop viewing and display the view window again. Check the boxes in this group to determine the keys that are used as hotkeys.
**Autoscroll Speed**
When you are viewing a Student’s screen, the Tutor can automatically scroll the contents when the mouse moves close to the edges of the window. Adjusting the sliding control sets the speed at which the view scrolls, from not at all to very fast.

**Scroll Delay**
When auto-scroll is enabled, you can change the delay before the scroll is activated. If you want the view to scroll as soon as the mouse is at an edge of the screen, move the slider towards **Min**. If you prefer a longer delay before the auto scroll takes effect, move the slider towards **Max**.

**Mouse Delay**
Adjusting the mouse delay allows you to reduce the rate at which mouse updates are sent from the Tutor to the Student when controlling or sharing. Move the slider control towards **Infinite** to reduce the rate and conserve bandwidth, or towards **Min** for the best mouse response. This is useful on dial-up or very slow networks.

**Disable Num Lock Synchronisation**
Check this option if using a laptop as the Tutor machine to ensure that the keyboards behaviour corresponds with that of a standard desktop machine.
Replay File settings

The Replay Files feature enables the Tutor to record and play back the screen activity that takes place at a Student machine while it is being remote controlled/viewed.

Record Replay Files
Check this option to enable the recording of Replay Files. A Replay File will be created each time the Tutor opens a view session at any Student machine.

Include Audio
In addition to the screen, mouse and keyboard activity, if the machine is configured for audio, you can record any microphone narration from the Tutor.

Note: Desktop sounds, music are unable to be recorded.

Prefix Files with Client name
In order to identify each Replay File, file names are prefixed with the Client name and the date/time of the recording. Alternatively, by
unchecking this box, the files will be named sequentially in the format 00000001.rpf etc.

**In Folder**
Specify where the Replay Files should be stored.

**Audio settings**
Provides configuration options for using audio support.

The audio settings can be configured in two ways:
1. To apply the settings for all Student sessions, click **Options** in the Tutor Console, select **Settings** from the drop-down menu and choose **Remote Control - Audio**.
2. To apply the settings for an individual Student session, go to the Audio tab in the View window ribbon and click **Audio Settings**.

**Volume**
- Threshold: Microphone sensitivity.
- Microphone: Volume of microphone.
- Test: Tests all of the above settings (this is only available when applying settings to all Student sessions).
Enable
On       Turn audio on.
Off      Turn audio off.
Talk only Turn the Tutor audio to talk function only.
Listen only Turn the Tutor audio to listen function only.

Selecting the **Change transmission format** buttons allows you to change the transmission format. Use only the level you need for acceptable quality. High quality settings can affect screen update performance.

**Tutor Chat settings**
A copy of all chat history can be saved to a .txt file.

![Settings for Configuration: NetSupport School](image)

**Auto save chat history**
Select to save all chat history automatically.

**Chat History Folder**
Click the **Browse** icon to specify the folder to store the chat history.
As User
If the path specified above is a UNC path, enter the user name and password.

Include teacher name in path
Allows you to include the teacher name in the path name.

Tutor File Transfer settings
You can configure the File Transfer settings in NetSupport School. Click Options in the Tutor Console, select Settings from the drop-down menu and choose File Transfer. Here you can alter the way in which information is displayed and set safety features such as confirmation before performing a damaging operation.

Display Options
Show System/Hidden files
Check this box to display all files with system and hidden attributes. By default, this option is unchecked.
Show file details
Select this option to display multiple columns of information for each file in the list. These show the file size, modified date, attributes and short file name. You can toggle between this state and the file names only state, by using the list style buttons in the File Transfer User Interface.

Show file names only
Select this option to only display file names in the file lists. This allows you to display more files at the same time than with file details. You can toggle between this state and the Details state, by using the list style buttons in the File Transfer User Interface.

Confirm
When you perform potentially dangerous file operations, such as deleting a folder or file, you can make the Tutor display a Confirmation dialog box. This helps prevent accidental loss of data. If you are familiar with the User Interface, you can turn these options off as required. By default, all the confirmation settings are turned on.

Folder copy
Make the user confirm before copying a folder structure.

Folder delete
Make the user confirm before deleting a folder structure.

File overwrite
If checked, displays a confirmation dialog before overwriting an existing file. However, if unchecked the confirmation message will still appear if system/hidden files are about to be overwritten.

File delete
Display a confirmation dialog before deleting one or more files.

Use Recycle Bin for local deletions (when available)
All files deleted from the local pane will be sent to the recycle bin, this is enabled by default.

Use Compression
Check this box to enable the use of compression. When you are communicating with a Student, whether it is a File Transfer, View or Chat session, the data being sent and received will be compressed. This also provides a means of security, as the data will also be encrypted.
Delta File Transfer
Delta File Transfer improves performance by skipping the transfer of information that is unchanged. If the file being transferred already exists in the destination folder, only the changed parts of the file will be updated.

Delta File Transfer is enabled by default.

Priority (when also viewing)
When you are transferring files and viewing a Students’ screen at the same time, each operation impacts the performance of the other. You can reduce the priority of a File Transfer operation to make the viewing more responsive and vice-versa. Slide the control to the left to give the File Transfer higher priority, or to the right to give Student views higher priority. If you are not viewing a Student, this setting is ignored.

Automatically close progress when copy finished
Closes the File transfer progress dialog automatically on completion. Un-tick this option if you want to see the File transfer results.
Tutor User Interface settings

Display Student User Names
Check this option to retrieve and display the login name of the Student on the Tutor Console when you perform a Student Register.

Remember Student user/login names
Check this option to save the Student user/login names in the Known Client list.

Display Student photos from Google Classroom
If you are integrating with Google Classroom and a photo is associated with the student account, you can choose to display the photo as the Student icon in the Tutor Console.

Silent Disconnect
Should a Student inadvertently disconnect from the Tutor during a session, a prompt appears at the Tutor machine. Check this option to disable this warning.
Automatically Reconnect to Students
Ensures that Student machines automatically rejoin a live remote control session should they inadvertently disconnect.

**On Exit**
**Save Student history**
Check this option to automatically save Internet, Application, Print and Typing history to a CSV file when the Tutor is shut down.

**Save Student Web history to Tutor Journal**
This option will automatically save Students' web history to the Tutor Journal when the Tutor is closed down.

**Show icons for restricted websites**
By default, the website icon for restricted websites is displayed. If you have numerous restricted websites, you may want to disable these icons, so you are not using excessive Windows Resources.

**Show Tutor Toolbar on minimizing**
When the Tutor program is minimised, the Tutor Toolbar will be displayed, providing access to key NetSupport School features. Uncheck this option to disable this.

**Show active Print Jobs**
Displays any active print jobs in all views.

**Show Student alert level**
Students can raise an alert from the Student Toolbar, the Student icon will change colour at the Tutor depending on the type of alert raised. This option enables you to show or hide these alerts.

**Use context colour in user interface**
By default, the colour used in the Tutor user interface changes to match the current view mode. Disabling this option allows you to turn this off and use the same colour throughout the user interface instead.

**Show wireless and battery status**
You can choose to display both the wireless and battery status or just show the battery level when it drops below 10%.
Message Prompts
Reset 'Don't show this again' prompts so you see them again
If you have turned off the message prompts when powering off, restarting or logging out Students, deleting a group or exiting the Tutor Console, you can enable them again here. Click Reset.

Student User Interface settings

Mute sound when locking mouse/keyboard or blanking screen
Sound will be muted at Students when locking the mouse/keyboard or blanking the screen.

Student to Student Chat
Check this option to enable Students to initiate a group Chat session with other connected Students.
Tutor Assistant settings
Configure the settings for the NetSupport School Tutor Assistant.

Tutor Name/ID
The name that appears at the Tutor Assistant. Selecting Custom allows you to enter your own name for the Tutor.

System Status
Shows the current system status. You can start and stop the system from here.

Start System when Tutor Starts
The system will automatically start when the Tutor starts.

Current Network Address
The network address for the Tutor.

Connection Port
Enter the port number. The default port is 37777.
Connection Password
Enter the password that Tutor Assistants will use to connect to the Tutor.

Show Password
Displays the connection password.

Authorised Assistants
Lists the Tutor Assistants that have been authorised to connect to the Tutor. You can remove or unauthorise the Assistants from here.

Assistants waiting for Authorisation
Lists the Tutor Assistants waiting for authorisation to connect to the Tutor. Click Authorise to approve the Assistant.

Automatic Authorisation
Tutor Assistants will be automatically authorised once they have entered the correct password.

Interactive Authorisation
Tutor Assistants will require manual authorisation to connect to the Tutor.
Group Leader settings

When working with defined groups of Students, the Tutor can assign Group Leader status to a selected member of the group.

![Settings for Configuration: NetSupport School](image)

Enable Group Leaders
Enables the Group Leader function.

Show visual Group Leader connections
Visual Group Leader connections can be displayed, allowing you easily see the link between a Group Leader and their Students in all views.

All Group Leader features are enabled by default but can be removed by un-checking the appropriate box.

Functions
Allows you to select the functions that are available to the Group Leader.
Student Toolbar Settings
Configure the settings for the Student toolbar.

Enable Student Toolbar
Enables the Student toolbar.

Make the toolbar always visible
Decide whether to make the toolbar always visible at the top of the Student screen or to auto-hide.

Toolbar options
Select the options that will be displayed on the Student toolbar.
Tutor Journal settings

A Journal is provided allowing key information from the lesson to be stored in a portable PDF file. You can use these options to customise the settings for the Journal stored at the Tutor. To customise the settings for the Student Journal, choose {Start}{Programs}{NetSupport School}{NetSupport School Student Configurator - Journal}. On Windows 8 and above machines right-click in the Start screen and choose All Apps at the bottom of the screen. Click the NetSupport School Student Configurator icon.

Enable Student Journal
Activates the Journal for the Students.

Enable Tutor Journal
If enabled, a copy of the Journal will be stored for the Tutor to view.

Tutor Settings
Margins (mm)
If required, you can adjust the top, bottom, left and right margins for the Journal.
Page Size
Select the required page size for the Student Journal.

Font Size (points)
Set the font size to be used in the Journal.

Jpeg Quality (0-100)
Allows you to set the quality of images in the Journal, this is set to 75 by default.

Journal Folder
Specify where you want the Student Journal to be stored.

Journal Logo
Allows you to add an image that will appear at the top of the Journal.
Show settings
The Show feature allows you to display the Tutor screen on all, some or one of the Student's screens. From here you can configure the settings for a Show.

Screen Scrape
NetSupport School’s favoured (and the most efficient) method for capturing screen data is to hook into the Video Driver of the machine being viewed. However, there may be occasions when this method will not work because certain applications bypass the driver. In these circumstances, you can enable ‘screen scrape’ mode in order to take a snapshot of the screen. Although this will have a greater impact on the network, it will at least provide an accurate representation of the Student’s screen.

Max Colour Depth
Allows you to select the maximum colour depth when showing to Students. By default, this will be set to 256 (high) colours.
Show Hotkeys
To ensure that all actions performed by the Tutor are visible to the Students during a Show, you can enable the use of hotkeys. Any key combinations that the Tutor uses, e.g. CTRL+V, will be displayed in a balloon at both the Tutor and Student screens.

Send Physical Fonts
In order to reduce the volume of data being sent when sharing information of this nature, NetSupport School passes the font information by reference. The target machine will refer to its own internal font mappings to find an appropriate match to the one that has been sent. In most cases, the same fonts will be available but if there are instances where this isn’t the case, you can send the full information. Check this box to enable.

Disable Touch Support at Student during Show
If the Students are using touch-enabled devices, you may wish to disable touch support whilst performing a Show.

Restrict Internet access to approved sites only during Show
Allows the Tutor to only access websites that are on the Approved Site List, preventing inappropriate websites being displayed to Students during a Show.
**Tech Console**

A classroom management solution is not simply about providing the right tools for each teacher; equally important are tools to ensure all computers in the school can be managed and maintained, so they are always available for teaching. With this in mind, NetSupport School provides a unique ‘Tech Console’ specifically for IT technicians and network managers.

The Tech Console provides a single view of all computers across the school, allowing technicians to review hardware and software inventory, monitor internet and application usage, apply ‘always on’ internet, application and printing policies and define security policies which all PCs across the school will be checked against to determine whether they are secure.

**Note:** The Tech Console can be installed with other NetSupport School components or as a standalone component.

To start the Tech Console, click the **NetSupport School Tech Console** icon in the Start screen or click the desktop icon if the option was selected during installation.
When the Tech Console loads for the first time, the Configuration dialog will appear. This enables you to specify the Clients to connect to at start-up. This dialog will not appear in future sessions but can be accessed by clicking Options on the right-hand side of the Tech Console and selecting Settings from the drop-down menu.

**Note:** If required, a message can be displayed at a Tutor machine when a connection is made. See Student Security tab for further details.

In the List view, the connected Clients can be viewed in two different ways. Thumbnail view displays a thumbnail of the Student screen, providing a quick and easy method for monitoring activity. Details view displays details of the Student machines, such as name, IP address, user name, Client platform, Client version, current security state, policy settings, room, running application and all websites.

The icon displayed next to the Student name in details view will change depending on the status of the Student. The available icons are:

- Grey PC = machine is off.
- Colour PC = machine on, no Tutor connected.
- Green user = Tutor is connected (Client is in a class).
- Brown user = Client is a teacher.

To toggle between views, select the View tab in the ribbon and click Details or Thumbnail, or click the Details or Thumbnail icon on the status bar.

If you are in details view, you can hide the Running Applications, All Websites and Client Version columns by clearing the required checkboxes in the View tab of the ribbon.

**Note:** From details view, you can activate and close applications and websites on a Student by right-clicking the required icon.

From the Status bar, you can resize the Client thumbnails using a convenient 'slider' bar, change the thumbnail refresh rate and automatically adjust the size of the displayed thumbnails to fit the window.

To allow you to differentiate between a Student and a Tutor, a Tutor icon is displayed next to the Tutor thumbnail. A connection bar showing
the link from the Tutor to the Students will also be displayed. You can manually set a machine to show as a Tutor machine; right click the required Student and click **Properties**. In the General tab, select the **This is a teacher's computer** check box.

The Tech Console brings together the main NetSupport School Tutor Console features:

- Monitor all computers across the school network in a single view.
- Monitor application and internet usage on each Client PC.
- Transfer files and folders to selected or all computers.
- Group all computers by classroom/physical location.
- Hardware/Software inventory.
- Use the Task Manager to view and manage applications, processes and services on the Student.
- Provide direct technical assistance to any classroom teacher.
- Power on/off classroom computers remotely.
- Reboot/logout classroom computers remotely.
- Automatically login computers.
- Display all Students and Teachers by active class.
- Review individual NetSupport School Student security settings remotely.
- Conduct Chat with one or multiple Students or Teachers.
- Broadcast messages to groups or all network users in seconds.
- Perform powerful 1:1 PC Remote Control on any selected computer.
- See real-time USB memory stick status on all Client PCs.
- Lock/unlock Clients’ keyboards and mice.
- Execute applications on Client PCs.
- Edit the registry of a remote system.
- Launch a local command prompt from the remote system on your PC.
- Launch a PowerShell window at the selected Client.
- Automatically connect to Students/Teachers using Room mode.
- Apply a school-wide set of internet, application, USB, CD/DVD and print restrictions.
- Easily find Student and Tutor machines using the search feature.
- Stop the NetSupport School Student running at the student machine.
- Create user-defined tools that can automatically run a task on a Tech Console machine.
- Manage files on a Tech Console using the File Manager.

NetSupport School allows teachers to request help from technicians. The Teacher Support feature is enabled by default and can be turned on and off by toggling the Teacher Support ☑️ toggle on the caption bar. A Support 📥️ icon is displayed on the Tutor Console caption bar. Clicking the icon allows the Tutor to either chat or send a message directly to the technician.
Searching for Students
You can easily find Student and Tutor machines using the search feature in the Tech Console. You can search by logged-on user name, machine name, IP address, running application or the active website.

1. Select the View tab in the Tech Console ribbon and enter the search term in the Search Text field. Click the required Search For icon:
   - Search by logged-on user name.
   - Search by PC name.
   - Search by IP address.
   - Search by the running application.
   - Search by the active website.

2. To make the search case-sensitive, click the Configure Quick Access List icon.
3. Click Search.
4. The search results appear in a new group on the group bar.

**Note:** You can remove the search results (and the group) by clicking the Close Search icon on the ribbon.
Stopping the Student service

There may be occasions when you need to stop the NetSupport School Student running at a student machine. You can stop the Student service from the Tech Console. Once this has been stopped, no further use of NetSupport School is available. You can stop the Student until the machine is restarted, specify how long the Student is stopped for before it's restarted or stop the Student until a specified time.

**Note**: If you have suspended the service for a set period or a specified time, restarting the machine does not cause the Student service to start unless the specified time has expired.

1. In the Tech Console, select the Student(s) or group to stop the Student service for.
   **Note**: Please ensure the correct machines are selected, as this can't be undone.

2. Select the Home tab in the ribbon and click **Stop Student**.

3. Choose the required option:
   **Student is stopped now and won’t be available until the machine is restarted**
   The Student service is stopped and won't be available until the machine is restarted.
**Student is stopped now and restarted after the specified number of minutes**
Suspends the Student service for a specified time. Enter the amount of time in minutes before the Student is restarted.

**Student is stopped now and restarted at the specified time**
Stops the Student service until the specified time. Enter the time the Student is restarted.

4. Click **Next**.
5. A summary of the option you have selected and the Student(s) this applies to is displayed.

6. Click **OK**.
7. A final confirmation appears. Click **Yes** to proceed.

**Limitations**
- This is only available for Windows Students.
- The maximum time you can stop the Student service for is 24 hours. If you need to stop the service for longer, the setting must be applied daily.
- In terminal server environments, it is not possible to stop the Student service for individual user sessions.
Remote inventory and system information
For many support teams an important part of the problem resolution process is knowing not only what platform the machine is running, but also its hardware specifications and the applications installed on the machine. For this reason, NetSupport School provides the tools to supply a full inventory of the remote machine.

In addition to its sophisticated hardware/software reporting, where a wealth of information is collected specifically about the hardware or environment of the Student PC, you can obtain details of installed hotfixes and use the Task Manager to view and manage applications, processes and services that are currently running.

As well as the real-time reporting, NetSupport School also provides the tools, security permitting, to allow you to remotely stop and start services, end applications and more.

**Note:** The Inventory is only available from the Tech Console.

To retrieve a Student inventory
1. Select the required Student icon in the Tech Console List view
2. Select the Home tab in the ribbon and click **Inventory**.
   Or
   Select the tab displaying the Student's name in the ribbon and click **Inventory**.
   Or
   Right-click the Student icon and choose **Inventory**.
3. The Inventory window for the selected Student will appear.

**Note:** Once collected, the various Client inventories are stored locally in the NetSupport School program folder meaning that you do not need to be connected to the target PC to be able to view the information at a later date. Simply select the required Client from the List view and choose the **Inventory** option. However, if you subsequently want to refresh the inventory, you do need to connect to the target PC.
The Inventory window

The Inventory window is the primary interface for accessing the wealth of information that NetSupport School’s inventory feature provides.

The window is organised as follows:

**The caption bar**

The caption bar displays the name of the remote Student PC whose system inventory is being viewed. The following options are available on the right-hand side:

- ![Multiple windows icon](image)
  - Shows how many windows are open. From here, you can access the Window menu.

- ![Online help icon - question mark](image)
  - Access the online help and version number, licensee, Technical Support and compression information.

- ![Minimise window icon](image)
  - Minimise the window.

- ![Maximise window icon](image)
  - Maximise the window.

- ![Close window icon](image)
  - Close the window.
The ribbon
The ribbon provides access to the inventory components and from here, you can refresh, print and export the current view.

The following inventory views are available:

- **Hardware**
  NetSupport School collects a range of information specifically about the hardware or environment of the Student PC, providing all the key information needed to assist in speedy problem resolution.

- **Software**
  Provides a full software inventory report for any selected Student PC. Includes the name of each installed product, the manufacturer, product icon, version number and even the associated .exe file.

- **Hot Fixes**
  NetSupport School scans for and checks the status of any ‘hotfixes’ that have been installed on the selected Student machine. The hotfix ID is listed along with its status. The hotfix ID links to the appropriate Microsoft support page, where details of the fix can be found.

  When verifying the status of each fix, NetSupport School returns one of three indicators:

  - ![✓] Verifies that the fix is present on the target PC and is current.
  - ![✗] An expected file may not be present or is not the correct version. It would be advisable to install the fix again.
  - ![?] NetSupport School was unable to gather the required information for it to be able to verify the status.

**Note:** Once collected, the various Student inventories are stored locally in the NetSupport School program folder, meaning that you do not need to be connected to the target PC to be able to view the information at a later date. Simply select the required Student from the List view and choose the Inventory option. However, if you subsequently want to refresh the inventory, you do need to connect to the target PC.
The status bar
The status bar shows the number of connected Students. You can see a list of all connected Students by clicking Connections (clicking a Student name opens an Inventory window for them).

Running the Task Manager
1. Select the required Student icon in the Tech Console List view.
2. Select the Home tab in the ribbon and click Task Manager.
   Or
   Select the tab displaying the Student's name in the ribbon and click Task Manager.
   Or
   Right-click and select Task Manager.
   Or
   While viewing the Student screen, select the Tools tab in the View window ribbon and click the Task Manager icon.
3. The Task Manager window for the selected Student will appear.

The Task Manager window
NetSupport School allows you to remotely open the Task Manager and manage applications, processes and services on the Student.
The window is organised as follows:

**The caption bar**
The caption bar displays the name of the Student you are running the Task Manager for. The following options are available on the right-hand side:

- [Multiple windows icon](#) Shows how many windows are open. From here, you can access the Window menu.

- [Online help icon - question mark](#) Access the online help and version number, licensee, Technical Support and compression information.

- [Minimise window icon](#) Minimise the window.

- [Maximise window icon](#) Maximise the window.

- [Close window icon](#) Close the window.

**The ribbon**
The ribbon provides access to the Task Manager tasks and tools. The available options change depending on what view is selected. You can refresh, print and export the data from all views.

The following views are available:

- **Applications**
  Shows a list of applications currently running on the Student machine. You can close a selected application from the list by clicking the **Close Application** icon.

- **Processes**
  Provides a list of processes currently running on the Student machine. You can close a selected process from the list by clicking the **Kill Process** icon.

**Note:** Click **Monitor Resources** to see the usage differences (+/-) for the running processes.
- **Services**
  Provides a list of services currently running on the Student machine. You can stop, start, pause and restart services by clicking the required Services icon.

**The status bar**
The status bar shows the number of connected Students. You can see a list of all connected Students by clicking **Connections** (clicking a Student name opens a Task Manager window for them).
Policy Management

The Tech Console allows you to create a set of policy restrictions that can be applied across the whole school. Once the policy is applied, it will remain in force 24 hours a day. The policy restrictions can include internet and application usage, access to USB and CD/DVD drives, printing and webcams.

In details view, you can view the current policy restrictions for Students. Hovering over the icons in the Policy column displays further information about the current policy.

The NetSupport School Tutor is notified of any policy restrictions that are in force. A lock icon will be displayed next to the relevant feature advising that a central policy has been applied.

**Note:** The Tutor can override central policies for their Students in the NetSupport School Tutor - Start Option settings.
Creating a Policy
1. Select the Security tab in the ribbon and click Group.
   Or
   Click the Details ‡ icon on the status bar, right-click in the Policy column and select Policy Management.
2. The Policy Management dialog will appear.
3. Set the required restrictions.
4. Click OK.
5. Click Yes to apply the policy changes to all Students.

Applying a Policy
You can apply the policy to all connected machines.

Note: Teacher machines can be excluded from a policy. Select the Don’t apply policies to teacher computers check box in the Tech Console - General Settings dialog.

1. Select the Security tab in the ribbon and click Apply.

Clear a Policy
Clears the current policy from the selected Student(s).

1. Click the Details ‡ icon on the status bar.
2. Select the required Student(s).
3. Right-click in the Policy column and select Clear Policy.
Define and view Student security settings

The Tech Console allows you to view the current security status for Students, modify the security settings such as the firewall, Windows updates etc for Students and configure the settings that determine whether a PC is secure. If a Student meets the conditions that define a secure PC, a green shield is displayed in details view. This will turn red if the Student fails to meet even one of these conditions.

**Note:** These settings are only available in the Tech Console.

**Define a secure PC**

Define what options determine whether a PC is classed as secure.

1. Select the Security tab in the ribbon and click **Define**.
2. The Define Secure PC dialog will appear.

![Define Secure PC dialog](image)

3. Select the required options.
4. Click **OK**.
**View current security settings**
In details view, the current security status for Students is displayed in the Security column. Hovering over the shield will display the current status of all items for a Student.

1. Right-click the Student icon and select **Properties**.
2. The Client Properties dialog will appear.
4. The current security status for the Student will be displayed.

**Change the security settings**
1. Select the Student icon.
2. Select the Security tab in the ribbon and click **Security Settings**.
   Or
   In details view, right-click the shield in the Security column and select **Modify Security Settings**.
3. The Modify Settings dialog will appear. Alter the settings as required.
4. Click **Apply**.

Or

1. Right-click the Student icon and choose **Properties**.
2. The Client Properties dialog will appear, select the Security tab.
3. Click **Change** and alter the settings as required.
Remote Command Prompt window
By launching the Command Prompt window, you can remotely execute command line instructions at a connected Client.

**Note:** This feature is only available in the Tech Console.

1. Connect to the required Student.
2. Select the Home tab in the Tech Console ribbon and click **Remote Command**.
   Or
   Right-click on the Student icon and select **Remote Command Prompt**.
   Or
   Select the tab displaying the Student's name in the ribbon and click **Remote Command**.

3. The Remote Command Prompt window will appear.

The window is divided into the following sections:

**The caption bar**
The caption bar shows the name of the Student the Remote Command Prompt window is open for. The following options are available on the right-hand side:

![Multiple windows icon]  
Shows how many windows are open. From here, you can access the Window menu.
Access the online help and version number, licensee, Technical Support and compression information.

Minimise the window.

Maximise the window.

Close the window.

The ribbon
A range of tools is available via the ribbon, enabling you, for example, to clear the output window and change the displayed font.

Output/results pane
Shows the results of the command that has been run at the Student.

Input pane
This is where you enter the commands to run at the Student. It can be resized if required. While the window is open, each command is stored by the Tech Console - enabling you to recall previous instructions that you may wish to run again. Either scroll through the entries using the up and down arrow keys and press Enter when the required command is displayed or press F7 to show all commands in a window. Click on the required command and press Enter.

A maximum of 50 commands is stored. To clear the history press F8. Once you close the Remote Command window, the history is cleared automatically.

The status bar
The status bar shows the number of connected Students. You can see a list of all connected Students by clicking Connections (clicking a Student name opens a Remote Command Prompt window for them).
PowerShell window

A PowerShell window can be launched, allowing you to execute PowerShell commands at a selected Client.

**Note:** This feature is only available in the Tech Console.

1. Connect to the required Students.
2. Select the Home tab in the Tech Console ribbon and click **PowerShell**.
   Or
   Right-click the Student icon and select **PowerShell**.
   Or
   Select the tab displaying the Student's name in the ribbon and click **PowerShell**.
3. The PowerShell window will appear.

The window is divided into the following sections:

**The caption bar**

The caption bar shows the name of the Student the PowerShell window is open for (or the currently selected Student if the PowerShell is for multiple Students). The following options are available on the right-hand side:

- [Multiple windows icon] Shows how many windows are open. From here, you can access the Window menu.
Access the online help and version number, licensee, Technical Support and compression information.

Minimise the window.

Maximise the window.

Close the window.

**The ribbon**
A range of tools is available via the ribbon, enabling you, for example, to change the displayed font. If the PowerShell is launched at multiple Students, they will be listed in the Clients pane, allowing you to easily access the required Student session.

When a PowerShell is launched at multiple Students, if any sessions report an error or there are any differences between them, you will be notified in the Errors and Differences sections in the ribbon. An indicator will appear advising how many errors or differences there are and you can scroll through these and clear them when required.

**Input output pane**
This is where you enter the commands to run at the Student(s) and the results are displayed.

While the window is open, each command is stored, enabling you to recall previous instructions that you may wish to run again. Either scroll through the entries using the up and down arrow keys and press enter when the required command is displayed or press F7 to show all commands in a window. Click on the required command and press enter.

**The status bar**
The status bar shows the number of connected Students and any errors or differences between multiple Student sessions. You can see a list of all connected Students by clicking **Connections** (clicking a Student name opens a PowerShell window for them).
Testing Module

NetSupport School’s Testing Module is a powerful utility that enables Tutor’s to design tests and examinations with the minimum of effort. Incorporating an intuitive Test Designer allowing a Tutor to set customised tests including text, picture, audio and video questions, once the specified Students have completed the test in the pre-set time, the results are automatically collated, marked and made available to the Tutor.

The following components are available within the Testing Module:

The Test Designer
Launched from the NetSupport School program group, the Test Designer is used to create questions and tests.

The Testing Console
Run from within the NetSupport School Tutor program, the Testing Console is used to launch the required test at selected Student machines, monitor progress and collate results.

The Test Player
This component runs the test at the Student machine, it loads automatically when the Tutor launches a test.
The Test Designer
The NetSupport School Test Designer is the primary interface for:

- Creating questions.
- Creating tests/examinations.
- Maintaining stored questions and tests.
- Providing user access to the designer.

**Note:** Selecting participants, running the test at student machines and recording the results of tests is managed within the NetSupport School Tutor program. See **Testing Console** for more information.

Starting the Test Designer
1. Choose {Start}\{Programs\}{NetSupport School}\{NetSupport School Test Designer\}. On Windows 8 machines right-click in the Start screen and choose All Apps at the bottom of the screen. Click the NetSupport School Test Designer icon.

   Or

   Select the Feedback & Wellbeing tab in the Tutor Console ribbon and click **Test Designer**.

2. The Test Designer logon screen will appear. Enter your user name and password.

**Note:** NetSupport School provides a default administrator logon for use the first time you access the Test Designer (user name **admin**, password **admin**) but you can add additional users.
The Test Designer user interface

The Test Designer comprises two modes of operation, Questions and Exams. You navigate the two interfaces using the drop-down menus or the icons displayed above each tree view. Stored questions grouped by subject are shown in the top pane and exams at the bottom. The right-hand pane shows a preview of the currently selected question or exam.

The main toolbar provides shortcuts to a number of general tasks such as creating user accounts, importing and exporting data and managing question resources. The Layout toolbar icon enables you to customise the Test Designer interface should you wish to work in either Question or Exam mode. Select Normal Layout to return to the default interface.

Note: An online resource centre is available, providing teachers with access to a wide range of curriculum-based information that can be used within the Testing Module. The portal is provided and managed by NetSupport School, but the actual content will be provided by Educators for Educators, which will ensure it reflects up to date and relevant curriculum content. Select {Help}\{Online Resources} from the Test Designers drop-down menu to access the site.
The Questions interface
You can create questions in a variety of formats and these can be enhanced by the use of imported pictures, videos and sound clips.

The four icons available in Question Mode enable you to:

- Create questions
- Edit a selected item
- Delete a selected question
- Change the way questions are arranged in the Tree view. This can be by author, question type, subject or level of difficulty.

Subjects and Topics can be added to the Tree view at any time or, if you are not sure which subject groups your questions will belong to, you can add them when creating a question.

To add subjects directly to the Tree view, select {Questions}-{New Subject} from the drop-down menu or right-click in the Questions window and select New Subject.

Multiple topics can then be added beneath a subject by right-clicking on the subject name and selecting New Topic or choosing {Questions}-{New Topic} from the drop-down menu.
Create questions
A choice of eight question styles are available, each with a Question wizard that steps you through the required process.

To create a question, choose {Questions}{Create Question} from the drop-down menu, click the Create New Question icon or right-click a question and select Create Question.

Select the required question type and click Create.

Note: Questions can also be created in the Exam Editor at the time you compile a test.

The nine question types are:

Multi choice
The Student is required to pick the correct answer from up to four possible options.

Drag and drop text
Students must try to complete a statement by adding a word or phrase from the alternatives provided.
Drag and drop image
Students must match an image with the appropriate statement.

Combo list
Students are presented with up to four questions and need to select the correct answer from a drop-down list. You can insert additional 'decoy' answers into the list.

Label image
You provide Students with a picture that has various areas marked. The Student needs to label each area correctly.

True or false
The Students are provided with a statement and they must decide whether this is true or false.

Multi true or false
Students are presented with up to four statements and must decide whether they are true or false.

Order items
The Students are required to place the items in the correct order.

Highlight text
Students must highlight a word or phrase to answer the question.
**Multi choice**
Students select the correct answer from up to four possibilities.

The first stage, of three, is to set the question followed by the correct answer and up to three false answers. When the question is run at Student machines, the answers are randomly arranged.

Once you have completed part one of the wizard, click **Next**.
**Drag and drop text**

The Student is presented with four partially completed statements. They must complete the statement by dragging and dropping the appropriate word or phrase from a list.

The first stage, of three, is to enter the instructions for the question along with the four statements. Within each statement, highlight the word or phrase that you will want the Students to drag and drop, clicking **Set Answer** when you are happy that you have selected the appropriate text. You can add two fake (incorrect) answers, so the Students have to identify the correct answer before dragging it into the statement. When the question is run at Student machines, the four highlighted items are removed from the statements and randomly arranged with any fake answers you have entered.

Once you have completed part one of the wizard, click **Next**.
**Drag and drop image**

The Student is presented with up to four statements or questions, and a selection of images. They must match the image with the correct statement.

The first stage, of three, is to enter the instructions along with up to four statements or phrases. Alongside each statement, you add the appropriate image. Click **Browse** to search for the images. The list of pictures currently stored in the Images database will appear. Either select an existing image or import a new one. Click **Use** to apply the image to the question.

When the question is run at Student machines, the pictures are randomly arranged at the bottom of the screen and the Students drag and drop the images next to the appropriate statement.

Once you have completed part one of the wizard, click **Next**.
Combo list

The Student is presented with up to four statements, alongside each statement is a drop-down list containing a choice of possible answers. They must select the correct answer from the list.

The first stage, of three, is to enter the instructions along with up to four statements or phrases. Alongside each statement, enter the correct answer text. You can then add two further fake answers, meaning that when the question is run at Student machines, the Student will be shown all possible answers to choose from.

Once you have completed part one of the wizard, click Next.
Label image

Students are presented with a picture that has up to four areas marked, each with an adjacent blank’ text box. At the bottom of their screen will be up to four text labels which they must drag and drop into the correct text box.

The first stage, of five, is to enter the question along with up to four text labels. You then select the image that the Students will need to label. Click Browse to search for the images. The list of pictures currently stored in the Images database will appear. Either select an existing image or import a new one. Click Use to apply the image to the question.

Once you have completed part one of the wizard, click Next.

If the image you have chosen for the label image question is too large for the viewable area, you can resize it.
Use the scroll bars to position the image within the viewable area. To select the required section, use your mouse to draw around the area you require. When ready, press Enter or click Next to continue.

Use this preview window to position the answers on the image, select the type of arrow you wish to use and choose an appropriate colour scheme for the ‘pointer’ lines and background.
1. Drag the end of each ‘pointer’ to the correct region of the image.
2. Drag the associated text box to an appropriate area.
3. Select the pointer style you wish to use and choose a colour for the pointers and background.
4. Click **Next** when ready.
True or false

Students are provided with a statement and they must decide whether it is true or false.

The first stage of three is to provide instructions for the question, then enter the statement you want the students to answer and specify whether the statement is true or false.

Once you have completed part one of the wizard, click Next.
Multi true or false
Students are provided with up to four statements and they must decide whether they are true or false.

The first stage of three is to enter instructions for the questions, along with up to four statements. Alongside each of the statements choose whether they are true or false, by selecting the appropriate button.

Once you have completed part one of the wizard, click **Next**.
Order items

Students are required to correctly place up to four items in the correct order.

The first stage of three is to set the question, with up to four answers in the correct order. When the question is run at the Student machines, the answers will be randomly arranged and the Students will drag and drop each item to the correct place.

Once you have completed part one of the wizard, click Next.
Highlight text
Students are presented with up to four statements. They have to highlight the correct section of the statement(s).

Note: This question type was introduced in version 15.00 and previous versions cannot import or use this question. This question type should not be used if you have Tutor Consoles or Students running earlier versions, as it will not work and, if included in a test, the test will not start for any Students.

The first stage of three is to enter instructions for the question and then up to four statements. Once you have entered a statement, highlight the correct section of the statement. To allow for Student error when highlighting the correct text, an error margin can be set, allowing you to specify how many characters before and after the highlighted section can be selected before the answer is marked incorrect (by default, this is set to one character before and two after the selection). The correct answer is highlighted in dark blue and the error margin is shown in green.

If the text selected as the correct answer appears more than once in the statement, the duplicates are highlighted in pale red. You may want to reword the statement, as if a student highlights the wrong section of text, this will be marked as incorrect.

Note: If a Student only partially highlights the correct answer, the question will be marked as incorrect.
Once you have completed part one of the wizard, click **Next**.

**Adding additional resources to questions**

**The resources database**
Imagery in the form of pictures, videos and sound clips are often an integral part of any question you create. Question types such as label image and drag and drop image are graphical by nature but any question type can have an additional supporting resource included. The Test Designer provides an ‘Observation’ mode which, if enabled, forces Students to view or listen to a resource before they can answer the question.

Before you can attach a resource to a question, it must first be added to the programs internal Resources database. By default, this is stored in `\program files\netsupport\netsupport school\resources` but the location can be modified by selecting `{File}{Options}` from the drop-down menu.

To populate the database, click the **Resources** icon on the Test Designer’s main toolbar or select `{File}{Resources}` from the drop-down menu. The Resource list will appear. A range of toolbar options are available, enabling you to import and manage items. Prior to importing a new resource, click the **Filter** icon and select the relevant category, audio, image or video. This ensures that each resource type is stored in the appropriate folder within the database.

Click the **Import a Resource** icon and browse for the required file. Alternatively, you can simply drag and drop the file directly into the list from its location using Windows Explorer.

At the stage where you add your resources to a question, if the required file isn’t already in the database, you can import it at that time.
Adding resources to a question
Each Question wizard will prompt you to add resources at the appropriate stage.

1. Decide which resource type is appropriate, image, sound or video and click Browse. The resources list for the selected type will appear.
2. If the required file has already been imported into the database, highlight it in the list and click Use. You can preview the files before selecting them.
   Or
   To add a new item to the list, click Import and browse for the file. When you have selected the file, you can preview it to ensure it is the correct one. It is also important that you include a suitable description for the item, as this will appear in the Resources list rather than the file name. Once added to the list, click Use to add the item to the question.
3. Click Next.

Observation Mode
Selecting this option allows you to force the Students to view a resource file before the question appears, they will not be able to view the resource in the question. When the exam is run at the Student machines, they will be advised that the question media will only be shown once. If this option is selected, you will not be able to continue until a resource has been added to the question.
**Question details**
The Question Details dialog completes the create question process. Decide where to store the question and whether to add any additional author notes.

Stored questions are maintained in an internal database, school.mdb, within the NetSupport School program folder. The Question Editor window displays stored questions in a Tree view. You are able to customise this to your own requirements by creating subjects and topics within each subject.

The Question Details dialog also displays the Tree view and you can choose whether to add a question to an existing subject/topic or to create a new area. Supporting text can also be added.

**To add new subjects and topics while creating a question**
1. Select **Create Subject** and enter an appropriate name. Click **OK**. The subject will be added to the Tree view.
2. Within the subject, create a topic. Select **Create Topic** and enter a name. Click **OK**.
3. Author’s information can now be added. If required, edit the description and add any additional supporting text. You can also assign a level to each question to indicate the level of difficulty.
4. Click **Finish** to store the question and return to the Create a Question dialog. Either select another question type or click **Close** to return to the Question Editor window.

**Edit questions**
To edit a stored question, highlight it in the Tree and choose `Questions`\{Edit Question\} from the drop-down menu, click the **Edit the Selected Item** icon or right-click the question and select **Edit**.

Change the required details by selecting the appropriate tab on the Edit Question dialog and click **OK** when complete.

**Note:** Questions can be duplicated, right-click the question and select **Duplicate**. The Edit Question dialog will appear, if required, make any changes and click **OK** when complete; the duplicate question will now appear under the original question in the Tree.
Delete questions, subjects and topics
A question can only be deleted if it does not appear in an exam. A subject or topic can be removed if there are no items beneath it in the Tree view, the currently selected sort view determining the extent of the deletion.

Select the item in the Tree view and choose {Questions}{Delete Item} from the drop-down menu, click the **Delete Selected Item** icon or right-click and select **Delete**.

You can rename a subject or topic by right-clicking on the required item and selecting **Rename** or clicking the **Edit Selected Item** icon.

When deleting a subject or topic, the program will check to see if there are items beneath it in the Tree view and, depending on the current sort view, if the item appears anywhere else in the Tree view.

When sorted by subject type, there will only be one occurrence of the item. Therefore, a topic will be removed if it does not contain any questions and a subject if it does not contain any topics. However, when sorted by question type, for example, there may be multiple occurrences of the same subject and topic in the Tree view. If you delete the only occurrence of a Geography question in the multi-choice category, that topic or subject will be removed from multi-choice but not from any other category that Geography appears in.
The Exam interface

Having created a library of questions, you can then add them to an exam. Your own grading and scoring schemes can be applied and exams can be centrally ‘published’ for shared use with other teachers.

The icons available in Exam Mode enable you to:

- Create an exam
- Edit the content of an exam
- Delete an exam
- Publish an exam. Before an exam can be run at Student machines, it needs to be published. This also enables you to store completed exams in a shared area for general use.
- Preview an exam. Enables you to step through the questions as the Students will see them
- Edit exam grades. Apply your own grading scheme to exams.
**Exam grades**

Upon completion of an exam, teachers are provided with a detailed breakdown of results. You can further enhance this report by categorising the students within specific bands.

The exam grades need to be set up before you start creating an exam.

Select {Exams}{Exam Grades} from the Test Designer’s drop-down menu or click the **Exam Grades** icon.

Enter a name for the grading schema and add a report image. This provides a pictorial indicator of how well the Student has done. For example, a Student scoring 20% might have one star appearing next to their grade, someone scoring 80%, four stars. The image, restricted to 32x32 pixels, must be imported into the Resources database. A default, `reportgrade`, is provided but you can create and import your own customised images if required.

Give each grading band a description and attach the appropriate % mark. Click **Add** to insert each band into the list. When all bands have been added, click **Save**. Use the **Edit** or **Delete** buttons to change any of the items in the list.

You can view the grades each Student has achieved in the Test Reports window.
Create exam
Having created a suitable mix of questions in the Question Editor, adding those questions to an exam is a quick and easy process.

The Exam wizard guides you through the process of selecting the required questions, setting a time limit for the exam, using your own grading system and including supporting information. New questions can also be created during this process.

To create an exam
1. Choose {Exams}{Create Exam} from the Test Designer’s drop-down menu or click the Create New Exam icon.

2. The first stage is to enter general supporting information about the exam. Enter a title and description for the exam. Choose whether to have the exam timed, if so, set the time limit, hh:mm. You can use your own grading system by selecting from the Grading Schema drop-down. Decide whether to use the default scoring system (you can assign your own scores to questions in stage two). You can then add some optional information such as the age range or class group that the exam is aimed at. Click Next when ready.

Note: If you wish to use a grading schema, you must first create one in the Exam Grades dialog.
3. Stage two is to select the questions for the exam. Expand the Tree in the left-hand pane of the window and highlight the required question, click the **Add Question** button. The Tree view can be sorted by author, level, question type and subject. Repeat this process until all questions are selected.

4. Selected questions appear in the right-hand pane of the window. From here, you can use the buttons to remove a question from the exam, sort the questions into the required order, preview the question, assign a new score to the question or even create a new question.

5. Click **Finish** to store the exam in the Exam Editor window Tree view.

Once created, you can use the Exam Editor menu or toolbar options to edit or delete exams, preview exams and publish the exam.

**Note:** Although the newly created exam appears in the Exam Editor Tree view, it cannot be run at Student machines until it has been ‘published’. This bundles the various elements of the exam, questions, pictures, videos etc, into a single ZIP file which is then made available in the Testing Console.
**Question score**

Questions are created with a default score, the Question Score dialog allows you to allocate your own score to individual questions.

1. In the Exam wizard, select the question you wish to amend the score for and click the **Question Score** icon.

   **Note:** You must ensure that the **Default Scoring System** option is un-checked.

2. The Question Score dialog will appear showing details of the question and the score that would normally be awarded for the question.

3. Increase the score by using the appropriate buttons.

   **Note:** Questions with multiple answers can only be incremented by a corresponding number.

4. When you have finished, click **Save** to exit.
**Preview exam**

You can preview an exam at any time in order to simulate what the Students will see. This is a useful way of checking each question and viewing the resources, pictures, video’s etc that may have been included. Although the exam runs exactly how it would at the Student machines, the preview facility does not return any results.

1. Select the exam in the Tree view.
2. Choose {Exams}{Preview Exam} from the Test Designer’s drop-down menu, click the **Preview Exam** icon or right-click the exam name and select **Preview**.
3. Use the buttons at the bottom of the window to move between questions and end the preview. You can also click each question number on the left-hand side of the window to view each one.

**Note:** Individual questions can also be previewed in this mode. Expand the Tree beneath an exam to reveal the questions, highlight the appropriate item and click **Preview**.

**Edit exam**

1. Select the exam in the Tree view.
2. Choose {Exams}{Edit Exam} from the Test Designer’s drop-down menu, click the **Edit Exam** icon or right-click the exam name and select **Edit**.
3. The Exam wizard will appear.
4. Select the Exam Details or Exam Question tab and edit the required items.
5. Click **OK**.
Delete exam

Although this procedure removes the exam from the Exam Editor window, it does not delete the Zip file that is created when an exam is published. The exam will therefore still be available to run at Student machines.

To delete an exam
1. Select the exam in the Tree view.
2. Choose {Exams}-{Delete Exam} from the Designers drop-down menu, click the Delete Exam icon or right-click the exam name and select Delete.
3. Confirm that you want to delete the exam.

Publish exam

Before an exam can be run at Student PCs, it must be ‘published’. This procedure bundles the various elements of the exam, questions, resources etc, into a ZIP file that can be stored in either the default Program Files Tests Folder or in a shared network area of your choosing. The latter having the added benefit of enabling other teachers to access the exam.

Once published, the test can be selected in the Testing Console.

To publish an exam
1. Select the newly created exam in the Tree view.
2. Choose {Exams}-{Publish Exam} from the Test Designer’s drop-down menu, click the Publish Exam icon or right-click the exam name and select Publish.
3. A window will appear confirming the exam properties. Click Publish.
4. The Save As dialog will appear. Give the exam a suitable name, this is the name that will appear in the Testing Console when selecting an exam to run. Click Save to create the Zip file.
Setting up user accounts

Multiple Test Designer user accounts can be created in addition to the default Admin logon (user name: admin, password: admin).

Choose {File}{Users} from the Test Designer’s drop-down menu or click the Users icon on the main toolbar. The User Management dialog will appear from where you can add, edit or delete users.

Click Add and enter a user name, generally the person’s full name, along with a login name and password. Decide whether to assign admin rights. This gives the user access to all features within the Test Designer along with the ability to edit/delete questions and exams created by other users. Non-admin users can only create exams.
Admin options

Questions, exams etc are stored in an internal database supplied with NetSupport School. This dialog provides version information about the database. You also have an option to edit the path where imported resources (images, video, sound clips) are stored.

![Options dialog]

General
Tracks the version number of the database, school.mdb, that is currently in use. NetSupport School may on occasions supply updates to the internal database and this dialog indicates which version is currently in use.

Resources
By default, imported resources such as images, video files and sound clips, are stored in the resources area within the NetSupport School program folder. This option enables you to edit the path if required.
Import/export data
The Test Designer provides an Import/Export facility enabling you to store external backups of data or make information available to other users. Exported files can be password protected for security. You have the choice of exporting all items in the database or just the exams, questions or resources.

The import/export options can be accessed from either the Question or Exam Editor windows.

Exporting data
1. Choose {File}{Export} from the Test Designer’s drop-down menu or click the Export icon on the main toolbar.
2. The Export Database dialog will appear. Select the category of information to be exported and click Export.
3. The Export wizard will appear. Specify the location for the exported data and provide a file name. By default, files are prefixed with the current date, but you may prefer to enter a custom name. If required, password protect the file, add any additional notes and click Next when ready to proceed.
4. Depending on the category selected, (exams, questions, resources etc) the wizard will now prompt you to choose, from a tree view, the specific items to be exported. Select each item in turn and click the Add Item to Export List button. When the Export list is complete, click Next.
5. The wizard will confirm the items to be exported. Any resources associated with exams or questions are included. Check the details and if required, click Back to change the information.
6. Click Finish to begin exporting.
7. A progress dialog will appear. Click Close when complete.

Note: Exported data is not removed from the Test Designer.

Importing data
1. Choose {File}{Import} from the Test Designer’s drop-down menu or click the Import icon on the main toolbar.
2. The Import Database dialog will appear. Browse for the required export file and click Open.
3. Click Import DB to start importing. If the file has been protected, you will be prompted for the password.
4. A progress dialog will appear. Click Close when complete.
The Testing Console

Having used the Test Designer to create questions and exams, you use the Testing Console option in the NetSupport School Tutor program to run the exam at Student machines and monitor results.

Running an exam
1. Select the Feedback & Wellbeing tab in the ribbon and click **Assessments**.
2. The Test Modules dialog will appear. From the list of connected Students, indicate which ones should participate in the exam by checking or un-checking the box next to their name. Click **Next** to continue.

3. Details of the published exams are listed, choose the one that you want to run at the selected Student PCs. If required, you can alter the time limit for the exam. To preview the exam, click **Preview**. Click **Finish** when ready to run the exam.
4. The NetSupport School Test Player will automatically launch at the Student PCs and a dialog enabling you to administer the exam will appear on the Tutor screen.

5. This dialog is used to start the exam, monitor Student progress and collect results.
The window enables you to track individual Student progress. Each question is marked in real-time so you can see immediately how each Student is doing. At the end of the exam, you can view the results by class and individual Student and print a permanent record. You can also show each Student their results giving them the opportunity to see where they made mistakes.

**Note:** If a Student disconnects partway through the exam, the description shows they have disconnected. The results of the questions they did answer are available in the exam report.

The following toolbar options are available:

**View Client**
You can view a particular Student screen at any point during the exam. All options normally associated with the View window are available.

**Chat**
If required, you can open a Chat session with Students while the exam is running. Although the Test Player provides a help button offering Students guidance with each question type, you may find that you need to offer additional assistance.

**Test Login**
Before starting the exam, you can ask each Student to login with their own name. This would be useful if, for example, the machine name is listed and be more meaningful when checking results against each Student.

**Pause Test**
You can pause the exam at any point. Click **Start Test** when ready to continue.

**Start Test**
Start running the exam at Student PCs.

**Stop Test**
If Students answer all the questions within the time limit, you can stop the exam rather than wait for the clock to tick down.

**Report**
This option gathers the results when the exam has finished. (When the Tutor stops the exam or the time limit elapses.)
Test Reports window
The Test Reports window enables the Tutor to review the results of an exam. You also have the option to allow Students to see their own results.

By selecting the required item in the Tree view, you can display two types of report, a class summary and individual Student summaries. Each can be printed and copies are also stored, in HTML format, in the \NetSupport\NetSupport School\Tests\Reports folder.

**Note:** An alternative location for the reports can be specified in the Tutor Profiles option.

**Class Summary**
This provides a summary of each Student’s results in tabular format. The report details the number of questions in the exam, the number of points available (questions other than multi-choice are worth 1 point for each correct answer) and itemises each Student’s score.

**Individual Student Summary**
By selecting the Student name in the Tree view, you can display a full breakdown of the individual results. This is ideal for highlighting any problem areas that the Student may have. If you have applied a grading schema, the marked grade along with any comments you added is also displayed. An index itemising the points scored for each question is
provided from which you can jump to each question to see how the Student answered.

**Note:** If a Student disconnects during the exam, the status shows as interrupted. The results are available for any questions they did answer but you are unable to send the results to the Student.

The toolbar provides shortcuts to a number of additional features:

**Show Results**
This enables you to show each Student their results and, if required, include the answers. To display to all Students simultaneously highlight **Students Reports** in the Tree view, to show to an individual Student select their name.

The Test Player will re-open at the Student machines enabling them to view each question in turn. The window will indicate which questions they got right, wrong or, in the case of questions that have multiple answers, partially correct.

If you have chosen to include the answers, a **Show Answers** button will appear on the Test Player window enabling the Student to toggle between their response and the correct answers.

**Show Report**
This option enables you to display the individual summary reports at Student machines.

**Print Report**
Enables the Tutor to obtain a printed copy of the Class and Student summaries.

**Send to Journal**
Allows you to send a copy of the Student’s results to their Student Journal. The Student then has the opportunity to review their answers after the lesson.

When ready, close the window to return to the Test Console window from where you can exit the test. This will clear the results or reports from the Student screens.
The Test Player
The NetSupport School Test Player is the testing utility that loads at Student PCs when an exam is running.

The Tutor uses the Testing Console option to choose the Students to participate in the exam and select the exam to run. At this point, the Test Player loads automatically at each Student PC. When the Tutor starts the exam, the first question appears and the Students can then work their way through the exam.

The Test Player window displays the following:

**Exam Time**
Counts down the time remaining.

**Question List**
Numbered buttons indicate how many questions there are in the exam. The Student can click these to quickly move between questions. Useful at the end of the exam to review answers and to make changes before the time runs out.
**Question Area**
The main body of the window displays the question and, depending on the question type, the associated options. Buttons are provided to view any resources that may have been included, pictures, videos or sound clips, and a reference button is available which provides Students with tips on how to answer the particular type of question.

**Navigation Buttons**
In addition to the numbered buttons in the question list, navigation buttons are also available at the bottom of the window enabling Students to move between questions. When they have completed the exam, they click **Finished**.

When the exam has finished, the Tutor has the option to show Students their results and, if required, include the answers. The Test Player will re-open at the Student machines enabling them to view each question in turn. The window will indicate which questions they got right, wrong or, in the case of questions that have multiple answers, partially correct. If the Tutor has chosen to include the answers a **Show Answers** button will appear enabling the Student to toggle between their response and the correct answers.
Contact us

If you have any comments regarding the design, installation, configuration, or operation of this NetSupport School, please contact us.

**UK & International**
www.netsupportsoftware.com
Technical Support: support@netsupportsoftware.com
Sales: sales@netsupportsoftware.com

**North America**
www.netsupport-inc.com
Technical Support: support@netsupportsoftware.com
Sales: sales@netsupport-inc.com

**Canada**
www.netsupport-canada.com
Technical Support: support@netsupportsoftware.com
Sales: sales@netsupport-canada.com

**Germany, Austria and Switzerland**
www.pci-software.de
Technical Support: support@netsupportsoftware.com
Sales: sales@pci-software.de

**Japan**
www.netsupportjapan.com
Technical Support: support@netsupportsoftware.com
Sales: sales@netsupportjapan.com
Index

access point speed, 302
adding notes to the student journal, 270
adding resources to questions, 376
android
  student, 103
tutor, 102
annotating screens, 166
  annotate toolbar, 167
  interactive whiteboard, 163
application
  show application, 187
application control module, 230
  history, 239
  identify applications in use, 231
Application control module
  Managing applications on Student machines, 233
arrange Client icons, 81
assign group leader, 123
audio monitoring, 168
audio settings, 322
audio support, 171
  adjusting audio settings, 173
  announcement, make a, 171
  configure at Client, 288
automatic login, 75
automatically reconnect to students, 85, 328
backgrounds, 82
blanking Client screens, 135
  all screens, 136
bouncing questions, 254
broadcast show, 154, 302
  on wireless network, 302
browse mode, 54
browsing
  configuring subnets, 87
  for Clients at installation, 44
  for students at startup, 48
  for terminal server Clients, 91
cache size, 293
cancel group leader, 125
Chat settings, 323
chatting to Clients, 188
disable at Client, 290
the chat window, 190
chrome tutor, 97
class lists
  create class lists, 60
class wizard, 49
Client
  arrange icons, 81
  as a show leader, 157
  audio settings, 288
  audio support, 171
  clipboard, 137
  configure, 283
  configure advanced settings, 291
  configure security, 286
  configure transport, 284
  connecting to at installation, 44
  connecting to at startup, 48
  customise icons, 126
  exhibit a Client screen, 159
  group leader, 123
  help requests, sending, 195
  record activity, 178
  remote installation, 28
  save login name, 80
  scan screens, 139
  sign in, 76
  user interface configuration, 289
  viewing screens, 131
client disconnects, 85
clipboard, 137
combo list question, 368
configure remote control settings, 314
  audio settings, 322
  Chat settings, 323
  file transfer settings, 324
  group leader settings, 332
  replay file settings, 321
  student toolbar settings, 333
student user interface settings, 329
tutor journal settings, 334
tutor keyboard/mouse settings, 319
tutor user interface settings, 327
tutor view settings, 316
configure the Client
   advanced settings, 291
   audio settings, 288
   enable name server, 284
   security, 286
   transport, 284
   user interface settings, 289
configure the Client, 283
configure the Control, 297
   administration options, 309
   enable name server, 302
   for subnet browsing, 87
   protect configuration, 307
   set connectivity, 302
   set Control name, 307
   set password, 307
   set transport, 302
   to show across wireless networks, 302
   Tutor profiles, 267, 311
configure the student toolbar, 278
configuring netsupport school on google chrome, 97
configuring the tutor assistant, 92
connect to students
   browse mode, 54
   pc mode, 55
   room mode, 52
   user mode, 57
connect to students using browse mode, 54
connect to students using pc mode, 55
connect to students using user mode, 57
connecting to Clients
   at installation, 44
   configuring subnets, 87
   name server/gateway, 110
   terminal server, 91
   connecting to students at startup, 48
   connecting to students via room mode, 52
   connectivity, 284, 302
   console. See testing console
Control
   announcement, make a, 171
   audio support, 171
   chat to Clients, 188
   clipboard, 137
   configure, 297
   ctrl+alt+delete, 135
   executing applications at Clients, 210
   file distribution, 203
   file transfer, 198
   help requests, dealing with, 195
   lock Client mouse and keyboard, 129
   logoff Clients, 216
   make Client a group leader, 123
   messages, sending, 192
   profiles, 311
   protect configuration, 309
   remote control, 131
   scan Clients, 139
   showing the Control screen, 154
   starting, 44
   user defined tools, 214
   using replay files, 178
   using show leaders, 157
   video support, 174
   viewing Clients, 131
Control Window, 62
   bitmap backgrounds, 82
   customise Client names, 76
   customise list view, 81
   conventions used, 13
   converting replay files to video files, 186
   create exam, 383
   create group leader, 123
   create pre-set messages, 193
   create questions, 363
   create test designer users, 388
   creating an administrative installation, 25
   ctrl+alt+delete, 135
customisable text, 287
customise
Client & group icons, 126
cut and paste, remotely, 137
define a secure pc, 353
delete exam, 387
delete group leader, 125
delete questions/subjects/topics, 380
deploy
  a Client configuration, 38
  a NetSupport School licence file, 39
  a NetSupport School package, 33
  getting started, 31
log files, 43
pre-define settings, 42
Remote Install, 28
remote uninstall, 40
room mode, 46
designer
  adding resources to questions, 376
  create combo list question, 368
  create drag & drop image question, 367
  create exam, 383
  create label image question, 369
  create multi choice question, 365
  create multi true or false question, 373
  create order items question, 374
  create questions, 363
  create true or false question, 372
  delete exam, 387
  delete questions, 380
drag & drop text question, 366
edit exam, 386
exam mode, 382
export data. See testing module
google chrome, 97
group chat, 188
disconnect, 85
display customisable text, 287
Distributing files
  Distributing files to Students, 203
  distributing files, 203
distribution copy for installation, 25
drag and drop image question, 367
drag and drop text question, 366
DVD support, 291
eyes mode, 72
edit exam, 386
enable DVD support, 291
enable student toolbar, 278
enter an answer question type, 249
exam grades, 382
exhibit Client screens, 159
  annotate while exhibiting, 166
file distribution, 203
file locations
  Tutor profiles, 311
file transfer, 198
  from the Control to a Client, 198
  settings, 324
first to answer question type, 249
Gateway, 110, 111
  configuration, 112, 114
  enable at Tutor, 302
  gateway configuration
    classes tab, 117
    licences tab, 115
    security tab, 116
  get name, 76
  save Client login name, 80
giving students rewards, 281
  google chrome, 97
group chat, 188
group leader settings, 332

groups
  change members, 121
  creating, 120
  customise icons, 126
  group leaders, 123
  remove group leader, 125
  working with groups, 120

hardware inventory, 345

help requests
  dealing with, 195
  disable Client requesting help, 289
  sending, 195

history
  application control module, 239
  web control module, 228

hotkeys, 289
  display when showing, 154

icons
  customise, 126

image file
  display image when Client locked, 293

import/export data. See testing module

install configuration options, 27

installation
  setup type, 19

installing
  from a server, 25
  name server, 111
  NetSupport connectivity server, 111
  parameters for silent install, 27
  planning, 14
  pre-requisites, 15
  remote deploy, 28
  silent installation, 26

installing and configuring
  android student, 103
  browser app, 105

installing netsupport school on
  google chrome, 97

installing the tutor assistant, 92

installing the Tutor for android, 102

instcfg.exe file, 27

interactive whiteboard, 163

intermediate mode, 70

inventory, 345

iOS, 105

ip subnet browsing, 87

join class
  disable Client joining class, 290
  keyboard monitoring, 146
  setting up word lists, 146
  typing history, 150

label image question, 369

launching applications, 210

layout
  arrange Client icons, 81
  set background, 82

lesson planner, 276
  set class time, 276

list view
  application view. See application control module
  survey view. See student surveys

web view. See web control module

List view, 66

lock/unlock mouse and keyboard, 129

log files
  display graphic, 129
  display image, 293

messages
  create pre-set messages, 193
  sending, 192

monitor mode, 143

multi true or false question, 373

multi-choice question, 365

multi-scan, 140
name server, 110, 111
   configuration, 112, 114
   enable at Tutor, 302
NetSupport School deploy
   a NetSupport School package, 33
NetSupport connectivity server, 111
NetSupport connectivity server
   configuration
   classes tab, 117
   general tab, 112
   keys tab, 114
   licenses tab, 115
   security tab, 116
NetSupport School
   starting, 44
NetSupport School deploy, 28
   a Client configuration, 38
   a NetSupport School licence file, 39
   getting started, 31
   log files, 43
   pre-define settings, 42
   remote uninstall, 40
NetSupport School deploy via room mode, 46
observation mode, 377
order items question, 374
password
   at Control, 307
   protect Control configuration, 309
pc mode, 55
peer assessment, 255
performance settings, 306
planner, 276
planning an installation, 14
play replay file, 182
play video, 174, 175
policy management, 351
pot luck question type, 249
pre-define deploy settings, 42
pre-define lesson plan, 276
pre-requisites, 15
pre-set messages, 193
preview exam, 386
printer management, 257
   history, 262
using print management, 259
profiles, 267
protect Control configuration, 307, 309
publish exam, 387
question and answer module, 247
   bouncing questions, 254
   enter an answer, 249
   first to answer, 249
   peer assessment, 255
   pot luck, 249
   team mode, 255
   tutor interface, 251
   using question and answer module, 253
question and answer module team mode, 255
question scores, 385
questions mode, 362
   adding resources to questions, 376
   create combo list question, 368
   create drag and drop image question, 367
   create drag and drop text question, 366
   create label image question, 369
   create multi true or false question, 373
   create multi-choice question, 365
   create order items question, 374
   create true or false question, 372
   delete questions/subjects/topics, 380
   observation mode, 377
   store questions, 378
quiet mode, 289
reboot, 216
register students, 76
remote
   clipboard, 137
   launching applications at Clients, 210
   log off Client workstations, 216
   remote command prompt, 355
   remote deploy utility, 28
   remote install
   a Client configuration, 38
a NetSupport School license file, 39
a NetSupport School package, 33
log files, 43
Remote inventory and system information, 345
remote uninstall, 40
remove group leader, 125
Removing a Student from a class, 86
replay file settings, 321
replay files, 178
control panel, 183
converting replay files, 186
create at the tutor, 181
create for all students, 179
create for selected students, 180
showing to students, 185
watch, 182
reports
test results, 394
reset passwords, 217
restricted website list. See web control module
room mode, 52
Running the Task Manager, 348
scale to fit mode, 133
scanning, 139
monitor mode, 143
multi-scan, 140
screen capture, 152
Screen Capture, 152
Searching for Students, 342
security
configure at Client, 286
security key
Client, 287
test designer, 360
control, 310
select setup type, 19
select Students for exam, 391
Selecting Students to work with, 69
send physical fonts, 291
send/collect work, 205
change properties, 209
collect work, 207
send work, 205
sending messages, 192
create pre-set messages, 193
server installation, 25
set class time, 276
set name for Control, 307
setup. see installing
show leaders, 157
show printers, 257
show settings, 336
showing
a Client screen, 159
across a wireless network, 302
an application, 187
annotate while showing, 166
broadcast show, 154, 302
hotkey combinations, 154
replay files, 185
set show leader, 156
suspend a show, 155
the Control screen, 154
using audio, 172
using Show leaders, 157
videos, 175
sign in, 76
sign out, 78
silent disconnect, 85, 327
silent installation, 26
specify parameters, 27
silent mode, 291
software inventory, 345
starting NetSupport
test designer, 360
starting NetSupport School, 44
startup restrictions, 300
startup settings, 298
Status bar, 68
Stopping the Student service, 343
student disconnects, 85
student feedback and wellbeing, 161
Student inventory, 345
student journal, 270
adding notes to the journal, 270
student login, 75
Student name
count, 291
student register, 76
student rewards, 281
student security settings, 353
Student stickers, 282
student surveys, 241
  show results to students, 241
survey lists, 244
student toolbar, 278
student toolbar settings, 333
student user interface settings, 329
subnet browsing, 87
system pre-requisites, 15
Task Manager, 348
tech console, 338
  policy management, 351
  remote command prompt, 355
  student security settings, 353
Tech Console
  Searching for Students, 342
  Stopping the Student service, 343
terminal server, 91
terminology used, 13
testing module
  true or false question, 372
test designer, 360
test player, 396
testing console, 391
testing module
  adding resources to questions, 376
  combo list question, 368
  create exam, 383
  create questions, 363
  delete exam, 387
  delete questions/subjects/topics, 380
drag and drop image question, 367
drag and drop text question, 366
edit exam, 386
exam grades, 382
exams mode, 381
import/export data, 390
introduction, 359
label image question, 369
multi true or false question, 373
multi-choice question, 365
order items question, 374
preview exam, 386
publish exam, 387
question scores, 385
questions mode, 362
reviewing results, 394
run exam, 391
select Students for exam, 391
setting up user accounts, 388
starting the designer, 360
store questions, 378
test player, 396
testing console, 391
what the Student sees, 396
The List view, 66
timed lesson, 276
tools
  add, 214
transfer files, 198
Transferring files
  Managing files and folders, 200
  transfer files between a Tutor and a Student, 198
  Transfer files between Students, 199
transport
  configure at Client, 284
true or false question, 372
Tutor. See Control
tutor assistant, 92
configure settings, 330
tutor assistant settings, 330
Tutor Console, 62
easy mode, 72
intermediate mode, 70
List view, 66
Status bar, 68
tutor journal settings, 334
tutor keyboard mouse settings, 319
Tutor profiles, 267, 311
tutor toolbar, 74
tutor user interface settings, 327
tutor view settings, 316
unattended installation, 26
  specify parameters, 27
understanding ip addresses, 89
unlock/lock mouse and keyboard, 129
user acknowledgement, 287
user defined tools, 214
user mode, 57
using audio support, 171
using question and answer module, 253
using this manual, 13
values.txt file, 27
video player, 174
ccontrol panel, 176
play video, 175
viewing, 131
annotate while viewing, 166
blank Client screen, 135
Clients, 131
launch an application, 213
logout, 216
monitor mode, 143
reboot, 216
remote clipboard, 137
scale to fit, 133
screen capture, 152
send ctrl+alt+delete, 135
using audio, 172
watch replay files, 182
web control module, 219
approved/restricted lists, 223
block all internet access, 226
close URLs, 222
history, 228
launch URL, 222
Web control module
Managing websites at Students, 222
wellbeing, 161
whiteboard, 163
window
application control, 230
chat, 190
control main, 62
file distribution, 203
file transfer, 198
monitor mode, 143
replay files, 183
scan, 139
Student survey, 241
test reports, 394
view, 131
web control, 219
windows 10, 95
wireless network
optimise show performance, 302
using netsupport school, 108
working with groups, 120
zoomed mode. See monitor mode